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Software registration required 
You must register your NDCMedisoft program.  Although you have 30 days from 
installation to register, we recommend that you register right away.  Full instructions on 
how to register are found on page 10 in this manual.  

Proof of ownership 
KEEP YOUR SERIALIZED SOFTWARE, even if damaged or obsolete.   It is your 
proof of ownership. 
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Preface 
 

Copyrights 
NDCMedisoft, NDCMedisoft Advanced, NDCMedisoft Network Professional, and 
Office Hours programs and documentation © 1987-2004 by NDCHealth Corporation.  
All Rights Reserved. 

Software License Agreement 

License Agreement  
NDCHealth Corporation (“NDCHealth”) grants to the original purchaser 
("Purchaser") a nontransferable, nonexclusive license to use the accompanying software 
(the “Software”) in machine-readable, object code form only, and the associated 
documentation for the private use of Purchaser as set forth in the Permitted Uses and 
Prohibited Uses sections below.  Acceptance and use of the Software acknowledges 
Purchaser's agreement to abide by the terms of this License Agreement.   

Disclaimer 
NDCHealth makes no representations or warranties with respect to the contents of the 
Software and specifically disclaims any implied warranties and warranties of 
merchantability or fitness for any particular purpose.  NDCHealth reserves the right to 
make changes or alterations in the Software without the obligation to notify anyone of 
the changes or alterations. 
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Permitted Uses  
Purchaser may (1) copy the Software for backup purposes to support Purchaser's use of 
the Software; (2) use the Software on a single computer; and (3) if integrated with 
NDCHealth networked software licensed by Purchaser from NDCHealth, Purchaser 
may install this Software on each computer within one network at a single location. 

Prohibited Uses  
Purchaser may not (1) distribute, rent, sublicense, or otherwise make available to others 
the Software, documentation, or any copies thereof; (2) modify, translate, adapt, 
disassemble, or create derivative works from the Software or documentation; or (3) use 
the Software or permit it to be used on more than one computer at any one time, except 
as expressly authorized in the Permitted Uses Section above.  The Software, 
documentation, and all manuals accompanying the Software are copyrighted and all 
rights are reserved by NDCHealth.  No copyrighted material may be copied, 
photocopied, reproduced, translated, or reduced to any electronic medium or machine-
readable device without prior written consent from NDCHealth.  

NDCHealth’s Rights 
Purchaser acknowledges and agrees that the Software and associated documentation are 
proprietary products of NDCHealth and certain third parties (“Third-Party Licensors”) 
protected under U.S. and international copyright law.  Purchaser further acknowledges 
and agrees that all right, title, and interest in and to the Software and any copies thereof, 
including associated intellectual property rights, are and shall remain with NDCHealth 
and Third-Party Licensors.  The License Agreement does not convey to Purchaser any 
interest in or to the Software, but only a limited right of use revocable in accordance 
with the terms hereof, and Purchaser agrees to transfer to NDCHealth any property 
interests or rights in the Software Purchaser may have or later obtain by operation of law 
or otherwise which are inconsistent with the rights granted to Purchaser herein.  

Trademarks 
All other trademarks associated with the Software are trademarks owned by NDCHealth 
or Third-Party Licensors.  No right, license, or interest to such trademarks is granted 
hereunder, and Purchaser agrees that no such right, license, or interest shall be asserted 
by Purchaser with respect to such trademarks.  Purchaser agrees not to take any action 
which would damage the goodwill associated with any such trademarks.  

Limited Warranty  
NDCHealth warrants to Purchaser that the computer media on which the original 
Software is recorded will be free of defects in materials and workmanship for a period of 
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thirty (30) days from the date of purchase under normal conditions of use and service.  
Should the media become defective within thirty (30) days from the date of purchase, if 
proof of original purchase can be verified, NDCHealth will replace the Software or, at 
its option, NDCHealth may refund to Purchaser the original NDCHealth purchase 
price.   

NDCHealth, its software suppliers, distributors, and Value-Added Resellers make no 
representations, warranties, or guarantees, express or implied, including warranties of 
merchantability or fitness for any use or any particular purpose with regard to the 
Software and documentation.  The Software and documentation are licensed to 
Purchaser on an AS IS basis.  Liability of NDCHealth will be strictly limited to the 
purchase price of the Software in any case. 

IN NO EVENT SHALL NDCHEALTH BE LIABLE FOR ANY DIRECT, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES, INCLUDING, BUT NOT 
LIMITED TO, LOSS OF PROFITS, LOSS OF BENEFITS, OR LOSS OF DATA 
RESULTING FROM THE USE OF THIS SOFTWARE OR ARISING OUT OF 
ANY CLAIMED OR ACTUAL BREACH OF WARRANTY.  Some states do not 
allow the exclusion or limitation of direct, incidental, or consequential damages.  If 
Purchaser resides in such a state, the above limitation may not apply to Purchaser.  

NO OTHER REPRESENTATIONS OR WARRANTIES CONCERNING THE 
SOFTWARE OR DOCUMENTATION MAY BE GIVEN EXCEPT THOSE 
CONTAINED HEREIN. 

Termination of License 
NDCHealth may terminate this License Agreement upon a breach by Purchaser of any 
term hereof.  Upon such termination by NDCHealth, Purchaser agrees to immediately 
return to NDCHealth or destroy all copies of the Software in Purchaser’s possession. 

Miscellaneous 
The failure of NDCHealth to enforce any rights granted hereunder or to take any action 
against Purchaser in the event of a breach hereunder shall not be deemed a waiver by 
NDCHealth as to subsequent enforcement of rights or subsequent actions in the event 
of future breaches.  Neither this License Agreement nor any interest in this License 
Agreement is assignable by Purchaser.  This License Agreement represents the entire 
agreement concerning the Software between Purchaser and NDCHealth.  Should any 
term of this License Agreement be declared void or unenforceable by any court of 
competent jurisdiction, such declaration shall have no effect on the remaining terms 
hereof.  This License Agreement shall be construed and governed in accordance with the 
laws of the State of Georgia, United States of America. 
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Chapter 1 
 

Getting Started 
Verify the Installation Media 
Your program software is serialized, with a 14-digit Serial Number preprinted on the 
Certificate of Authenticity.  If you did not receive a Certificate of Authenticity, check 
with the Value-Added Reseller from whom you purchased the program or, if you 
purchased directly from NDCHealth, call your Account Executive and be sure you 
receive proper software.  Unless you were buying an update of an earlier purchase, there 
is no reason why you should not have received a Certificate of Authenticity.  If you did 
not buy directly from NDCHealth and did not get a Certificate of Authenticity, you 
were not delivered legal software.  Contact your local Value-Added Reseller for legal 
software.    

Networking  
Networking lets you connect two or more computers so that they share the same 
software and information.  If your office computer system is set up on a network, read 
this section carefully.  

NDCMedisoft Network Professional supports networking.  The difference between 
NDCMedisoft Advanced and NDCMedisoft Network Professional is the ability to 
perform file and record-locking functions, which allows more than one user to access 
data files without file sharing violations or file damage.  Check the NDCMedisoft web 
site (www.medisoft.com) or the Knowledge Base (www.medisoft.com/kb) for current 
information on this topic. 
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Installation 
Check the NDCMedisoft Knowledge Base (www.medisoft.com/kb) for the most 
current technical information.   Close all open applications prior to installation. 

  Call for Help—If you have any questions, call NDCHealth technical support at 
(800) 334-4006. 

 
If you are installing NDCMedisoft Network Professional, see NDCMedisoft Network 
Professional Installation instructions below.  If you are installing NDCMedisoft or 
NDCMedisoft Advanced, see the NDCMedisoft and NDCMedisoft Advanced 
Installation instructions on page 8. 

NDCMedisoft Network Professional Installation 
These instructions are provided based on certain assumptions: 

• Your network is properly configured and all machines are communicating with 
each other 

• You have purchased NDCMedisoft Network Professional 

• You have network hardware--because of timing issues with new computers, Fast 
Ethernet (also known as 100mbps or 100BaseTx) is highly recommended for use 
in this capacity  

• The person performing the install has some level of networking expertise so that 
terminology does not cause any misunderstanding 

• The person performing the install has a working knowledge of  Windows 
networking 

Step One: Installing the Advantage Database Server 
 You must have administrative privileges to install the Advantage Database 
Server. 

 Pre-Server Installation Setup 
 1. Designate a computer as the server.  Use this server to house your data.    

 We strongly recommend that the server NOT be used as a workstation.  If the 
file server is also used as a workstation, there is a great risk of data corruption. 
If you have to reboot for any reason, any open data may be corrupted. 

 2. Create a folder for the Root Data Path (i.e., Medidata).  Use the UNC 
(Universal Naming Convention) address to designate the shared folder (e.g., 
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\\ServerName\FolderName).  If you use the UNC address, you don’t have to 
map a drive and use the drive name in accessing your data. 

 3. Before installing NDCMedisoft, set up file sharing in the Network applet (in 
Control Panel) on the designated server.  In Windows Explorer, set up sharing 
for the program data folder and give full access (not read-only access) to the 
folder for everyone who uses the program. 

 Server Installation Setup 
 1. Insert the CD in the server CD-ROM drive. 

 2. When the first installation splash screen appears, select Networking and Tools.   
If the splash screen does not appear automatically, go to the Start menu on your 
Task bar and select Run.  Type X:\AUTORUN (where X is your CD-ROM 
drive letter) and click [OK] or press e.  Select Networking and Tools.   

 3. In the second splash screen, select the correct database option.  Select either 
Advantage NT Server or Advantage NetWare Server.   

 4. In the Enter Number of Users screen, enter the number of users that will be 
accessing NDCMedisoft data on your server.  Click [OK]. 

 If you select a number of users that exceeds the number allowed by your program, 
an error code is displayed. 

 5. In the Welcome screen, click [Next]. 

 6. In the License Agreement screen, read the agreement, then click [Yes] to proceed 
with the installation. 

 7. You are given information concerning registering Advantage and then be asked 
if you want to proceed.  Click [Yes]. 

 8. In the Install Location for the Advantage Database Server screen, select the 
directory into which you want the Advantage Database Server program 
installed.  It is recommended that you use the default.  Click [Browse] if you 
want to locate a different directory.  Click [Next] after selecting the directory. 

 9. If the folder into which you want the program to install does not exist, the 
Confirm Newly Selected Directory screen appears, asking you if you want to 
create it.  Click [Yes].  A Setup box is displayed while the computer creates the 
folder and sets up the program. 

 10. The Product Information screen requests the Advantage Serial Number, 
Validation Code, and the name of the Registered Owner.  Refer to the 
Advantage Certificate of Authenticity included with your installation materials 
for your Advantage Serial Number and Validation Code.  Select the Service 
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Startup Type.  The default, Automatic Setup, is highly recommended.  Selecting 
Manual Setup requires that extra steps be performed every time you start the 
Client/Server.  Click [Next]. 

 11. In the ANSI Character Set screen, be sure the character set is correct (usually 
English).  For most users, the default is the correct choice.  Click [Next]. 

 12. In the Registration screen, enter your five-character registration code.  This 
code is provided on the Certificate of Authenticity.  Click [Next].   

  A browse screen is opened.  Close this screen. 

 13. Several Question dialog boxes are displayed.  If you want to view the Read Me 
file, click [Yes].  After reading the document, close it and continue with the 
next step.  If you don’t want to view the Read Me file, click [No].   

 14. The next Question dialog box states that the setup is complete and asks if you 
want to start the Advantage Database.  Click [Yes]. 

 15. Select Exit in the splash screen.   

 Starting and Stopping the Advantage Database Server Program 
The information in this section is necessary if you selected Manual Setup in step 10 
above. 

 Windows NT Installation 
 1. In the Task bar, click Start, select Settings, and then select Control Panel.   

 2. Locate and double-click the Services icon. 

 3. Right-click Advantage Database Server. 

 4. Select Start or Stop as necessary. 

 Windows 2000/XP Professional Installation 
 1. In the Task bar, click Start, select Settings, and then select Control Panel. 

 2. Select Administrative Tools. 

 3. Double-click Services. 

 4. Right-click Advantage Database Server.  

 5. Select Start or Stop as necessary. 

Step Two: Installing NDCMedisoft Network Professional  
There are two methods available for installing NDCMedisoft Network Professional. 
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 • Copy the program installation file into the shared drive–then you can install the 
program from each workstation by accessing the shared drive and not need to 
use the CD for the program install  

 • Move the CD to each workstation or each CD-ROM needed to install the 
program on each workstation 

 Copying the Client Install to the Shared Drive 
 1. In the splash screen, select Copy NDCMedisoft Client.  If this option is not 

available, select Networking and Tools, then select Copy NDCMedisoft 
Client. 

 2. In the Welcome screen, enter the first four digits of your Serial Number.  Then 
click [Next]. 

 3. In the Choose Destination Location screen, select the shared directory for the 
program files on the network.  We recommend that you use the default path.  
Click [Browse] to locate the directory you want.  Click [Next] when finished 
with this step. 

 4. Click [Next] in the Start Installation screen. 

 5. When the installation is completed, click [Finish]. 

 6. Select Exit in the splash screen.  The INSTALL.EXE file has now been copied 
to the network shared drive. 

From each client workstation, navigate to the shared drive and double-click the 
INSTALL.EXE file.   

 1. In the Welcome screen, enter the first four digits of your Serial Number.  Then 
click [Next]. 

 2. Click [I Accept] at the End User License Agreement screen.  If you do not 
accept the terms set forth, you cannot complete the install. 

 3. In the Select Installation Type screen, it is recommended that you use the 
Express Install option.  If you choose to perform a Custom Install, move to the 
NDCMedisoft Network Custom Installation section below. 

 4. You are ready to install.  Click [Next]. 

 5. Once installation is complete, click [Finish]. 

 6. Select Exit in the splash screen. 
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 Installing NDCMedisoft Network Professional Directly on each 
Workstation 

 1. Insert the CD in the local CD-ROM drive.   

 2. When the installation splash screen appears, select Install NDCMedisoft.   

 3. In the Welcome screen, enter the first four digits of your Serial Number.  (The 
Serial Number is on your Certificate of Authenticity.)  Then click [Next]. 

 4. Click [I Accept] at the End User License Agreement screen.  If you do not 
accept the terms set forth, you cannot complete the install. 

 5. In the Select Installation Type screen, it is recommended that you use the 
Express Install option.  If you choose to perform a Custom Install, move to the 
Network Professional Custom Installation section below. 

 6. You are ready to install.  Click [Next]. 

 7. Once installation is complete, click [Finish]. 

 8. Select Exit in the splash screen. 

Repeat the instructions in steps 1 through 8 directly above for installing 
NDCMedisoft on each client workstation.   

 NDCMedisoft Network Professional Custom Installation   
  

We recommend that this type of install is only attempted by someone who has 
extensive computer installation experience.   

 1. After following steps 1 through 4 immediately above, select Custom Install in 
the Select Installation Type screen.  Click [Next]. 

 2.  In the Select Components screen, you can indicate which components to install 
by marking those to be loaded.  To select a component, click the check box 
next to the item you want to install.  A U is displayed next to that component.  
After you have made your selections, click [Next]. 

 3. In the Select Destination Directory screen, you need to specify the drive and 
directory on which you want the program installed.  We recommend that you 
use the default path.  Click [Next].  

 4. You are prompted to back up your existing files.  We highly recommend that 
you perform this backup function now.  By default, Yes is selected.  If you 
choose not to perform a backup, skip to step 6.  

 5. In the Select Backup Directory screen, indicate the directory in which you want 
the backup files to be stored.  Click [Next]. 



 
      Chapter 1:  Getting Started     7 

 6. You are ready to install.  Click [Next]. 

 7. Once installation is complete, click [Finish].  

 8. Select Exit in the installation splash screen.  

Step Three: Accessing NDCMedisoft Network Professional 
from the Workstations 

Number of Connections:  When you purchase NDCMedisoft Network 
Professional, you also purchase the number of connections you need for your 
network.      

 1. After NDCMedisoft has been installed on each computer, run the program on 
any workstation.  In the Find NDCMedisoft Database window, enter the UNC 
(Universal Naming Convention) address for data location.  Click [OK].  

 2. If converting from a previous NDCMedisoft program Version 5.5 or higher, an 
automatic conversion is performed. 

  If converting from an earlier version than 5.5, or if this is a new installation, 
you are asked to create a new set of data or convert existing data.  You can also 
add tutorial data at this time by clicking the box. 

  Make your selection(s) and click [OK]. 

 3. Go to the File menu and select New Practice.  Enter the name of the newly 
created or newly converted practice and the UNC path to the shared data on 
the network drive.   

 4. NDCMedisoft should display a warning telling you that data already exists in 
that location.  Tell NDCMedisoft to use that data.   

 5. Any time two or more users attempt to access the same record, a warning 
should display.  Try to bring up the same patient record on two computers to 
test this function.  If you get a warning, the installation is correct.   

Troubleshooting 
See Appendix B—Troubleshooting, page 153. 
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NDCMedisoft and NDCMedisoft Advanced Installation 
 1. Insert the CD in the local CD-ROM drive.   

 2. When the installation splash screen appears, select Install NDCMedisoft.  If the 
splash screen does not appear automatically, go to the Start menu in your Task 
bar and select Run.  Type X:\AUTORUN (where X is your CD-ROM drive 
letter) and click [OK] or press e.  Select Install NDCMedisoft. 

 3. In the Welcome screen, enter the first four digits of your Serial Number (found 
on the Certificate of Authenticity), then click [Next]. 

 4. Click [I Accept] in the End User License Agreement screen.  If you do not 
accept the terms set forth, you cannot complete the install. 

 5. In the Select Installation Type screen, it is recommended that you use the 
Express Install option.  If you choose to perform a Custom Install, move to the 
NDCMedisoft Custom Installation section below. 

 6. You are ready to install.  Click [Next]. 

 7. Once installation is complete, click [Finish]. 

 8. Select Exit in the splash screen. 

NDCMedisoft Custom Installation 
 

We recommend that this type of install is only attempted by someone who has 
extensive computer installation experience.   

 1. After following steps 1 through 4 above, choose Custom Install in the Select 
Installation Type screen.  Click [Next]. 

 2.  In the Select Components screen, you can select which components to install by 
marking those to be loaded.  To select a component, click on the check box 
next to the item you want to install.  A U is displayed next to that component.  
After you have made your selections, click [Next]. 

 3. In the Select Destination Directory screen, you need to specify the drive on 
which you want the program installed.  We recommend that you use the 
default path.  Click [Next]. 

 4. You are prompted to back up your existing files.  We strongly recommend that 
you perform this backup function now.  By default, Yes is selected.  If you 
choose not to perform a backup, skip to step 6 below. 
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 5. In the Select Backup Directory screen, indicate the directory in which you want 
the backup files to be stored.  When done, click [Next]. 

 6. You are ready to install.  Click [Next]. 

 7. Once installation is complete, click [Finish]. 

 8. Select Exit in the installation splash screen. 

Follow these instructions for installing NDCMedisoft on each client workstation.   

Storing the Installation Media 
The installation media should be stored in a very safe place, one that is free from 
excessive heat or cold, protected from electromagnetic fields or high humidity.  Keep the 
media and the Certificate of Authenticity, even if damaged–these are your proof of 
purchase. 

Initial Program Setup 
Once the program is installed, you are ready to start.  Click the NDCMedisoft icon on 
the desktop or go to the Start menu on the Task bar, select Program Files, 
NDCMedisoft, and then NDCMedisoft. 

If  a root data path is found, the program requires you to register immediately.  Skip to 
Registering the Program, p 10.   

If no data path is found for the program (if this is the first time NDCMedisoft has been 
installed on this computer), a window is displayed asking you to specify the root data 
directory for the program.  See Figure 1.1.   

 

Enter the root data directory or click [Browse] to locate the directory.  Click [OK].  The 
program opens the Create Data window.  You have two options:  Create a new set of 
data or convert previous NDCMedisoft Windows data.  In addition, there is an Add 

Figure 1.1
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Tutorial Data check box which, when selected, includes tutorial data under the name of 
“Medical Group” in the list of practices.   

If you choose not to add the tutorial data at this time, you can still open the files by 
going to the File menu and selecting Open Practice.  The Open Practice window 
displays an [Add Tutorial] button on the right of the window so that the tutorial files 
can be added at any time.   

The tutorial files provide dummy data with which to practice and get exposure to the 
program before you start entering permanent data.  Get a feel for how to set up patients, 
codes, practices, providers, and insurance carriers in the tutorial before using live data.  
The tutorial data can also be used to train any new employee not familiar with the 
program.  A couple of hours running through practice files could be required before 
anyone starts entering actual data into the program.  That way, first-time mistakes that 
can take valuable time and effort to correct can be left in the tutorial data files.  Tutorial 
practice information has been added at the end of each setup chapter in this manual. 

Registering the Program 
You have 30 days to register the program.  We recommend that you register right away 
because the program will be locked at the end of the 30 days and you will not be able to 
access your data until the program is registered.   

To register, go to the Help menu and select Product Registration.   

 Version 9 requires that all NDCMedisoft products be registered again. 

All installed NDCMedisoft products are listed in the opening NDCMedisoft 
Registration window.  If you have an NDCMedisoft product that is not listed in this 
window, close registration and open and close each of the products that should be listed.  
Then reopen your NDCMedisoft program. 

There are three ways to register the program.  The default method is by modem.  If no 
modem is found, the program attempts to register through an Internet connection.  If 
no connection is available, you can register by fax or mail.  Choose the option below 
that best matches your connectivity options.    

Modem Registration 
1. Click [Register].  

2. In the Please fill out your purchase information window, enter all information 
as completely as possible.  The Customer Number, issued by NDCHealth, 
consists of five digits.  If you purchased the program directly from 
NDCHealth, the Customer Number is in the upper right corner of the invoice 
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received with your order.  If you purchased the program from a Value-Added 
Reseller, leave this field blank. 

In the Number of Users field, enter the number of computers on which 
NDCMedisoft will be installed.  In the Number of Providers field, enter the 
number of providers in your practice.  Click [Next].  

3. In the Please fill in all providers window, enter each provider’s name, 
credentials, and specialty.  If you need additional lines, click [New]; if you 
need to remove a provider from the current list, highlight that record and click 
[Delete].  When all the information is entered and correct, click [Next]. 

4. In the Please enter your Serial Number window, enter the Serial Numbers of 
each listed unregistered product.  The Serial Number is a 14-digit number 
printed on the Certificate of Authenticity received with the CD.  Click [Next]. 

The program begins an immediate search for a modem.  

5. If a modem is found, the Register by modem window opens.  Enter your area 
code and, if necessary, any number(s) needed to access an outside line.  Click 
[Next].   

Note:  If no modem is found, the program automatically searches for an 
Internet connection.  See Web Registration below, step 5. 

6. You receive Registration Codes back by modem, and the codes are entered into 
the program automatically.  A Registration by modem: Confirmation window 
opens showing the registration status of all products.   

7. Click [Done].   

8. In the NDCMedisoft Registration window, click [Print] and the program 
prepares a fax form that contains your registration information, including the 
Registration Codes.  To complete this information, enter the current date in 
the Registration Date field, as this is not provided by the program.  Keep this 
form in a safe place.  Click [Close]. 

Web Registration 
1. Click [Register].  

2. In the Please fill out your purchase information window, enter all information 
as completely as possible.  The Customer Number, issued by NDCHealth, 
consists of five digits.  If you purchased the program directly from 
NDCHealth, the Customer Number is in the upper right corner of the invoice 
received with your order.  If you purchased the program from a Value-Added 
Reseller, leave this field blank. 
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In the Number of Users field, enter the number of computers on which the 
program will be installed.  In the Number of Providers field, enter the number 
of providers in your practice. Click [Next].  

3. In the Please fill in all providers window, enter each provider’s name, 
credentials, and specialty.  If you need additional lines, click [New].  When all 
the information is entered and correct, click [Next]. 

4. In the Please enter your Serial Number window, enter the Serial Numbers of 
each listed unregistered product.  The Serial Number is a 14-digit number 
printed on the Certificate of Authenticity received with the installation CD.  
Click [Next]. 

The program begins an immediate search for a modem.  

If no modem is found, the program automatically searches for an Internet 
connection.  If an Internet connection is not found, the program asks if you 
want to connect to the Internet yourself and then try again.  Click [Yes] and a 
Dial-Up Connection window opens where you select the service you want to 
use and enter your user name and password.  Click [Connect].   

5. After a successful connection, the NDCMedisoft Online Registration page 
opens.  A floating Serial Number List window also opens if you have multiple 
products to register.  This window includes the Serial Numbers of each 
product.   

The registration page automatically fills in the information you entered in the 
Purchase Information window.  Fields marked with an asterisk (*) must 
contain information before registration can proceed.   

Note:  Do NOT change the Registration/Practice Name setting.  Doing so 
will cause the Web registration to fail. 

6. Click [Submit].  If registration is successful, the registration page reloads with 
your Registration Code displayed at the top of the page.   

Note:  This Registration Code has to be entered in the Please enter your 
registration code window to complete registration. 

7. Click [Print Screen] to print the form for your records.  Now you can either 
register another product or close your browser and return to product 
registration.   

8. When you return to product registration, click [Next] to move to the Please 
enter your registration code window. 

9. Enter each Registration Code in the Please enter your registration code 
window next to the appropriate product.  Click [Done].   
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10. In the NDCMedisoft Registration window, click [Print] and the program 
prepares a fax form that contains your registration information, including the 
Registration Codes.  To complete this information, enter the current date in 
the Registration Date field, as this is not provided by the program.  Keep this 
form in a safe place.  Click [Close].  

Mail or Fax Registration 
1. Click [Register].  

2. In the Please fill out your purchase information window, enter all information 
as completely as possible.  The Customer Number, issued by NDCHealth, 
consists of five digits.  If you purchased the program directly from 
NDCHealth, the Customer Number is in the upper right corner of the invoice 
received with your order.  If you purchased the program from a Value-Added 
Reseller, leave this field blank. 

In the Number of Users field, enter the number of computers on which the 
program will be installed.  In the Number of Providers field, enter the number 
of providers in your practice. Click [Next].  

3. In the Please fill in all providers window, enter each provider’s name, 
credentials, and specialty.  If you need additional lines, click [New].  When all 
the information is entered and correct, click [Next]. 

4. In the Please enter your Serial Number window, enter the Serial Numbers of 
each listed unregistered product.  The Serial Number is a 14-digit number 
printed on the Certificate of Authenticity received with the installation CD.  
Click [Next]. 

The program begins an immediate search for your modem.  If you have no 
modem or Internet connection, an Information window pops up.  Click [Print 
Registration].   

Note:  Because mailing time can significantly increase the time it takes to 
get your Registration Code, we highly recommend that you fax your 
registration form instead of mailing it.  

5. Fax the printed registration form to the following number:   

(480) 892-8001 

 Or mail the printed registration form to the following address: 

 NDCHealth--Attention:  Registration  
 5222 E. Baseline Road, Suite 101 

Gilbert, Arizona  85234   
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6. NDCHealth returns your Registration Codes in the same manner as they were 
sent soon after the registration forms are received.  Open the NDCMedisoft 
Registration window again and navigate to the Please enter your registration 
code window.  Enter the Registration Codes in the appropriate Registration 
Code fields.  Click [Done].   

7. In the NDCMedisoft Registration window, click [Print] and the program 
prepares a fax form that contains your registration information, including the 
Registration Codes.  To complete this information, enter the current date in 
the Registration Date field, as this is not provided by the program.  Keep this 
form in a safe place.  Click [Close].  

Setting up the Practice 
When you first enter the NDCMedisoft program after installation, you are required to 
create a new data set or convert previous NDCMedisoft or MS-DOS data.  If you 
choose to create a new data set, the Create a New Set of Data window is displayed.  Fill 
in the practice name.  When you click [Create], the Practice Information window is 
displayed, at which time you need to enter all the practice information requested.  See 
Figure 1.2.   

 

The information in report headings comes from this Practice Information window.   

Figure 1.2
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Billing Services 
In recent years, with electronic submission becoming more important and the 
complexity of insurance claims processing increasing, there has been a growing number 
of billing services.  Smaller office or home-based businesses now handle insurance billing 
for healthcare practices. 

If you are a billing service, enter your client’s information in the Practice tab.  Enter 
your information in the Billing Service tab.  If you want to use the NDCMedisoft 
program to keep track of your own accounts receivables, a separate database can be set 
up with each client listed as a patient.  Separate procedure codes can be created to cover 
the various services of your billing service. 

Setting Up Multiple Practices 
It is not necessary to install the program for each new practice.  To set up multiple 
practices, go to the File menu and select New Practice.  When the first practice is set up 
in the NDCMedisoft program, the program assumes there is only one practice and 
establishes a default directory for the data for that practice.  Each time you set up an 
additional data set with totally unrelated patients and procedure files, you must create a 
different subdirectory.  In the Create A New Set Of Data window, enter the additional 
practice name and change the data path.  This establishes a completely separate database 
for the new practice.   

Once you have set up additional practices, you can move easily from one to another by 
going to the File menu, selecting Open Practice, and choosing the practice you want 
from the list presented. 

Practice Type  
The practice Type field is a drop-down list.  Click on the arrow to view the entry 
options, i.e., Medical, Chiropractic, and Anesthesia.  Each option controls special fields 
within the program.   

Medical: This is the general setting for all healthcare groups except Chiropractic and 
Anesthesiology.   

Chiropractic: Choosing Chiropractic activates the Level of Subluxation field in the 
diagnosis section of the patient case file.  When set as Medical or Anesthesia, this field is 
not available.   

Anesthesia: The Anesthesia choice adds a Minutes field in the Transaction Entry 
window for entering charges in transaction billing functions.   
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Data Conversion 
NDCMedisoft MS-DOS Users Converting to Windows 
If you are a user of any NDCMedisoft patient accounting program in the MS-DOS 
environment, your data files are converted to the Windows version.  See Appendix C, 
page 157.   

The conversion process is designed to have no effect on your original MS-DOS files.  
However, before you begin installation of the new program, back up your current data 
files just to be safe.   

Windows Converting to Upgraded Windows 
When you convert previous data, the program searches your physical hard drive for any 
MWDBLIST.ADT files.  When found, the program lists all valid data directories in the 
NDCMedisoft File Conversion window.   

 A valid data directory is one that contains data. 

Of the data sets listed in the NDCMedisoft File Conversion window, select one at a time 
that you would like to have converted.   

When you are finished converting the data sets, your original data directories remain 
unchanged except a CONVERT.LOG file (and possibly a DATABASE.CLI file) is 
created in each data directory that is upgraded.  The program creates a new directory for 
each data set converted in the root data directory you specified when you installed your 
latest program.  The first new data directory is automatically named DATA, the second 
is named DATA1, and each new data directory is named consecutively after that (e.g., 
DATA2, DATA3, etc.).   

   DO NOT RENAME THESE DATA FILES. 

The program relies on this naming convention to function properly.  To identify which 
practice files are contained in which data directory, use the Open Practice window, 
which contains the data path for the highlighted directory.   

We recommend that you do not delete your old data directories until you know for 
certain that the newly converted data is complete.  If you need more space on your 
computer, you can create a backup of the old data directories or just copy them onto 
storage disks, but keep them until you are certain the new program is working 
completely and properly. 
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Chapter 2  
 

Basic Navigation in the Manual and Program 
How to Use the Manual 
This manual is designed to give you an overview of what the program is and how it can 
work for you.  It is not a complete how-to instruction manual. The detailed 
instructions are contained in the online Help files. 

After a function or window is introduced in the manual, the ! symbol tells you where 
to go for additional help.  For example, the Billing Code List explanation in the manual 
briefly explains the feature and shows the window, then instructs, “! Look up Billing 
Code Entry.”  Press !, click [Search] in the Help window (or press a + S); type 
“Billing Code Entry” and press e to go directly to help information specific to 
billing code entry.  If the program is running, pressing ! immediately accesses help 
relating to the active window.   

More information concerning the manual is contained in Appendix A, page 149. 

Search 
 A search feature is included in many data fields, indicated by an icon that looks like 

a magnifying glass.  Clicking the icon opens a Search window that contains a list of the 
fields related to the data area of the program from which the feature was accessed.   

! Look up Searching. 
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Data Entry Process 
Entering data in the program is easy and straightforward.  Select an option from the 
menus or click a speed button or icon.  A data entry window for that function opens.   

Buttons are placed in windows for easy editing and access.  At the bottom of the Patient 
List window, for instance, are buttons for editing records, setting up new records, 
deleting records, or closing the window.  Clicking [New] brings up a data entry window 
that lets you set up all of the information needed to create patient records, build patient 
ledgers and file claims, generate reports, and whatever else you need from your patient 
accounting program. 

Data entered in a field is saved as it appears on the window.  To correct data, just click 
in the desired field and the text in the field is selected.  Typing new text with the text 
selected changes the existing text.  Select a part of the text to replace just that part or to 
delete by pressing the d key. 

Keyboard Specifications 
There are keys you use in the program that control the data.  By default, both the e 
and t keys enter typed data into the program and move the cursor to the next field 
in the Tab order.  If you want, you can deselect e as a key which allows you to 
move forward through fields.  Directional arrows let you move around the page to line 
up with the space desired. 

Accelerator Keys 
Any letter underlined on the Menu bar or in drop-down lists and in some windows 
indicates the presence of an accelerator key, a keyboard alternative to a mouse function.  
Using the a key in combination with the underlined letter key selects that option or 
moves the cursor to that field (such as a + N in list windows creates a new record).  
There are also accelerator keys that utilize the c and s keys in combination with 
another key (e.g., c + C copies selected text). 

Function Keys 
Function keys provide shortcuts to various parts of the program.  The keys are usually 
identified by the letter “F” followed by a number from 1 to 12 and many are assigned 
specific functions within the program.  Most functions are consistent throughout the 
program, but there are a few variations.  As you get acquainted with the program, 
shortcuts can speed your data entry.  Some of them are:  ! (Help), # (Save), ^ 
(Search),  * (New or “add on the fly”) and ( (Edit).
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NDCMedisoft at a Glance  
Once the program is open, your can get a good look at the main program window.   
The top bar on the window is the Title bar and it displays the name of the active 
program and contains Minimize, Maximize, and Close buttons on the right side.  See 
Figure 3.1.  

 

Menu Bar  
Just below the Title bar is the Menu bar, which shows categories of activities available in 
the program.  Click on various headings, such as File, Edit, Activities, Lists, Reports, 
Tools, Window, and Help, and each opens a submenu with a list of all the activity 
options available in that category.  See Figure 3.2. 

 

File Menu 
The File menu contains options for managing your database files.   

Figure 3.2

Figure 3.1 
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Edit Menu 
The functions of the Edit menu are Cut, Copy, Paste, and Delete.  These deal primarily 
with the handling of text.   

Activities Menu 
This is the center of much of the daily routine of the practice.   

Lists Menu 
This menu provides access to the various list windows available in the program.   

Reports Menu 
Reports within NDCMedisoft are accessible through the Reports menu.  You can also 
access the Custom Report List and Report Designer through this menu.   

Tools Menu 
The options available in this menu help you access peripheral programs and information 
to assist in the management of your practice. 

Window Menu 
This menu contains options that control the display of windows in the program.   

Help Menu 
The Help menu contains access to information on how to use the program, as well as 
how to register.   

Services Menu 
The Services menu contains a link to OnCallData for electronic prescriptions.  Call 
your local Value-Added Reseller or call your NDCMedisoft sales representative at (800) 
333-4747 for information concerning OnCallData.   

Toolbar 
Below the menu bar is the toolbar with an assortment of speed buttons (or icons) that 
are shortcuts to accessing options within the program.  See Figure 3.3. 

 

Figure 3.3
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Select the option you want by clicking the appropriate speed button.  That function of 
the program opens in a full data entry window. 

The toolbar can be customized to your liking.  Change the order of the buttons in the 
toolbar or hide them so they don’t show at all.  Create a new toolbar with only the 
buttons or file names that you want.  In addition, you can move the toolbar to the top, 
bottom, or either side of the screen or return it to its original position and layout.   

! Look up Toolbar Customizing. 

Shortcut Bar 
At the bottom of the screen, above the Status bar, is a shortcut bar that describes the 
available shortcut function keys available in the active window.  This bar may also be 
referred to as the “function help bar.”   
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General Practice Setup  
Open Practice, New Practice 
To change practices or create a new practice database, go to the File menu and select the 
appropriate option.   

To open an existing database, go to the File menu and select Open Practice. Choose the 
practice you want to open and click [OK].   

To create a new database, follow the same procedure as described in the Setting Up the 
Practice section, page 10.   

Backup Data, Backup Scheduler, View Backups, 
Restore Backups 
Information concerning backups is contained in the online Help.  Go to the File menu 
in your NDCMedisoft program, select any backup-related topic, and then press !.   

! Look up Backup, Backup Scheduler, View Backup, or Restore in the Backup Help 
file. 

Program Date 
You can change the program date for back dating a large number of transactions.  This 
affects all dates in the program except the Date Created setting, which always reflects the 
System date.   
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Program Options 
Go to the File menu and select Program Options.  There are a number of tabs within 
Program Options, several available only with NDCMedisoft Advanced and 
NDCMedisoft Network Professional.  Each is described below.   

General Tab 
 Backing Up Data 

The General tab deals with backups, which are an essential part of maintaining a 
computer-generated billing program, and with general default settings.  See Figure 
4.1. 

 

We recommend that data files be backed up every day, with a program of rotating 
backup disks so you can restore lost data to the most recent date before the files 
were damaged or corrupted.  If you are working with multiple practices, each 
practice should have its own set of backup files.  Doing your backups within the 
NDCMedisoft program is a dependable method.   

 
When you perform a backup, you are only backing up the data files for the 
practice currently open.  If you work with several practice databases, you must 
open each practice and perform a backup to preserve those files. 

Figure 4.1
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! Look up Backup, Backup Scheduler, View Backup, or Restore in the Backup 
Help file. 

 Default Choices 
You have the option to show the Patient List and/or Transaction Entry windows 
on startup by placing a checkmark next to either or both options here.  You can 
indicate whether you want to show shortcuts and/or hints, or Enforce Accept 
Assignment.  In NDCMedisoft Advanced and NDCMedisoft Network Professional, 
you can indicate whether to print a title page for every report.  Network 
Professional includes an option to synchronize your computer time with the time 
on the network server. 

 Eligibility Receiver 
Designate the receiver for your eligibility verification requests.   

! Look up Program Options-General Tab. 

Data Entry Tab 
The Data Entry tab gives you lots of options for various sections of the program.  See 
Figure 4.2. 

 

Figure 4.2 
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You can indicate whether to use e as a toggle to move between fields, to force 
payments to be applied, and to multiply unit times amount.  Using the zip code to enter 
city and state information can save a lot of time.   

In the Patient section, you can choose to use numeric Chart numbers (the default is to 
use an alphanumeric code) and/or have the program automatically hyphenate Social 
Security Numbers. 

Choices in the Transaction section primarily affect Transaction Entry.  Selecting Force 
Document Number displays a Document field in the Transaction Entry window.  If you 
click Force payments to be applied, the program makes you apply every payment before 
exiting Transaction Entry.  If you choose to Multiply units times amount, the program 
automatically adjusts the cost of the procedure based on number of units.  If you click 
Auto Create Tax Entry, the program automatically adds tax to any selected procedure 
code that has been marked taxable and create a separate line item in Transaction Entry.   
Be sure you have created and selected a Default Tax Code.   

The Case Default field determines which case is selected in Transaction Entry.  The 
default is Last Case Used, but you can change this to Newest Case or Oldest Case. 

There is also a field where you can set the default Place of Service Code.  The default in 
this field is 11.  When there is an occasional change of location, simply type the new 
code to override the default entry. 

NDCMedisoft Advanced and NDCMedisoft Network Professional offer a few more 
features.  When Create statement billing notes is activated, a note is added to statements 
when printed.  Be sure to select a default note in the Statement Billing Note Code field.  
When Create billing notes is activated, a Comment transaction line is added in both 
Transaction Entry and Quick Ledger whenever a claim is billed.  The note includes the 
carrier name, date billed, claim number, and the name of the provider associated with 
the claim.  Be sure to select a default Billing Note Code.  You can also select default 
Receipt and Statement formats, which give you one-button printing of these documents 
from Transaction Entry and Quick Ledger.  You can choose a default form to print as a 
face sheet.  This is connected to a button in the patient Case window.   

! Look up Program Options-Data Entry Tab. 

Payment Application Tab (Advanced and above) 
In the Payment Application tab, you can establish default settings that affect the 
payment application function.  See Figure 4.3. 
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If you choose to accept the default settings, any amount applied to a charge is 
automatically marked as paid by that particular payee, the allowed amount is 
automatically calculated, and the difference between the calculated allowed amount and 
the practice charge is offset in the Adjustment column.  In addition, any claim that has 
received payment from all responsible payers is automatically marked “Done.”  

In the lower half of the window, select default billing codes to be applied when using 
this feature.   

! Look up Program Options-Payment Application Tab. 

Aging Reports Tab 
The Aging Reports tab lets you alter the starting date for patient aging reports and to 
redefine aging columns for both patient and insurance aging reports.  See Figure 4.4.  

Figure 4.3 
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! Look up Program Options-Aging Reports Tab. 

HIPAA Tab 
In 1996 Congress passed the Health Insurance Portability and Accountability Act 
(“HIPAA”).  Its purpose is to ensure that all electronic patient information is both 
secure and private.  The law is having far-reaching effects and HIPAA compliance is 
becoming one of the dominant standards by which accounting software is judged.   

The HIPAA tab contains two options.  See Figure 4.5. 

Figure 4.4
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There is a check box for Auto Log Off, with an associated time field.  Clicking the box 
activates a log off function that requires entry of a password to continue.  This 
minimizes unauthorized use of the program, should someone sit down to the computer 
while the program is active. 

The second check box is to Warn on Unapproved Codes.  Checking this option alerts you 
if a code entered is non-HIPAA compliant. 

Identifiers have been added to each set of data fields for the provider, referring provider, 
address, insurance, and patient records as part of the HIPAA compliance program.   

! Look up Program Options-HIPAA Tab. 

Color-Coding Tab (Advanced and above)  
 Transactions 

If you want to use color coding for transactions in Transaction Entry and Quick 
Ledger, click the Use Color Coding box.  See Figure 4.6. 

 

Figure 4.5 
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Select colors for each of six types of transactions:  Unsaved, No Payment, Partially 
Paid, Overpaid Charge, Unapplied Payment, and Overapplied Payment.  These colors 
appear in both windows, letting you know at a glance the status of the transaction. 

 Patients 
This feature, called patient flagging, lets you color code patient records to alert you 
to various situations when viewing the records the Patient List, Transaction Entry, 
Quick Ledger, and Deposit List windows of NDCMedisoft and the New 
Appointment window in Office Hours (when integrated with NDCMedisoft). 

The patient flag colors in the Program Options window are fixed and cannot be 
edited.  In the box to the right of a color box, assign your own description to that 
flag color.  To activate the edit boxes, click Use Flags.   

Patient flags are connected to patient records in the Other Information tab of the 
Patient/Guarantor window as you edit or set up a new patient record.   

! Look up Program Options-Color Coding Tab. 

Security Setup  
One of the options within the File menu is Security Setup.  This feature protects the 
integrity and privacy of your information files and safeguards your data from 
unauthorized access.  

Figure 4.6 
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NDCMedisoft 
In the basic NDCMedisoft program, security is a limited-access feature to protect your 
program from unauthorized access.  You enter each program user and assign a password, 
which they need to enter every time they access the program.  Once the security feature 
is used, the File menu contains an additional option, Log In As Another User.   

NDCMedisoft Advanced and NDCMedisoft Network 
Professional 
In NDCMedisoft Advanced and NDCMedisoft Network Professional, the security 
feature not only controls access to the program, but protects parts of the program from 
full access.  There are five levels of access available in the program. The Security 
Supervisor, who has unlimited access and full control of security, can assign or remove 
rights for any level of security, with one exception.  Level 1 access cannot be removed 
from any of the three options listed in the Security window settings for the Supervisor.  
Lower level access can be added, but the Supervisor must retain rights to these options. 

Level 1 is for unlimited access and is designed to be used exclusively by the Supervisor or 
administrator to restrict access to the program.  Levels 2, 3, 4, and 5 can be user-defined 
with the Supervisor deciding what fits in what level and assigning users accordingly.  
Generally, the higher the level number, the less rights are assigned to it.  Add or remove 
check marks for level access by clicking the appropriate check box for each process 
displayed with each listed window name. 

If a task is attempted by a user who does not have rights to that task, based on the 
security level assigned, a warning dialog box is displayed stating that the user does not 
have the authority to perform the requested task.   

Once the security feature is used, the File menu contains an additional option, Log In 
As Another User. 

! Look up Security Setup. 

File Maintenance 
The program puts you in the driver’s seat by giving you the ability to rebuild indexes, 
pack data, recalculate patient balances, and purge data.  The tools to perform each 
procedure are contained within separate tabs.   

 
Each of these file management functions carries the warning that it can take a 
long time to process.  Keep that in mind when planning your file maintenance 
activities. 
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Rebuild Indexes 
The Rebuild Indexes tab provides options to rebuild data indexes and lists the files 
available for rebuilding.  Clicking All Files includes them all.  See Figure 4.7. 

 

Pack Data 
Select the Pack Data tab to choose the data files from which you want to remove deleted 
data.  Here again, you can choose one particular set of files or click All Files to include 
them all. 

Figure 4.7
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Purge Data 
The decision to purge data files should be done only after careful consideration.  Data 
removed cannot be reinstated unless you have a previous backup disk containing the 
information.  You have a choice of purging appointment fields, closed cases, and claims 
data files.  In any case, select the cutoff date to which you want to clear data.  All data in 
the selected file before and including the date specified is deleted.   

Recalculate Balances 
You can recalculate all patient balances in File Maintenance by clicking the Recalculate 
Balances check box, then [Start].  Recalculation of a single patient’s account balance can 
be done in the Transaction Entry window by clicking on the Account Total amount. 

! Open the File Maintenance portion of the program and press !. 
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Setting Up the Practice  
Here is a recommended sequence for setup that helps you get off to a great start. 

 1. Procedure codes and MultiLinks. 

 2.  Diagnosis codes. 

 3. Provider records. 

 4.  Insurance carrier records and their ID numbers.  

 5.  Address information. 

 6.  EDI receiver records. 

 7. Referring provider records. 

 8. Billing codes. 

 9. Contact List. 

 10. Eligibility. 

Procedure, Payment, and Adjustment Codes 
Procedure codes are used to communicate procedure information between patient, 
provider, and third-party payers.  These codes can be accessed by going to the Lists 
menu and selecting Procedure/Payment/Adjustment Codes, or by clicking the CPT 
icon.   

The Procedure/Payment/Adjustment List window shows what codes have been set up.  
At the top of the window, there are two fields to help you find a procedure code: Search 
for and Field.  Field defaults to Code 1 but can be changed to Description or Type.  If 
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you are not sure of the complete code, description, or type, enter the first few letters or 
numbers in the Search for field.  As you type, the list automatically filters to display 
records that match.  At the bottom of the window are choices for setting up a new code, 
editing a code, or deleting a code.  If the code you need is not shown in the list, click 
[New] or press *.   

! Look up Procedure/Payment/Adjustment Entry. 

New Procedure Codes and Accounting Codes 
General Tab 
In this area, you can enter a new code number, description, and type.  Valid code types 
can be seen by clicking on the drop-down Code Type list.  See Figure 5.1.   

 

Accounting Codes can be any configuration of letters or numbers you want to assign to 
each accounting function, e.g., cash, checks, etc.  Procedure codes are used for recording 
charges for services rendered, and Accounting Codes show the payment and adjustment 
side of the entry process.  These categories are broken down into codes for specific 
purposes. 

Figure 5.1



 
     Chapter 5:  Setting Up the Practice     37 

Valid codes that have unique functions within the program are: 

Adjustment  Deductible 
Billing Charge Inside Lab Charge 
Cash Co-payment  Insurance Adjustment 
Cash Payment Insurance Payment 
Check Co-payment Insurance Withhold Adjustment 
Check Payment  Outside Lab Charge 
Comment  Procedure Charge 
Credit Card Co-payment  Product Charge 
Credit Card Payment Tax 

Also indicated in this window are the type of service, place of service, time to perform 
the procedure, whether to allow the code to print on insurance forms, Alternate Codes 
and, if applicable, whether only the patient is responsible.  There is also a check box to 
indicate if the code is inactive.   

Modifiers help pinpoint the exact procedure performed.  If needed for claim filing, add 
modifiers.  The HIPAA Approved field indicates whether the code is HIPAA approved.  
The Revenue Code is used with the UB92 claim form.  You can adjust the number of 
units associated with this code in the Default Units field.  If the code is used only with a 
service that the practice purchased (usually from a lab), click this check box. 

! Look up Procedure/Payment/Adjustment Entry-General Tab. 

Amounts Tab 
The Amounts tab is linked with Case information, Account tab, Price Code field.  
NDCMedisoft Advanced and NDCMedisoft Network Professional allow 26 charge 
amounts for each code entered in the program.  The applicable charge amount is 
selected in the Account tab of each patient’s Case window.   

! Look up Procedure/Payment/Adjustment Entry-Amounts Tab. 

Allowed Amounts Tab  (Advanced and above) 
The Allowed Amounts tab keeps track of how much each carrier pays for a particular 
code.  The program calculates the allowed amount based on the amount paid, any 
applicable deductible, and the service classification.  This amount is used in calculating 
the patient portion of any transaction entered in Transaction Entry.   

! Look up Procedure/Payment/Adjustment Entry-Allowed Amounts Tab. 
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MultiLink Codes 
MultiLinks are groups of procedure codes combined under one access code.  They are 
for procedures that are normally performed at the same time, e.g., for a physical exam, a 
routine set of treatments, etc. 

The advantages to using MultiLinks include a reduction of time during data entry.  If 
you can create several transactions with the entry of a single code name or number, there 
is an obvious time saving.  MultiLinks also reduce omission errors.  You won’t forget 
codes that should be included if they are included in a MultiLink.  When you use the 
MultiLink code, all the codes in the group are entered.   

Enter the MultiLinks function by going to the Lists menu and selecting MultiLink 
Codes.  The list displays all available procedure codes, adjustment codes, and payment 
codes.  You can also set up a new MultiLink or edit or delete an existing MultiLink 
code. 

! Look up MultiLink Entry. 

Diagnosis Codes 
Diagnosis codes represent the reason a service is provided.  In effect, the procedure code 
tells what the doctor did and the diagnosis code tells what the doctor found.   

As with other list functions, the diagnosis code setup is accessed by going to the Lists 
menu and selecting Diagnosis Codes or by clicking the Diagnosis Code List speed 
button.  At this point you can review codes in the list or search for one you do not see.  
Clicking [New] (*) or [Edit] (() opens up a window where you can create a new 
code or edit an existing one.  See Figure 5.2.   

 

The Diagnosis: (new) window displays fields for the code number and description.  You 
also have the option of entering Alternate Code Sets.  These can be used later for entering 
codes for different carriers but for the same diagnosis.   

! Look up Diagnosis Entry. 

Figure 5.2 
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Provider Records 
The Provider List is accessed by going to the Lists menu and selecting Providers or by 
clicking the Provider List speed button.  Specific provider information is accessed by 
clicking [Edit] or pressing (, and the Provider: (new) setup window is accessed by 
clicking [New] or pressing *.  See Figure 5.3. 

 

Address Tab 
Provider Code numbers are assigned to more than the doctors.  Every member of the 
staff should be set up as a provider and receive a provider Code number. 

Provider and staff member Code numbers are utilized in Transaction Entry to identify 
the author when a Patient note is generated.  The only provider Code number that is 
printed on a claim form or transmitted electronically is that of the physician assigned to 
the patient.  All others are for in-house monitoring and accounting. 

! Look up Provider Entry-Address Tab. 

Figure 5.3
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Default Pins and Default Group IDs Tabs 
PIN and ID numbers assigned by Medicare, Medicaid, TRICARE, Blue Cross/Blue 
Shield and other commercial carriers are recorded in the Default PINs and Default 
Group IDs tabs.   

! Look up Provider Entry-Default Pins Tab and Provider Entry-Default Group IDs 
Tab. 

PINs Tab 
The PIN matrix is contained in the PINs tab.  This contains all of the provider’s PINs 
assigned by the various carriers.  This is the same table as that contained in the 
Insurance Carrier record. 

! Look up Provider Entry-PINs Tab. 

Insurance Carrier Records 
Setting up the insurance carriers correctly is essential to getting claims paid in a timely 
manner.  Go to the Lists menu and select Insurance Carriers or click the Insurance 
Carrier speed button.   

Address Tab 
The information contained in the Address tab is standard and includes the  
Practice ID code.   

! Look up Insurance Carrier Entry-Address Tab. 

Options Tab 
The Options tab provides fields for more specific information, including plan name and 
type.  See Figure 5.4. 
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This is where you indicate the Procedure and Diagnosis Code Set that are used by this 
carrier, select options in the various Signature on File fields, and specify the Default 
Billing Method.  The various Signature on File fields are provided to determine what 
prints in Boxes 12, 13, 31, and 24K of the CMS- or HCFA-1500 claim form. 

! Look up Insurance Carrier Entry-Options Tab. 

EDI, Codes Tab 
In the EDI, Codes tab, be sure to enter the EDI Receiver if you are planning to submit 
electronic claims.  If the EDI receiver you want is not in the list, you can add it “on the 
fly” by pressing *.  After you have signed up with a receiver for your electronic claims, 
that receiver assigns your EDI Payor ID and EDI Sub ID numbers and any other 
necessary numbers or codes.   

! Look up Insurance Carrier Entry-EDI, Codes Tab. 

Allowed Tab (Advanced and above) 
This tab contains a listing of allowed amounts paid by the selected carrier for each of the 
procedure codes contained in the program.  Enter these amounts by hand or let the 
program gather the information from insurance payments entered in the program. 

! Look up Insurance Carrier Entry-Allowed Tab. 

Figure 5.4
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PINs Tab 
The PINs tab contains a listing of all PINs assigned by the selected carrier to each 
provider contained in the program.   

! Look up Insurance Carrier Entry-PINs Tab. 

Address Records 
The Address file is your address book within the computer.  It keeps the names, 
addresses, and phone numbers (with extensions) of important outside contacts, such as 
referring physicians, attorneys, employers, referral sources, etc.  The Address file should 
include all important contact persons whose phone, fax, cell, and e-mail numbers the 
practice needs at any time in the future.   

Go to the Lists menu and select Addresses or click the Address List icon.   
See Figure 5.5.   

 

Figure 5.5
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When you click [New] or press *, the program automatically assigns an address code 
based upon the Name field.  The address code is not assigned until all information is 
entered and saved.  Use Search for and Field to look up the address code of existing 
records. 

The addresses maintained in the program are classified by “type” assigned to facilitate 
ease of selection in a drop-down list.  These types include: Attorney, Employer, Facility 
(Hospital, Rest Home, etc.), Laboratory, Miscellaneous, and Referral Source.  Correct 
types are required to ensure the CMS- or HCFA-1500 form prints correctly. 

! Look up Address Entry. 

EDI Receiver Records 
EDI receiver records are used when checking eligibility and when sending claims or 
statements electronically.  Electronic submission through NDC Electronic Claims 
Processing is provided at no additional cost.  To get started with electronic claim or 
statement submission, contact your local Value-Added Reseller or call NDCHealth 
directly at (800) 689-4550 and request the enrollment package. 

Optional direct claims software is available to send claims directly to selected carriers 
throughout the country.  Most of these are set up on a state or regional basis and handle 
Medicare, Medicaid, Blue Cross/Blue Shield, and often commercial claims.  There is a 
cost for each of these programs, but, in most cases, there is no charge for claims filed.  
Information on other available EDI modules can be obtained by calling your local 
Value-Added Reseller or NDCHealth directly at (800) 689-4550.  

! Look up EDI Receiver Entry. 

Referring Provider Records 
Many patient visits are the result of a referral from another provider.  When a patient is 
referred to your practice, you must record the Unique Physician Identification Number 
(UPIN).  The referring provider name prints in Box 17 of the CMS- or HCFA-1500 
claim form, and the UPIN prints in Box 17a. 

Go to the Lists menu and select Referring Providers.  To enter a new referring provider 
record, press *, or click [New]. 

Address Tab 
The Address tab takes the basic information, plus specialty data and the license number.  
It allows space for you to indicate whether this doctor is a Medicare participating 
healthcare provider. 
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Default PINs Tab 
The Default PINs tab displays UPIN and other identification numbers and 
information.  If a practice is performing internal lab work and/or X-rays, the attending 
provider is also the referring provider.  To get paid for this service, the attending 
provider must also be set up in the Referring Provider file and assigned to the patient. 

! Look up Referring Provider Entry. 

Billing Code List 
A Billing Code is a user-defined two-character alphanumeric code.  Billing Codes can be 
effective in sorting and grouping patient records.  Go to the Lists menu and select 
Billing Codes.  See Figure 5.6.   

 

The Billing Code List window lets you review and edit the codes contained in the 
program and create new ones.  If you want to use a code you have not previously 
entered, click [New] or press * and the window for a code and description appears.   

A billing code range is a filter available in most reports printed in NDCMedisoft. 

! Look up Billing Code Entry. 

Contact List (Advanced and above)  
The Contact List contains a ready reference of people with whom you have had contact 
during the course of business.  The Contact window has space where you can add notes 
concerning your conversations to help you keep track of what was discussed and any 
conclusions or information shared during the conversation.  For more information on 
the use of this feature, see the Help files. 

! Look up Contact Entry. 

Figure 5.6
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Eligibility 
You can check a patient’s insurance coverage eligibility before the patient gets to the 
office.  This feature requires a separate sign-up procedure.  The topic is addressed in 
greater detail in Chapter 8, Claim Management, page 79. 

! Look up Eligibility Verification and Eligibility List. 

Tutorial Practice 
To review the procedures outlined in this chapter, you can perform the following steps 
using the tutorial database provided with this program. 

Opening the Practice Record 
Going to the File menu and selecting Open Practice.  See Figure 5.7. 

 

The sample data set up in this tutorial is under the practice name Medical Group 
(Tutorial Data).  Highlight that name and click [OK].  If this practice name does not 
appear, click the [Add Tutorial] button.  Then select the practice and click [OK].  The 
practice name appears in the Title bar of the main NDCMedisoft window.   

Figure 5.7
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Creating a New Procedure Code 
Click the Procedure Code List speed button.  In the Procedure/Payment/Adjustment 
List,  Click [New].  See Figure 5.8. 

 

In the General tab, enter XYZ in the Code 1 field, then enter Test Code in the 
Description field.  Select Procedure charge in the Code Type field.   

The Account Code is an internal code for in-house bookkeeping.  It can be any 
configuration of letters or numbers you want to assign to each accounting function, i.e., 
cash, checks, etc.  Enter OVSP (for Office Visit-School Patient). 

Leave Type of Service empty.  Enter 11 as the Place of Service, and leave Time to do 
Procedure empty.  

Leave the Service Classification field alone.  It defaults to A. 

Leave the Alternate Codes fields alone.   

Click the Taxable box to mark this code as needing tax charges added to it. 

Click the Patient Only Responsible box. 

Figure 5.8
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No other fields in this window are applicable, so skip them.   

Open the Amounts tab and enter 50 in field A as the amount you want charged for this 
procedure.  See Figure 5.9. 

 

Enter 20 in the Cost of Service/Product field and 50 in the Medicare Allowed Amount 
field.  Click [Save] 

Editing Procedure Codes 
You need to edit a couple of the procedure codes in the program.  If the 
Procedure/Payment/Adjustment List window is not already open, click the Procedure 
Code List speed button.  In the Search for field, enter 99214.  Click [Edit].  Open the 
Amounts tab.  In field A, enter 65.  Click [Save].   

In the Search for field, enter 82954.  Click [Edit].  Open the Amounts tab and enter 10 
in the A field.  Click [Save].  Click [Close]. 

Creating a MultiLink Code 
Go to the Lists menu and select MultiLink Codes.  Click [New].  See Figure 5.10. 

Figure 5.9
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In the MultiLink Code: (new) window, enter SCHOOLPHYS in the Code field.  Enter 
a description in the Description field, such as Physical, School.  In Link Codes 1, enter 
80050, the general health screen panel; in Link Codes 2, enter 81000, a routine 
urinalysis; in Link Codes 3, enter 93000, an EKG; and in Link Codes 4, enter 99241, 
office consultation;.  When you have selected all of the procedures you want linked, 
click [Save].  Click [Close]. 

Creating a New Diagnosis Code 
Click the Diagnosis Code List speed button.  Click [New].  See Figure 5.11. 

 

Figure 5.10 

Figure 5.11
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Enter TEST in the Code 1 field.  In the Description field, enter Test Diagnosis Code.  
Click [Save].  Click [Close].  

Setting up a New Provider Record 
Click the Provider List speed button.  In the Provider List window, click [New].  See 
Figure 5.12.   

 

Skip the Code field.  Enter the following information:   

Name:  I. M. Urdoc 

Credentials:  MD 

Address: 1 Healthy Avenue, Stressfree, IA 68888 

Phone number:  (123) 443-2584 (123-4HEALTH).  There is no fax number, so leave 
that field blank.   

This provider is a Medicare participating provider.  Click the Signature on File check 
box, then select or enter 4/3/89 as the Signature Date.  Click the Medicare Participating 
check box.  Enter Dr. Urdoc’s License Number as ZYX1111110.  His practice specialty 
is General Practice.   

Figure 5.12



 
50     NDCMedisoft 

In the Default PINs and IDs tab, enter 102938475 in the SSN/Federal Tax ID field and  
22222222 in the Medicare field.   
No other information is available right now for Dr. Urdoc.   

When you have entered all the information, click [Save].  Click [Close]. 

Setting Up a New Insurance Carrier Record   
Click the Insurance Carrier List speed button.  Click [New]. 

In the Name field, enter A1 Insurance Partners.  In the other appropriate fields, enter 
PO Box 11223, Hartford, CT 01234.   

Open the Options tab.  See Figure 5.13. 

 

Enter Best Choice in the Plan Name field.  Enter HMO in the Type field.  Leave the 
Procedure Code Set and Diagnosis Code Set fields alone for now.     

What you select in the various Signature on File fields determines what prints in Boxes 
12, 13, 31, and 24K of the CMS- or HCFA-1500 form.  For now, select Signature on 
File in each of them.  Select Provider Name and PIN in the Print PINs on Forms by 
clicking the box and selecting that option.  Leave the Default Billing Method as Paper.  

Figure 5.13 
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Open the EDI, Codes tab.  We aren’t dealing with electronic claims, so skip the top 
section of the window.  In the respective default payment application code fields, select 
INSPAY, WROFF, WITHHOLD, and DEDUC.  Click [Save].  Highlight A1 
Insurance Partners, and click [Edit].  (A new insurance record must be saved before the 
last two tabs are accessible.)  

Open the PINs tab.  For IM Urdoc, enter 1122334.  When finished, click [Save].  Click 
[Close]. 

Creating a New Address Record 
Click the Address List speed button to open the Address List window.  Click [New].  
See Figure 5.14. 

 

Leave the Code field blank this time and let the program automatically assign one based 
on the Name field.  The code is not assigned until all information is entered and saved. 

Figure 5.14
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In the appropriate fields, enter Pizza Hut, 1234 Fifth Avenue, Anywhere, IA  85000, 
1234567890  (this is the phone number).  In Fax Phone, enter 1234567899.  Be sure 
the Type field reflects Employer.   

The contact for this entry is Murray and in the ID field, enter Hawaiian, 3-Cheese.  
The ID, Extra 1, and Extra 2 fields are used for any other information you may want to 
enter to identify this entry.  When finished, click [Save].  Click [Close]. 

Setting Up a New EDI Receiver Record 
Go to the Lists menu and select EDI Receivers.  Click [New].  See Figure 5.15.   

 

In the Address tab, enter Truly Wonderful Receiver, 2468 Appreciate Lane, Happy, IA 
55555, 4802468123 (this is the phone number).  The contact is George.  Again, since 
we are not dealing with electronic claims in this tutorial, skip the Modem and ID and 
Extra tabs.  Click [Save].  Click [Close]. 

Setting Up a Referring Provider Record 
Click the Referring Provider List speed button.  Click [New].  See Figure 5.16.   

Figure 5.15
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Create a record for Frank N. Stein, MD; 1 Spooky Drive, Transylvania, IA 85004; enter 
4805432109 as the Cell Phone number, fnstein@mdsx.com in Email address, 
4800981234 in the Office phone, 4800981233 as the Fax and 6026789123 as the 
Home phone number.  Dr Stein is a Medicare participating physician, his License 
Number is 5551212900, and his specialty is Gastroenterology.   

Open the Default Pins tab.  Dr. Stein’s Federal Tax ID is 23YXO444 (be sure to choose 
Federal Tax ID Indicator), and his UPIN is 2X3XC12.  That’s all the information 
needed right now.  When information is entered in both tabs, click [Save].  Click 
[Close]. 

Figure 5.16
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Chapter 6 
 

Patient Record Setup  
Patient List 
Set Up 
One of the most important functions in getting your practice computerized is entering 
patient data.  Go to the Lists menu and select Patients/Guarantors and Cases or click 
the Patient List speed button.  You can search for an existing patient’s record by 
entering the first few letters of his or her last name in the Search for field.   

If you want the Patient List window to open automatically each time you open the 
program, go to Program Options and click Patient List in the Show Windows on Startup 
section of the General tab. 

Clicking [New] or pressing * opens an entry window to set up a new patient.  Each of 
the data windows during setup lets you edit, change, or delete the information 
contained in window.  The importance of entering correct information into the patient 
data files cannot be overemphasized.  From setting up the chart numbers to entering 
percentage amounts for insurance claims, the effect of data entry is far reaching. 

It is especially important to set up the guarantor when doing insurance billing. 

! Look up Patient/Guarantor Entry. 
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Setting Up the Chart Number 
Every patient or guarantor must have a chart number and be set up in the database 
before transactions can be entered.   

If using the program’s default automatic settings, each chart number consists of eight 
alphanumeric characters.  If you leave the Chart Number field blank, the program 
automatically assigns a unique chart number.  If you want, you can change the default 
settings and have the program automatically assign numeric chart numbers.  Go to 
Program Options, open the Data Entry tab, and click Use numeric chart numbers in the 
Patient section.   

If you want to establish your own patient chart numbering system, type a number or 
code as soon as you enter the new patient window.  There is no need for corresponding 
numbers within a family; the number sequence has little bearing on grouping of 
patients.  Each patient is set up individually in the program and individual bills are 
prepared for each guarantor.  It is important to understand that once assigned, the Chart 
Number cannot be changed.  To correct a wrong chart number, you’d have to delete the 
entire patient record and create a new one with the proper chart number.  All other data 
in the patient record can be modified. 

! Look up Chart Number. 

New Patient Setup Window 
Clicking [New Patient] or pressing * lets you set up a new patient record in the 
program.  See Figure 6.1.   
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Enter all known or necessary information.  When entering an address, the focus moves 
from the Street fields directly to the Zip Code field.  The program has a feature that saves 
city, state, and zip code information in a table.  Once you enter a zip code with its 
associated city and state, the next time you enter the zip code, the City and State fields 
are filled in automatically, saving you time when entering new records. 

In the NDCMedisoft Advanced and NDCMedisoft Network Professional programs, 
you can establish default information, applied to all new patient records.  Enter that 
information which is generally the same for all of your patients, then click [Set Default].  
To remove your new default settings, hold down c and the button name changes to 
[Remove Default].   

When you enter a Social Security Number, the program checks through the patient 
records for any duplications.  If a number you enter is a duplicate, the program displays 
the name and chart number of the patient first showing that Social Security Number. 

Do not include spaces or hyphens as you enter dates or phone numbers.  If you want the 
program to automatically hyphenate Social Security Numbers, go to Program Options, 
open the Data Entry tab, and click Auto format Soc. Sec. # in the Patient area.  Then 
enter Social Security Numbers without hyphens.   

Figure 6.1
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The Other Information tab contains fields for additional information relevant to the 
patient record, such as the assigned provider, identification codes, and emergency 
contact numbers.  If you have chosen to use patient flagging (Advanced and above), the 
Flag field lets you choose which flag to associate with the patient record, including 
None if you want to disable the feature after assigning a flag.   

! Look up Patient Flagging (Advanced and above). 

If the patient’s employer record has been set up in the Address file, this data is available 
in the Other Information tab.  Clicking the arrow or magnifying glass icon to the right 
of the Employer field displays a list of those employer records already stored in the 
program.  If the employer record you need is not available, press * for the new 
employer setup.   

! Look up Patient/Guarantor Entry and Patient List. 

Custom Patient Designer (Advanced and above) 
A practice may need information that is not already gathered in the accounting package.  
NDCMedisoft lets you design a custom tab in the Patient/Guarantor window for 
gathering this data.  It could be eye color, hair color, emergency contact information, 
and so on.  Go to the Tools menu and select Design Custom Patient Data. 

If your insurance carrier requires you to send ambulance information for an EDI claim, 
an option is available to install necessary fields in the Custom Patient Designer.  Call 
(800) 689-4550.  

If you don’t need ambulance information or if you want to add additional fields to the 
ambulance fields, go to the Tools menu and select Design Custom Patient Data.  The 
Custom Patient Designer window opens.  See Figure 6.2.   
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 Installing this feature replaces any existing fields in the window.  

Within the large blank area on the right, add whatever fields you want to gather the 
extra data.  Similar to the Report Designer function (see Chapter 12, page 119), you 
have tools with which to define the fields, place Text or Data fields in the window in 
whatever order you desire, and create shapes to frame, divide or accent the fields or 
sections within the window.  There is an Add New Data Field speed button that lets 
you specify the type of data the fields contain (Alphanumeric, Date, or True/False) and 
then establish the field names.  Click a field type speed button, and then click in the 
window to place the field.  Each field, when created, can be adjusted as to size, 
alignment, and position. 

Multiple custom patient tabs can be designed in a database, and you can access them by 
opening the appropriate tab in the Patient/Guarantor window.  

! Look up Custom Patient Designer. 

Figure 6.2
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Setting up a Case 
Transactions within the program are generally case-based.  A case is a grouping of 
procedures or transactions generally sharing a common treatment, facility or insurance 
carrier.  You can set up as many new cases as needed.  See Appendix D for a discussion 
on cases, page 161.  

Each new case that is set up needs to contain the patient’s pertinent information.  If you 
click [New Case] or press * with the case list selected, only the Guarantor designation 
is copied to the new case.  To save time, click [Copy Case] to copy all the current case 
information, then revise those portions of the data that are different for the new case.   

You definitely want to open a new case if the treatment comes under a different 
insurance carrier.  Suppose you are treating a diabetic patient regularly and he is injured 
on the job.  His visits regarding the work-related injury should be kept in a Workers’ 
Compensation case, totally separate from the regular visits, for legal and reporting 
reasons.  The ideal situation is to have a case for each different malady from which the 
patient suffers.  Then you can pull up groupings of case visits to help you evaluate the 
patient’s overall health status.  By pulling a case that contains all diabetic treatments, 
one for high blood pressure, one for angina, and one for cancer, you get a better picture 
of the full range of health problems.   

 

If a patient comes for a onetime treatment, you can create a transaction for that 
treatment without creating an entirely new case.  Just select different diagnosis 
codes in Transaction Entry when creating the transaction. 

Existing case numbers are found in the Patient List window through which you set up 
new cases.  Case numbers set by the program are sequential and not one of the numbers 
is repeated within the program in a single data set. 

An existing case can be edited or reviewed through the Patient List window or accessed 
from any Case fields in the program by pressing (.  The patient Case window contains 
tabs that display fields necessary to complete an insurance claim form.   

! Look up Understanding Cases. 

In NDCMedisoft Advanced and NDCMedisoft Network Professional, you can limit 
the tabs that are displayed.  If a tab is not applicable to your practice or if you would 
prefer not to have it visible, right-click the tabs.  In the list that appears, click each tab 
you don’t want displayed.  That tab no longer appears in the Case window.  To add tabs 
that are not visible, right-click the tabs and click the tab you want displayed to remove 
the checkmark.   

The Personal tab establishes the patient and his or her guarantor information, marital 
and student status, and employment.   

! Look up Case (Personal). 
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The Account tab displays the provider, referral, and attorney information set up in the 
Address file.  It also covers billing and price codes and information on visit 
authorization, including the number of visits.    

! Look up Case (Account). 

The Diagnosis tab allows for entry of up to four default or permanent diagnosis codes 
for this case, plus entry for allergy and EDI notes.  Information in the Allergies and Notes 
section is displayed in Transaction Entry and the New Appointment Entry window of 
Office Hours when a Chart number is selected.   

! Look up Case (Diagnosis). 

The Condition tab allows for entry of information pertinent to the illness, pregnancy, or 
injury and tracking of symptoms.  It also includes dates relative to the condition, plus 
Workers’ Compensation information.   

! Look up Case (Condition). 

The Miscellaneous tab contains supplemental information features like lab work 
charges, whether the lab is in-house or outside, Referral and Prescription Dates, Local Use 
A and Local Use B fields, case Indicator code, and prior authorization.  It also provides 
space for recording information concerning a primary care provider outside your 
practice.   

! Look up Case (Miscellaneous). 

The Policy 1, 2, and 3 tabs let you connect up to three insurance carriers to the patient 
record, including policy and group numbers, and Insurance Coverage Percents by Service 
Classification (how much the carrier pays for certain types of procedures).  The service 
percentage classification is tied to each procedure code.   

! Look up Procedure/Payment/Adjustment Entry. 

A Deductible Met check box is provided in the Policy 1 tab.  When the patient meets his 
or her deductible obligation for the year, click this box and the status is displayed in the 
patient account detail of the Transaction Entry window.   

The three tabs have the same layout, except Policy 1 asks about Capitated Plan and Co-
Pay Amount and has the Deductible Met check box; Policy 2 asks if this is a Crossover 
Plan; and Policy 3 can be set up for tertiary or third-party involvement. 

! Look up Case (Policy 1, 2, and 3). 

The Medicaid and TRICARE tab includes fields for all submission numbers, reference, 
and data for each carrier.  It also includes branch of service information. 

Within the Medicaid and Tricare tab are EPSDT and Family Planning indicators, 
required submission numbers, and reference data for the case.  It also includes service 
information for TRICARE claims.   
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The Multimedia tab (Network Professional only) allows you to add bitmaps, video, or 
sound to your patient records.  

! Look up Case (Multimedia) and Multimedia Entry. 

Custom Case Designer (Network Professional Only) 
As well as creating custom patient tabs, you can create custom case tabs in the Custom 
Case Designer.  Information in these tabs might be vital signs, immunization records, 
etc.  Go to the Tools menu and select Design Custom Case Data.  See Figure 6.3. 

 

Within the large blank area, add whatever fields you want to gather for extra data.  
Similar to the Report Designer function (see Chapter 12, page 119), you have tools with 
which to define the fields, place Text or Data fields in the window in whatever order 
you desire, and create shapes to frame, divide or accent the fields or sections within the 
window.  There is an Add New Data Field speed button that lets you specify the type of 
data the fields contain (Alphanumeric, Date, or True/False) and establish the field 
names.  Click a field type speed button, then click in the window to place the field.  
Each field, when created, can be adjusted as to size, alignment, and position. 

Multiple custom case tabs can be designed in a database, and you can access them by 
clicking on the appropriate tab in the patient Case window. 

! Look up Custom Case Designer and Format/Design Reports. 

Figure 6.3
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Tutorial Practice 
To review the procedures outlined in this chapter, you can perform the following steps 
using the tutorial database provided with this program. 

Entering Patient and Case Records 
Setting Up a New Patient Record 
Click the Patient List speed button to open the Patient List window.  Click [New 
Patient].  See Figure 6.4.  

 

The Patient/Guarantor: (new) window opens on the Name, Address tab.  Chart 
Number is the first field.  Skip this field and let the program create a unique chart 
number. 

Create a record with the following information:  Name:  I.B. Gone; address:  246 
Outtahere Street, Pasturize, IA 55555; e-mail address: ibgone@wahoo.com; home 

Figure 6.4
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phone number:  (513) 224-4668 (remember to not enter parentheses or hyphens in 
phone numbers); work number:  (123) 456-7890; cell phone:  (513) 224-1111; fax 
number:  (513) 531-9766; birth date:  1/12/1975; sex:  Male; Social Security Number:  
012-34-5678.   

Open the Other Information tab.  In the Type field select Patient.  Assign I. M. Urdoc 
as the provider, click Signature on File and enter the signature date of September 15, 
1998.       

In the Employer field, select Pizza Hut.  Mr. Gone’s status is Full time.  When finished, 
click [Save].  Click [Close]. 

Opening a New Case 
Open the Patient/Guarantor List window by clicking the Patient List speed button.  
Highlight I.B. Gone in the left section of the window.  Then choose the Case radio 
button at the top right of the window.  Click [New Case].  See Figure 6.5. 

 

Enter Back pain as the description of this case.  Change Marital Status to Single.  All 
the other information is taken from the patient record.   

Figure 6.5
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Open the Account tab.   See Figure 6.6. 

 

In the Assigned Provider field, enter IMU (for I.M. Urdoc).  In Referring Provider, select 
Frank N. Stein. 

Let’s say Mr. Gone was referred by your stellar Yellow Pages ad.  In Referral Source, 
select Yellow Page Ad.   

You’ve already received information from Mr. Gone’s insurance carrier and you know 
that treatment is authorized through October 2005.  Enter that date in the Treatment 
Authorized Through field.  In Authorization Number enter 6489211, in Authorized 
Number of Visits enter 12, and in the ID field, enter A. 

Open the Diagnosis tab.  See Figure 6.7.  

Figure 6.6
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In Default Diagnosis 1, enter 724.2, and in Default Diagnosis 2 enter 847.2.  Mr. Gone 
has informed you that he is allergic to Codeine, so enter that in the Allergies and Notes 
field. 

Open the Condition tab.  See Figure 6.8.  

Figure 6.7
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The reported injury date was September 20, 2000, the Illness Indicator is Injury, the first 
consultation date was September 21, 2000.  There have been no similar symptoms.  
This was related to an auto accident, so select Auto in Accident Related To.  Mr. Gone 
lives in Iowa but was visiting people in Arizona when the accident happened, so indicate 
AZ as the State.  In Nature Of, select Injured during recreation.  No other fields are 
important for this case so leave them blank.   

Open the Policy 1 tab.  See Figure 6.9. 

Figure 6.8
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In Insurance 1, select A1 Insurance Partners.  Mr. Gone’s Policy Number is 9782XYZ, 
and his Group Number is 98KEY.  The Policy Start date is September 15, 1998 and the 
End date is September 14, 2005.  Click Assignment of Benefits/Accept Assignment.  Leave 
the default information in the rest of the fields in this tab.   

Mr. Gone has a secondary insurance policy.  Open the Policy 2 tab.  Select First Rate 
Insurance Company as his secondary coverage, Policy Number 00034526Z, and the 
Group Number is 888B.  Policy Start and End dates are October 1, 1999 and 
September 30, 2004, respectively.  Click Assignment of Benefits/Accept Assignment.   Your 
carrier assigns a Claim Number; in our case let’s use 283-8765D. 

No fields in the Medicaid and Tricare or Multimedia (Advanced and above) tab are 
necessary for Mr. Gone, so skip this tab.  Click [Save] when finished.

Figure 6.9



 
     Chapter 7:  Transaction Entry     69 

 
 
 

Chapter 7  
 

Transaction Entry  
The Transaction Entry window is designed for easy transaction entry and to display as 
much information with as few clicks or keystrokes as possible.  Not only do you record 
all patient visits and their charges, you also enter payments and adjustments that may be 
added to the ledger.  See Figure 7.1. 

 

Figure 7.1 
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NDCMedisoft is an Open Item Accounting program, meaning that transactions entered 
are marked when paid but remain on the active ledger as long as the case is active.  
There is no clearing of the ledger and bringing up a total to start a new month, as with a 
balance forward program.   

Transaction entry is generally case-based.  Transactions are entered into the patient 
ledger grouped by case number.  You can have a case for each transaction or for each 
diagnosis type.    

! Look up Transaction Entry. 

Start with a Chart Number 
Click the Transaction Entry speed button.  Within Transaction Entry, two numbers are 
of prime importance: the chart number and the case number.    

Enter the chart number or click the Chart field and select the chart number from the 
drop-down list.  If the patient record has not yet been set up, press * to bring up the 
Patient/Guarantor: (new) window.  See Chapter 6 for setting up a patient record, page 
55. 

When you press t or e, a case number is selected in the Case field (if one is 
available).   By default, the most recently opened case is opened.  You can change the 
default in the Program Options window, Data Entry tab, Case Default field, see page 25.   

If you want to create a new case, the shortcut to bring up the Case window is *.  
Another method of selecting a specific case is to click the speed button to the right of 
the Case description field to open the Select Case by Transaction Date window.     

! Look up Select Case by Transaction. 

A document number is automatically assigned by the program and is used for reference 
and filtering purposes, whether the field is displayed in the Transaction Entry window 
or not.  You can replace this number with your own if you want.   

If you use superbills, you can enter a superbill Serial Number in this field to help keep 
track of the superbill.  To use superbill numbers in Transaction Entry, open Program 
Options and click both Force Document Number and Use Serialized Superbills in the Data 
Entry tab. 

Sometimes there is a need to provide more documentation about a transaction.  This 
can be done in a special Transaction Documentation window activated by pressing % 
or clicking [Note] in the Charges section of the Transaction Entry window.  See Figure 
7.2.   
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There are various transaction documentation types available, e.g., Diagnostic Report, 
Ambulance Certification, etc., and they can be viewed in the Quick Ledger. 

! Look up Transaction Documentation. 

Entering a Charge in Transaction Entry 
Once you have selected patient chart and case number in the Transaction Entry 
window, click [New] or click in any column of the Charges section.  See Figure 7.3.   

 

The current date is automatically entered.  If you are entering transactions from earlier 
dates, insert the correct date of the entries with which you are working.  If you have a 

Figure 7.2 

Figure 7.3
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number of transactions from a different date, you can change the program date by 
clicking the date in the lower right corner of the program window and selecting a new 
date.  Be sure to change the date back to the current date when finished. 

Enter information in the Procedure column and any other information that is necessary 
to complete this charge transaction.  The transaction is automatically saved by the 
program.   

To create a second charge transaction, click the down arrow key or click [New].   

Entering a Payment or Adjustment in Transaction 
Entry 
After selecting patient chart and case numbers in the Transaction Entry window, you 
can enter a payment by clicking [New] in the Payments, Adjustments, and Comments 
section of the window.   

The current date is inserted in the Date field.  Select the Pay/Adj Code, then enter Who 
Paid, a Description, and the Amount.  If the payment is being made by check, the check 
number can be entered in the Description field. 

Apply Payments or Adjustments to Charges  

 

We recommend that you apply all payments and adjustments to charges.  
Failure to do so results in other parts of the program not functioning properly, 
i.e., remainder billing and the delay secondary billing feature (Advanced and 
above), to name only two.  In addition, some report results will be incomplete 
or inaccurate. 

You can distribute a payment or an adjustment to a specific charge or charges by 
clicking [Apply].  The Apply Payment to Charges or Apply Adjustment to Charges 
window opens (depending on whether you are applying a charge or an adjustment) and 
lets you direct that payment or adjustment to the proper charge or charges. 

Besides displaying the source of the payment or adjustment and the patient’s name, the 
Apply Payment to Charges or Apply Adjustment to Charges window also displays the 
number of charges in this case.  The upper right corner displays the unapplied amount 
entered in the payment.   

Once the entry is complete and verified, click [Close] to return to Transaction Entry.  
You can then click [Print Receipt] (which gives the patient a Walkout Receipt before 
leaving the office), click [Print Claim] (which prepares entries that have not yet been 
submitted on an insurance claim and sends them to print), or click [Close] to exit the 
window. 

! Look up Apply Payment to Charges or Apply Adjustment to Charges. 



 
     Chapter 7:  Transaction Entry     73 

Patient Treatment Plans (Network Professional only) 
When a patient has a choice of options for the treatment he or she can receive, a 
treatment plan can be prepared which sets out the different treatments offered and the 
cost of each plan. 

! Look up Treatment Plan List. 

Print Receipts, Create Claims 
Once a transaction has been entered and saved, the transaction can be displayed in the 
Transaction Entry window.  By sliding the scroll bar at the bottom of the window, a full 
summary of the transaction is revealed. 

You can now print a receipt for the patient, file a claim, or close the window.   

! Look up Create Claims. 

Billing Charges (Advanced and above) 
This feature lets you apply billing charges to accounts that are past due.   

Before you can use this feature, you must set up at least one billing charge type of 
procedure code.  Do this through the Procedure/Payment/Adjustment List and 
Procedure/Payment/Adjustment: (new) windows.  Fill in the Code 1 and Description 
fields.  Be sure to select Billing charge in the Code Type field.  Add whatever other 
information you want and save the code.  Create as many billing charge codes as you 
need.   

If desired, you can use billing codes (which are used to categorize patient records) and 
indicator codes in applying billing charges.  Be sure these codes are set up if you want to 
use them.   

Go to the Activities menu and select Billing Charges.  Use the range limitations to 
select the records to which you want to apply the billing charges.  The Charges Creation 
Date is the date that appears in the ledger with the billing charges.  This can be whatever 
date you choose (but the transactions created still show on the current day’s activity 
reports). 

Fill out all the requested information, then click [Start].  New transactions are added to 
each patient record that fits the criteria you selected.   

! Look up Billing Charges and Procedure/Payment/Adjustment Entry. 

Quick Ledger (Advanced and above) 
To get quick and easy access to a patient’s ledger from almost anywhere in the program, 
press & or click the Quick Ledger speed button.  See Figure 7.4.  
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While no new transactions can be made to the ledger itself, it is possible to edit and 
print the ledger and gain valuable detail on patient accounts. 

The Quick Ledger detail window is very similar to the Transaction Entry window.  Use 
the horizontal scroll bar to reveal additional data fields.  A navigation bar lets you move 
quickly through the list of transactions.  Three buttons open additional data fields.   

Click [Edit] or press ( to open a panel very similar to the transaction panel in the 
Transaction Entry window where charges, payments and adjustments can be reviewed 
and edited, as needed.  Notes can be added through the Transaction Documentation 
window.  Click [Payment Detail] to display all payments/adjustments made toward a 
specific charge.  Click [Filter] to search which transaction data to display.  Real power 
comes with using multiple filters.  Navigation buttons in the Payment/Adjustment 
Detail window are for selecting other entries in the Quick Ledger to review without 
having to exit the Payment/Adjustment Detail window first.   

 
If you click [Quick Statement], you print statements from the Reports menu.  
If you click [Statement], you print statements form Statement Management. 

! Look up Quick Ledger, Payment/Adjustment Detail, and Transaction Filter. 

Quick Balance (Advanced and above) 
Quick Balance is a quick summary of all remainder charge totals contained within the 
program for a selected guarantor record.  It can be displayed at just about any time 
while working in the NDC Medisoft program by clicking the Quick Balance speed 
button or pressing _.   

If the record selected is a guarantor’s record, the Quick Balance window displays each 
patient for whom the guarantor is responsible and the total qualifying remainder charges 

Figure 7.4
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for each.  If the record selected is not a guarantor’s record, a listing of all the selected 
patient’s guarantors is displayed.  Choose a guarantor to see the quick balance. 

 
If you click [Print] in Quick Balance, you print statements from the Reports 
menu.   

! Look up Quick Balance. 

Tutorial Practice 
To review the procedures outlined in this chapter, you can perform the following steps 
using the tutorial database provided. 

Transaction Entry 
To begin, go to the Activities menu and select Enter Transactions or click the 
Transaction Entry speed button.  See Figure 7.5. 

 

For this exercise, enter GON in the Chart field to pull up Mr. Gone’s chart.  Press 
e.  His most recent case opens and a number appears in the Document field.  If this 
field does not appear and you want to see it, go to Program Options, open the Data 
Entry tab, and click Force Document Number.  Return to the Transaction Entry 
window. 

Figure 7.5 
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To create a new transaction, click any column in the Charges section or click [New].  
Any information contained in the case Allergies and Notes box are popped up for your 
view.  Click [OK] to clear this message and continue.    

Enter 99214 (Office visit) in the Procedure column.  Press e.  All available 
information concerning that procedure code is automatically entered in the appropriate 
column.  The charge shows $65 for the visit.   

To create a second charge transaction, press the down arrow or click [New].  Now enter 
a second procedure code for this visit, 82950 (Glucose Test).  Note that the Amount 
field shows $10.   

Mr. Gone is making a payment of $10 on the account.  Click any column in the 
Payments, Adjustments, and Comments section, then enter the procedure code for a cash 
co-payment (COPAY).  In Who Paid, select Mr. Gone.  In the Description field, enter 
Co-payment, and enter 10 in the Amount field.  Click [Apply]. 

The Apply Payment to Charges window shows each of the charge entries that have been 
made and a white column marked This Payment.  See Figure 7.6. 

 

With the $10 to apply, select the charge that is $65.00, click in the This Payment 
column of that transaction, and enter 10.  Click [Close].   

You need to make an adjustment, so click [New] in the Payments, Adjustments, and 
Comments section of Transaction Entry.  Enter the adjustment code CACSYDISC, in 
the Pay/Adj Code field, Courtesy Discount in the Description column, and 5 as the 
adjustment amount.  Click [Apply].    

Figure 7.6
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The Apply Adjustment to Charges window is similar to the Apply Payments to Charges 
window.  See Figure 7.7. 

 

Locate the $65 charge and enter 5 in the This Adjust column.  Click [Close] to return to 
the Transaction Entry window.    

Transaction Documentation 
You need to add a note to the first transaction.  Locate that transaction in the Charges 
area and click [Note] in that same area.  (You can add a note to either a charge 
transaction or a payment/adjustment transaction.)  See Figure 7.8. 

 

The default Type is Transaction Note (internal use only).  Enter the following in the 
Documentation/Notes area of this window:  Follow up with the carrier on this charge. 

Figure 7.7 

Figure 7.8 
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Click [OK].  Click [Save Transactions].  In the column to the right of the selected 
transaction there is a small icon, which indicates that a note has been added.  This 
indicator is also displayed in the Quick Ledger window next to this transaction. 
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Chapter 8  
 

Claim Management 
This chapter explains briefly how to manage claims within the Claim Management 
window and includes creating, editing, printing/reprinting, and listing claims, as well as 
changing claim status. 

The Claim Manager’s Job  
To help you better understand the function of claim management, let’s use a shipping 
analogy (see also Appendix D, page 161).  Whereas Cases are containers filled with 
claims for specific diagnoses, claim management is the process by which the cases are 
checked, sorted and delivered.  In other words, claim management is the process of 
making sure all shipments are correct, ready to be sent and shipped to the right 
companies (insurance carriers).   

The Claim Manager (the person performing claim management) checks the claims, 
makes sure the boxes are properly marked, and sends them on their way.  She 
determines whether the shipment goes by truck (paper claims) or by air (electronic 
claims).  When a box is returned (rejected claim), the Claim Manager makes whatever 
changes are necessary (with help from the EOB or Audit/Edit Report) and ships the box 
again (resubmits the claim). 

Someone else sees and treats the patients.  Another person enters data from the superbill 
to begin the billing process.  Once all the data has been entered, it must go through the 
Claim Manager’s office before being sent to an insurance carrier. 

The Claim Manager focuses on three principal areas, not necessarily sequential: Review, 
batch, and final review. 
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Watchdog: The Claim Manager is, first of all, the watchdog of the claims.  She checks 
each claim and verifies the numbers.  She has the authority to edit the claim and make 
needed changes.  If she sees that a claim should go to a different carrier than indicated, 
or if the EDI receiver information is incomplete, she corrects the record.  She has access 
to all three carriers, primary, secondary, and tertiary.  She checks the billing date and 
how the claim is to be sent, either by paper or electronically.  And then she can indicate 
the status of the claim.  There is a place where she can add any special instructions that 
need to go with the claim. 

Batch ‘em up! The function of creating claims serves to group claims that are headed to 
the same destination.  The Claim Manager gathers and sorts by range of dates or chart 
numbers.  Transactions can be selected that match by primary carrier, Billing Code, case 
indicator, or location.  Random Billing Code numbers can be selected.  The Claim 
Manager can also indicate a minimum dollar amount for creating the claims, 
eliminating claims too small to be worth billing. 

Reviewer: The Claim Manager has at her fingertips a [List Only] button that lets her 
retrieve claims that match a certain criteria that she has determined.  The List Only 
Claims That Match window is a “show me” window that lets the Claim Manager review 
all that is in the program.  The claims that come before her can be given a final check 
for accuracy and completeness.  She can select specific or all carriers to review.  She can 
group all electronic media claims.   

Besides these three focus areas, the Claim Manager also has responsibility to mark claims 
that are paid and those that are rejected. 

Marking paid claims: The date of submission in the Claim Management window 
indicates when the claims were shipped or transmitted.  Claims are marked under the 
designation of “Sent” and the date is automatically inserted.  The claims stay in Claim 
Management marked as “Sent” until they are manually changed in the Claim edit 
window as having been received and dispatched by the carrier.  When a payment is 
received, use the EOB to enter all payments through transaction entry.  If selected in 
Program Options (Payment Application tab, Mark Completed Claims Done field), the 
status for paid claims is automatically changed to “Done.”  

Handling rejected claims: When a paper claim is rejected for payment by the insurance 
carrier, change the payment status in the Claim Management window from “Sent” to 
“Rejected.”  

Now put yourself in the picture.  Picture yourself as the Claim Manager.  The tools by 
which you get the job done are found in Claim Management.   

To perform any claim management functions, go to the Activities menu and select 
Claim Management, or click the Claim Management speed button.  See Figure 8.1.   
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Creating Claims 
It is in the creating claims operation that a claim is finally prepared for submission.  See 
Figure 8.2.   

 

Preparation can involve a single claim or a batch.  Claims are gathered by range of dates 
and/or chart numbers.  The selection of claims to be created can be further narrowed by 

Figure 8.1

Figure 8.2
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specifying detail in the Select transactions that match, Provider, and Include transactions if 
the sum is greater than fields.   

! Look up Create Claim. 

Editing Claims 
This function within the program is the watch dog area where you can verify and edit 
the claims that are ready to be submitted for payment.  It is a safety net where problems 
can be solved, and information entered in a transaction can be overridden if necessary.  
An override in the Claim edit window changes that claim submission, but does not 
affect the default database. 

As the claim comes up for final verification, it may be determined that a change needs to 
be made, such as a different carrier or EDI receiver.   

By highlighting a specific claim and clicking [Edit] or pressing (, the Claim edit 
window appears with the claim details and information concerning all assigned 
insurance carriers and their pertinent data.  See Figure 8.3.  

 

The detail also indicates submission method assigned to the claim (paper or electronic), 
as well as the claim status.  Claim status options include:  Hold, Ready to send, Sent, 
Rejected, Challenge, Alert, Done, or Pending.  The status of the claim can be changed at 
this point. 

Any time a claim is sent, a batch number is assigned.  That number shows in the Batch 
data box in the center of the window of the claim you are reviewing.  If a claim needs to 

Figure 8.3



 
     Chapter 8:  Claim Management     83 

be resubmitted, the batch number coincides with the number shown in the Claim 
Management window and the one you use to designate those claims that need to be 
resubmitted.   

The Transactions tab reveals a listing of all transactions applied to the selected claim.  
You can split, add, or remove qualifying transactions in this tab.  The Comment tab 
provides an empty box in which to place whatever comments you feel are necessary 
concerning this claim and/or any transactions relating to it.  If you have NDCMedisoft 
Advanced or NDCMedisoft Network Professional, these notes are represented by a note 
icon in the Claim Management window.  Double-click the icon to view or edit the note. 

! Look up Edit Claim. 

Printing Claims 
Once claims are created, you can print them by clicking [Print/Send].  Indicate whether 
you are sending the claims on paper or electronically, then apply filters to select only 
those claims you want to send. 

! Look up Print/Send Claims. 

Troubleshooting Insurance Claims 
 Claim Form Not Centered 

If your insurance claims are printing just a little off center, this can be fixed by 
entering the Report Designer (Reports menu, Design Custom Reports and Bills).  
Open the insurance form you use for printing claims.  Go to the File menu and 
select Report Properties.  In the Form Offset area of the window, adjust the form as 
necessary from the top and/or left margins.  The form is moved in increments of 
one hundredth of an inch.  When the form is adjusted, save the form, exit the 
Report Designer, and reprint your claim. 

For more detailed information, go to the Knowledge Base (www.medisoft.com/kb). 

Reprinting Claims 
If necessary, you can reprint claims without regard to their status.  To reprint an entire 
batch, the status must be changed for the batch. 

! Look up Reprinting Claims. 

Listing Claims 
The Claim Management window has a claims viewing feature that lets you retrieve 
claims that match a set of criteria that you define.  Click [List Only].  See Figure 8.4. 
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In the List Only Claims that Match window, use one or more of the options to limit the 
claims you want to appear in the window. 

! Look up List Only Claims that Match. 

Changing Claim Status 
In the Claim Management window, all submitted claims are automatically marked Sent 
with an indication of the method of submission.  There may be occasions when you 
need to change this status.   

Entire Batch 
If the status of an entire batch needs to be changed, you can change all the claims at 
once.  Highlight one of the claims and note the number listed in the Batch 1 column in 
the Claim Management window.  Click [Change Status].  The Change Claim 
Status/Billing Method window is opened.  See Figure 8.5. 

Figure 8.4
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Choose the Batch radio button and enter the batch number from the Batch 1 column in 
the Claim Management window.  Then choose the appropriate radio buttons in the 
Status From and Status To sections.  All claims with that batch number have the status 
changed when you click [OK].   

Selecting Multiple Claims 
When only one or a few claims within the same batch or claims from multiple batches 
need a status change, hold down the c key and click each claim that needs the status 
changed.  Note that the selected claims do not need to have the same claim status to 
begin with, but they are all changed to the same status.  Click [Edit]. 

In the Change Claim Status/Billing Method window, choose the Selected Claim(s) radio 
button, then choose the appropriate radio buttons in the Status From and Status To 
sections.  If you have chosen claims with varying statuses, choose Any status type in the 
Status From section.  When finished, click [OK].   

! Look up Change Claim Status/Billing Method and Marking Claims. 

Figure 8.5
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Sending Claims to a File 
The HCFA11 program takes data and puts it in an MS-DOS text file in CMS or 
HCFA format.  The program prints only the Group ID Number in Box 11. 

 Only the standard CMS or HCFA form can be used with this feature. 

Now you can follow the instructions given in your third-party program to access this 
claim file. 

! Look up Sending Claims to a File. 

Tutorial Practice 
To review the procedures outlined in this chapter, you can perform the following steps 
using the tutorial database provided with this program. 

Claim Management 
To perform any claim management functions, click the Claim Management speed 
button to open Claim Management.  Be sure you are using the tutorial database for 
these exercises.  See Figure 8.6.    

 

Creating Claims 
Click [Create Claims] in the Claim Management window.  See Figure 8.7. 

Figure 8.6 
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Since we created two charge transactions for I.B. Gone in the Transaction Entry portion 
of this tutorial, let’s create the claim for these charges.  Click the first Chart Numbers 
range field and type GON to set GONI0000 in the first Chart Numbers field.  Repeat 
this process in the second Chart Numbers field.   

Click [Create].  When you return to the Claim Management window, type GON in the 
Search field.  A new claim has been created for GONI0000.   

 The claim number may not match that shown in figures below. 

Editing Claims 
To edit the claim, highlight the GONI0000 claim and then click [Edit] or press ( to 
open the Claim editing window.   

Open the Comment tab.  Type the following message:  Notify attorney when claim 
paid by primary carrier. 

The two transactions we created in Transaction Entry are now part of one claim.  
Suppose you find out that they have to be sent separately (for whatever reason).  Open 
the Transactions tab.  See Figure 8.8. 

Figure 8.7
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This tab shows that both transactions are included in the selected claim.  To split the 
claim, highlight the second transaction, procedure code 82950, and click [Split].  Click 
[Yes] to split the claim.   The second transaction is removed from the claim.  Click 
[Save].  In Claim Management, a second claim has been created and displays below the 
original claim.   

Sending Claims 
Once the claims are ready to go, in the Claim Management window, click [Print/Send] 
to open the Print/Send Claims window.  See Figure 8.9. 

 

Figure 8.8 

Figure 8.9 
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We are only dealing with paper claims in this tutorial, so leave the setting at Paper and  
click [OK].  The Open Report window opens so you can select the claim form on which 
to send the claim.  For now, highlight HCFA-1500 (Primary) and click [OK]. 

The Print Report Where? window pops up to indicate whether you want to preview the 
claim before printing or just send the claim directly to the printer.  For now, leave the 
setting on Preview and click [Start].  

The program assembles the information and then displays the Data Selection Questions 
window.  In each of the Chart Number Range fields, enter GON and press t to print 
only Mr. Gone’s claims.  Click [OK]. 

The claim is displayed in the Preview Report window.  If you have a preprinted CMS- 
or HCFA-1500 claim form, put it in your printer.  Click the Print Report speed button.  
Answer whatever questions you may need in the Print window, and then click [OK].   

Click [Close] in the Preview Report window.  You may briefly see an Update Billing 
Status window and then are returned to Claim Management and the claim for Mr. 
Gone is printed.  The claim status has been automatically changed to Sent, a batch 
number assigned, and the current date entered in the Bill Date 1 column for both 
claims. 

Changing Claim Status 
Through Claim Management, all submitted claims are automatically marked Sent with 
an indication of the method of submission.  The status needs to be changed when the 
claim is paid completely or if a claim is rejected or put on hold or pending for some 
reason.  Time has passed since you printed and sent the claims for I.B. Gone and you’ve 
received a rejection notice from the carrier.  You’ve already corrected the errors and are 
ready to resend the claims.  To locate Mr. Gone’s claims, we’ll use a different portion of 
the  program.  Click [List Only] and type GON in the Chart Number field and press 
t.  Click [Apply].  In Claim Management, make note of the batch number and click 
[Change Status].  See Figure 8.10. 
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Choose the Batch radio button and make sure the batch number in the box matches that 
shown in Claim Management.   

 
Since we used the List Only Claims that Match window to locate the claims, 
the batch number is automatically entered in the Change Claim Status/Billing 
Method window. 

In the Status From section, choose Sent.  In the Status To section, choose Ready to Send.  
Click [OK]. 

You are now ready to send the claims for I.B. Gone again.

Figure 8.10
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Chapter 9  
 

Statement Management (Advanced and 
above)  
This chapter explains briefly how to manage statements within the Statement 
Management window and includes creating, editing, printing/reprinting, and listing 
statements, as well as changing statement status. 

To perform any statement management functions, go to the Activities menu and select 
Statement Management or click the Statement Management speed button.  See Figure 
9.1.   

 

Figure 9.1
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Creating Statements 
Click [Create Statements] to gather available transactions onto a statement.  See Figure 
9.2.   

 

You can create a single statement or an entire batch.  Enter ranges of transaction dates 
and/or chart numbers to control which statements are created.  Also, you can further 
limit the statements created by entering information in the Select transactions that match, 
Include statements if the remainder total is greater than, and Statement Type areas of the 
window.   

! Look up Create Statements. 

Editing Statements 
Highlight a specific statement and click [Edit] or press ( to edit a statement.  You can 
modify general statement information, the transactions that appear on the statement, 
and any comments attached to the statement.  When you make changes in the 
Statement edit window, you modify only that statement and do not affect the defaults 
for other statements.  See Figure 9.3.  

Figure 9.2
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The detail also indicates submission method assigned to the statement (paper or 
electronic), as well as the statement status.  Statement status options include:  Hold, 
Ready to send, Sent, Failed, or Done.  You can also see the statement type, initial billing 
date, batch number, submission count, and most current billing date. 

Any time a statement is sent, the program assigns the statement a batch number.  That 
number shows in the Batch field.  The program also updates the submission count, the 
number of times the statement has been sent, and the billing date. 

The Transactions tab shows all the transactions that appear on the statement.  You can 
split, add to, or remove transactions from statements in this tab.  The Comment tab 
provides an empty box in which to place whatever comments you feel are necessary 
concerning this statement and/or any transactions relating to it.  If you add a note here, 
an icon is displayed next to the statement in Statement Management.  You can double-
click the note to view or edit the note. 

! Look up Edit Statement. 

Printing Statements 
Once statements are created, click [Print/Send] to process them.  Indicate whether you 
are sending the statements on paper or electronically.  If you are sending statements 
electronically, specify the format for the statements.  Then apply filters to select only 
those statements you want to send. 

! Look up Print/Send Statements. 

Figure 9.3
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Reprinting Statements 
If necessary, you can reprint statements without regard to their status.  To reprint an 
entire batch, the status must be changed for the batch. 

! Look up Reprinting Statements. 

Listing Statements 
Click [List Only] to view only those statements that match a set of criteria that you 
define.  See Figure 9.4. 

 

In the List Only Statements that Match window, use one or more of the options to limit 
the statements you want to appear in the window. 

! Look up List Only Statements that Match. 

Changing Statement Status 
In the Statement Management window, all submitted statements are automatically 
marked Sent with an indication of the method of submission.  There may be occasions 
when you need to change this status.   

Statements sent electronically through NDC Statements Processing get a report that 
marks each statement as either accepted or rejected.   

Figure 9.4
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Entire Batch 
If the status of an entire batch needs to be changed, you can change all the statements at 
once.  Highlight one of the statements and note the number listed in the Batch column 
in the Statement Management window.  Click [Change Status].  The Change Statement 
Status/Billing Method window is opened.  See Figure 9.5. 

 

Choose the Batch radio button and enter the batch number from the Batch column in 
the Statement Management window.  Then choose the appropriate radio buttons in the 
Status From and Status To sections.  All statements with that batch number have the 
status changed when you click [OK].   

Selecting Multiple Statements 
When only one or a few statements within the same batch or statements from multiple 
batches need a status change, hold down the c key and click each statement that 
needs the status changed.  Note that the selected statements do not need to have the 
same status to begin with, but they are all changed to the same status.  Click [Edit]. 

In the Change Statement Status/Billing Method window, choose the Selected 
Statement(s) radio button, then choose the appropriate radio buttons in the Status From 
and Status To sections.  If you have chosen statements with varying statuses, choose Any 
Status Type in the Status From section.  When finished, click [OK].   

! Look up Change Statement Status/Billing Method and Marking Statements. 

Figure 9.5
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Tutorial Practice 
To review the procedures outlined in this chapter, you can perform the following steps 
using the tutorial database provided with this program. 

Statement Management 
To perform any statement management functions, click the Statement Management 
speed button to open Statement Management.   

Be sure you are using the tutorial database for these exercises.  See Figure 9.6.    

 

Creating Statements 
Click [Create Statements] in the Statement Management window to open the Create 
Statements window.  See Figure 9.7. 

Figure 9.6
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Since we created two charge transactions for I.B. Gone in the Transaction Entry portion 
of this tutorial, let’s create the statement for these charges.  Click the first Chart 
Numbers range field and type GON to set GONI0000 in the first Chart Numbers field.  
Repeat this process in the second Chart Numbers field.   

Click [Create].  When you return to the Statement Management window, type GON in 
the Search field.  A new statement has been created for GONI0000.   

 The statement number may not match that shown in figures below. 

Editing Statements 
To edit the statement, highlight the GONI0000 statement and then click [Edit] or press 
( to open the Statement editing window.   

Open the Comment tab.  Type the following message:  Notify attorney when 
statement paid.  Click [Save]. 

Sending Statements 
Once the statements are ready to go, in the Statement Management window, click 
[Print/Send] to open the Print/Send Statements window.  See Figure 9.8. 

Figure 9.7
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We are only dealing with paper statements in this tutorial, so leave the setting at Paper 
and  click [OK].  The Open Report window opens so you can select the statement form 
on which to send the statement.  For now, highlight Patient Statement (30, 60, 90) 
and click [OK]. 

The Print Report Where? window pops up to indicate whether you want to preview the 
statement before printing or just send the statement directly to the printer.  For now, 
leave the setting on Preview and click [Start].  

The program assembles the information and then displays the Data Selection Questions 
window.  In each of the Chart Number Range fields, enter GON and press t to print 
only Mr. Gone’s statements.  Click [OK]. 

The statement is displayed in the Preview Report window.  Click the Print Report speed 
button.  Answer whatever questions you may need in the Print window, and then click 
[OK].   

Click [Close] in the Preview Report window.  You may briefly see an Update Billing 
Status window and then are returned to Statement Management and the statement for 
Mr. Gone is printed.  The statement status has been automatically changed to Sent, a 
batch number assigned, and the current date entered in the Bill Date column for both 
statements. 

Changing Statement Status 
Through Statement Management, all submitted statements are automatically marked 
Sent with an indication of the method of submission.  The status needs to be changed 
when the statement is paid completely or for some other reason.  Time has passed since 
you printed and sent the statements for I.B. Gone and you’ve received a correction 
notice from the patient.  You’ve already corrected the errors and are ready to resend the 

Figure 9.8
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statements.  To locate Mr. Gone’s statements, we’ll use a different portion of the  
program.  Click [List Only] and type GON in the Chart Number field and press t.  
Click [Apply].  In Statement Management, highlight the statement and click [Change 
Status].  See Figure 9.9. 

 

Choose the Batch radio button and make sure the batch number in the box matches that 
shown in Statement Management.   

 

Since we used the List Only Statements that Match window to locate the 
statements, the batch number is automatically entered in the Change 
Statement Status/Billing Method window.  

In the Status From section, choose Sent.  In the Status To section, choose Ready to Send.  
Click [OK]. 

You are now ready to send the statements for I.B. Gone again. 

Figure 9.9
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Chapter 10 
 

Deposit/Payment Application (NDCMedisoft 
Advanced and above) 
This feature makes creating a deposit list and applying payments, especially EOB 
payments from insurance carriers, an easy process.  In many ways, it is a more 
convenient place to apply payments than Transaction Entry because you enter one 
deposit, then distribute the payment to as many cases as necessary, then click one button 
and all the transactions are created at one time.  If necessary, within the same window, 
open a different patient record and continue distributing payments. 

! Look up Deposit Entry, Apply Payment/Adjustments to Charges, and Program 
Options. 

Click the Enter Deposit/Payment speed button or go to the Activities menu and select 
Enter Deposits/Payments to open the Deposit List window.  See Figure 10.1. 
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In this window, you can select a payment to apply, edit a payment, or create a new 
payment.  The deposit date does not have to be the current date (but the transactions 
entered still appears on the current day’s activity reports).   

When you highlight a payment and click [Apply], the Apply Payment/Adjustments to 
Charges window is opened.  See Figure 10.2. 

 

Figure 10.1

Figure 10.2 
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In this window, select the patient chart number and apply the portion of the payment to 
the applicable charge(s).  When finished, click [Save Payments/Adjustments] to create 
the transactions.   

 
If you check Print Statement Now and click [Save Payments/Adjustments], you 
print statements from Statement Management. 

Then, if you need to apply payments from the same deposit to another patient record, 
select the next patient chart number and continue making payment applications.  This 
window is also tied to the Payment Application tab of Program Options.  Unless 
deactivated, all payment applications are automatically checked as paid in full by the 
payer, allowed amounts are calculated on all charges, and any charges over the calculated 
allowed amounts are automatically entered in the Adjustment field.   

 
Be sure to click [Save Payments/Adjustments] before closing this window or 
transactions cannot be created. 

The payment application feature is designed specifically to closely match the format of 
an EOB.  When you receive an EOB with a payment from an insurance carrier, open 
the Deposit List window, create the total amount deposit, and then apply the payment 
to the cases as specified in the EOB.   

EOB Payments 
Part of the payment structure to a healthcare office from an insurance carrier involves a 
check and an “Explanation of Benefits.”  Widely known throughout the industry as the 
EOB, it lists claims for which payment is being made and, in some cases, an explanation 
of what is not being paid and why. 

Not every insurance claim that is filed with a carrier is paid in full.  It may be that 
payment is 80 percent of the claim or it may be 50 percent.  Other times a claim may be 
totally or partially disallowed.  The EOB explains in these cases.  Normally the part that 
is not paid by the carrier is picked up by a secondary carrier or charged back to the 
patient. 

When an EOB is received, a transaction must be entered to offset the charges.  This is 
done by creating a deposit in the Deposit List window.  If the EOB check covers several 
charges, distributing a payment to specific charges can be handled by clicking [Apply].  
The window lets you select the patient records and claims to be paid and designate how 
much goes to each.   

! Look up EOB/Managed Care/Capitation. 

Managed Care 
One of the important sources of patients and income in many practices has begun to be 
managed care organizations.  In each instance, the HMO or PPO provides a list of 
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patients who have selected your practice as their primary care provider.  Payment is 
made to your practice on a per-patient basis, regardless of whether the patient ever visits 
the office.  When a patient does come in for treatment, he or she pays a set co-pay 
amount. 

The co-pay is charged only by the primary care facility or the facility to which the 
patient is referred by the primary care facility.  After a patient’s visit to the doctor’s 
office, a claim is filed and sent to the carrier.  When the EOB is returned, there is 
seldom a payment included, since payment is made under the capitation program for 
managed care organizations.   

! Look up EOB/Managed Care/Capitation. 

Capitation Payment 
The basis for capitation payments is to provide healthcare for a fixed cost, irrespective of 
the amount of service required by each individual patient.  This is done in connection 
with the managed healthcare services such as HMOs and PPOs.  There is no direct 
relationship between the capitation payment received by the practice and the number of 
patients covered by the plan who actually visit the practice for treatment.  Capitation 
payments are not posted to patient accounts but are entered in the Deposit List window.  
If it is necessary to zero out a patient account, create a zero deposit for the carrier.  For 
each patient covered by the capitation payment who has an outstanding balance, zero 
out the account by entering the remainder in the Adjustment field.  When it is applied, 
the payment shows as zero and the patient’s balance shows as a writeoff in the 
Adjustment field in the Transaction Entry window. 

! Look up EOB/Managed Care/Capitation. 

Tutorial Practice 
To review the procedures outlined in this chapter, you can perform the following steps 
using the tutorial database provided with this program. 

Creating a New Deposit 
Click the Enter Deposits and Apply Payments speed button.  See Figure 10.3. 
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Click [New].   See Figure 10.4. 

 

The payer is A1 Insurance Partners, so be sure the Payor Type is Insurance.  A1 
Insurance Partners conveniently paid $35 by check No. 5237; enter the check number 

Figure 10.3 

Figure 10.4 
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in the Check Number field.  The bank is American Southwest Savings.  Enter the 
amount in the Payment Amount field. 

In the Insurance field, select A1 Insurance Partners.  Since you already set default codes 
when you set up the record for A1 Insurance Partners, the remaining fields are 
automatically filled.  Click [Save].   

In the Deposit List window, be sure this new deposit is selected, then click [Apply].   

The Apply Payments/Adjustments to Charges window is opened.  In the For field, type 
GON and press [Enter] to call up I.B. Gone’s chart number.  See Figure 10.5. 

 

Locate the $65 charge, click the Payment column of that record, and enter 30.  In the 
box below (part of the $10 charge record), enter 5.  Click [Save Payments/Adjustments], 
then [Close].  A message is displayed letting you know that both claims will be marked 
“Done” for the primary carrier.  (This is based on a selection made in Program 
Options.) 

To review what you just did, click [Details] in the Deposit List window.  See Figure 
10.6. 

Figure 10.5
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The Deposit Detail window shows which transactions were affected and what was 
applied.  This window is only for reviewing the details of a deposit.  You cannot edit any 
transaction in this window.  Click [Close] after reviewing the details. 

Click [Close] again to close the Deposit List window.  If you return to the Transaction 
Entry window, a new entry has been created in the Payments, Adjustments, And 
Comments section—this insurance carrier payment.  

Figure 10.6 
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Electronic Services  
Eligibility 
An eligibility inquiry can be made concerning a patient’s enrollment status in a health 
care plan.  Information returned includes, but is not necessarily limited to, the status of 
the patient’s deductible and maximum benefits, the applicable co-payment and 
coinsurance amounts, and information on the patient’s status in specific plan programs 
(e.g., spin down, EPSDT dates, PCP, etc.).  You must register to process verification 
requests, and there is a fee assessed each time you request an eligibility verification. 
Contact your local Value-Added Reseller or NDCHealth directly at (800) 333-4747. 

! Look up Eligibility List and Eligibility Verification. 

NDC Electronic Claims Processing 
NDCMedisoft offers the ability to file electronically.  Electronic submission through 
NDC Electronic Claims Processing is a separate procedure and requires enrollment.   
To get started with electronic claim submission, contact your local Value-Added 
Reseller or call NDCHealth directly at (800) 689-4550 and request the enrollment 
package. 

Optional direct claims software is available to send claims directly to selected carriers 
throughout the country.  Most of these are set up on a state or regional basis and handle 
Medicare, Medicaid, Blue Cross/Blue Shield, and often commercial claims.  There is a 
cost for each of these programs, but, in most cases, there is no charge for claims filed.  
Information on other available EDI modules can be obtained by calling your local 
Value-Added Reseller or NDCHealth directly at (800) 689-4550.  
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NDC Statement Processing 
You can send statements electronically through NDC Statement Processing, the 
clearinghouse which is set up to process NDCMedisoft electronic statements.  
Statements sent electronically through NDC Statement Processing get an instant 
response report that tells what information was sent.   

! Look up Sending Statements Electronically. 

Customizing Statements 
NDC Statement Processing lets you choose alternate formats for both paper (Advanced 
and above) and electronic statements through the Statement Wizard.  Go to the Tools 
menu and select Statement Wizard.   

! Look up Statement Selection in the Statement Wizard Help file. 
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Reports 
Printing Reports 
Reports are printed through the Reports menu.  Select the report you want, enter the 
filters to include only specific information from specific files, and choose to print one of 
three ways:  to screen, to a printer, or to a file.   

! Look up Reports and Printing Reports. 

Available Reports 
Not only does the program build an accounts receivable file and handle statements, 
insurance claims, and electronic billing, it also provides a variety of reports that can give 
you a better understanding of the day-to-day workings of your practice. 

Among the reports generated within the program are Day Sheets, Analysis Reports, 
Aging Reports, Productivity Reports (Advanced and above), Activity Reports (Advanced 
and above), Audit Reports (Advanced and above), Patient Ledger Report, and 
Guarantor Quick Balance List (Network Professional only).   

You can print a title page that shows all the filters used in preparing the report.   

! Look up Program Options. 

Day Sheets  
Day Sheets are available in three reports.  The Patient Day Sheet lists each patient’s 
name, showing all transactions and a summary of activities for the day.  The Procedure 
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Day Sheet breaks down by procedure code the activities of the day, summarizing 
patients treated for each procedure.  The Payment Day Sheet shows the payments made 
on the requested day and the charges to which the payments are applied. 

! Look up Patient Day Sheet, Procedure Day Sheet, and Payment Day Sheet. 

Analysis Reports  
 Billing/Payment Status Report (Advanced and above)  

One of the most powerful tools in NDCMedisoft, the Billing/Payment Status 
Report provides a thumbnail sketch of the current billing and payment status of 
each claim.  The report shows what has been billed and not billed, what is delayed 
for some reason, if the carrier is not responsible or has refused the claim, or if the 
claim is paid in full.  An asterisk (*) next to an amount indicates that entity has paid 
all it is going to pay and the balance, if any, should go to the next responsible payer. 

! Look up Billing/Payment Status Report. 

 Insurance Payment Comparison (Network Professional only) 
The Insurance Payment Comparison report compares the payment records of all 
carriers in the practice. 

! Look up Insurance Payment Comparison. 

 Practice Analysis  
This report summarizes the activity of a specified period (e.g., a month), listing 
each procedure performed, the number of times it was performed, and the total 
dollar amount generated by each procedure.  It shows the average charge, includes 
any costs involved with that procedure, and calculates the net monetary effect on 
the practice’s income.   

! Look up Practice Analysis. 

 Insurance Analysis (Advanced and above) 
This report summarizes all claims filed by category (Primary, Secondary, Tertiary).  
Claims totals are shown for charges and insurance payments in both dollar amount 
and percentage.    

! Look up Insurance Analysis. 

 Referring Provider Report (Advanced and above)  
It is good to keep track of the source of your patients.  The Referring Provider 
Report shows which patients were referred by other practices and the percentage 
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each referral contributes to the overall referred income of the practice, as of the date 
of that report.  The report also includes the UPIN of the referring provider.  By 
blanking out the Referring Provider range in the Data Selection Questions window, 
a report can be generated showing what percentage of the entire practice has been 
referred. 

! Look up Referring Provider Report. 

 Referral Source Report (Advanced and above)  
This is another report for tracking the source of patients who come to the practice.  
For the report to work, however, all referral sources must be entered in the Address 
Book.  A source can be an attorney, a hospital, friends, other patients, or even the 
Yellow Pages.  Most new patient application forms include the inquiry “How did 
you hear about us?”  The Referral Source Report assembles the patient list by source 
(other than provider) and shows how much revenue comes from each source, 
allowing the practice to identify those sources that send profitable referrals and/or 
limit those that are costly or nonproductive.   

! Look up Referral Source Report. 

 Facility Report (Network Professional only) 
This report tracks patients who are seen at different facilities.  Like referral sources, 
all the facilities records are created in the Address List window.  The Facility Report 
assembles the patient list by facility and shows how much revenue comes from each 
facility, helping you identify which generates the most money. 

! Look up Facility Report. 

 Unapplied Payment/Adjustment Report (Advanced and above)  
This report shows any payment or adjustment that has an unapplied amount and 
where the transaction can be found.   

! Look up Unapplied Payment/Adjustment Report. 

 Unapplied Deposit Report (Advanced and above)  
The Unapplied Deposit Report shows all deposits that have an unapplied amount. 

! Look up Unapplied Deposit Report. 
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Aging Reports  
 Patient Aging 

One of the important tools in collections is the patient aging report.  This can be 
printed showing the age of each unpaid transaction for patients.  Default aging 
criteria is based upon the number of days between the creation of the transaction or 
claim and the date of the report you are generating.  The columns break down the 
amounts due that are 30, 60, and 90+ days old.  Aging is from actual date of the 
transaction, so it reflects the true age of the account.  The aging criteria and 
columns can be altered in Program Options.  This report includes all unapplied 
amounts in the totals.  The Date filter has been removed as it would return invalid 
values.  This is the same report that was available in NDCMedisoft V8. 

! Look up Patient Aging. 

 Patient Remainder Aging (Network Professional only)  
This report has the same format as the Patient Aging, but there is a key difference 
in how it works.  A charge does not show up on Patient Remainder Aging until all 
insurance responsibility has been marked complete.   

! Look up Patient Remainder Aging Report. 

 Patient Remainder Aging Detail (Network Professional only)  
This report has the same criteria as Patient Remainder Aging Detail; however, it 
also lists each insurance company on the patient’s account and the date the 
insurance payment was marked complete.   

! Look up Patient Remainder Aging Detail. 

 Patient Aging Applied Payment 
This report differs from the Patient Aging Report in that it contains only applied 
amounts in the totals and it has a Date filter.  In earlier Version 9 releases, this 
report was called the Patient Aging Report but has now been renamed Patient 
Aging Applied Payment Report. 

! Look up Patient Aging. 

 Insurance Aging  
Insurance aging is a tracking tool for claims filed with insurance carriers.  It does 
with insurance what the Patient Aging Report does for patients.  Aging is set to 
show claims that have been on file within the ranges of 0 to 30 days, 31 to 60 days, 
61 to 90 days, and 91 to 999 days.  Aging criteria is based upon the number of days 
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between the creation of the transaction or claim and the date of the report you are 
generating.    

! Look up Insurance Aging. 

 Insurance Aging Summaries (Advanced and above)  
These reports are based on the same data as the insurance aging reports, but the 
information is presented in summary, rather than detail, format.   

! Look up Insurance Aging Summary. 

Production Reports (Network Professional only) 
 Production by Provider, Procedure, and Insurance 
 Production Summary by Provider, Procedure, and Insurance  

These reports give incoming revenue information for each provider, procedure, or 
insurance carrier, respectively.  The summaries do not display as much information 
as the other reports. 

! Look up Production by... or Production Summary Reports. 

Activity Reports (Network Professional only) 
 Daily Activity Report  
 Monthly Activity Report  
 Activity Summary by Provider  
 Activity Summary by Procedure  
 Activity Summary by Insurance  

Activity reports break down financial activity by day or month.  The summary 
reports summarize financial information entered for each provider, procedure, or 
insurance carrier, respectively. 

! Look up Activity Reports or Activity Summary Reports. 
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Collection Reports (Advanced and above) 
 Patient Collection Report 

The Patient Collection Report contains information based on statements marked 
Sent in the Statement Management window, showing what has not been paid, 
statement date, etc. 

! Look up Collection Reports. 

 Insurance Collection Reports 
The Insurance Collection Reports are identical in layout, but each reflects the 
selected insurance level—primary, secondary, or tertiary. This report also shows the 
claim data, what amount is outstanding, etc. 

! Look up Collection Reports. 

Audit Reports (Advanced and above) 
 Data Audit Report  

The Data Audit Report indicates any changes and/or deletions made to program 
data.  With the Data Audit Report, it is possible for a responsible party to check 
any changes made.  If the security feature is used, the report indicates who made 
each of the changes that are reflected in the report.  See Security Setup in Chapter 
4, page 30. 

This report is intended as a protection for the practice and, by using the security 
feature, is accessible only by Level 1 users.  The file can be purged after it has been 
reviewed to avoid what could become a sizeable data file.  The purging of this file is 
performed in File Maintenance, accessed through the File menu. 

! Look up Data Audit Report. 

 Productivity by User (Network Professional only) 
This report tracks user activity in the program. 

! Look up Productivity by User Report. 

Patient Ledger  
This report reflects the account status of each patient.  Charges are shown until a 
payment is entered to remove a specific procedure paid.  You may include all patient 
accounts or select a few.  The patient ledger is similar to a ledger card in a manual 
accounting program.  Since the NDCMedisoft program is a true Open Item Accounting 
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program, it can show all or part of the financial activity for a patient, including the 
current balance and what procedures have not been paid.  Past activity in the account 
includes a listing of all transactions, indicating those that have been paid.  The report 
marks those transactions that have been paid and the amounts. 

! Look up Patient Ledger. 

Guarantor Quick Balance List (Network Professional only)   
This report lists the guarantor quick balances that appear in the Quick Balance feature.  
These balances are the guarantor remainder balances, so if there are charges that the 
insurance company has not paid on yet, then they are not reflected in this report. 

! Look up Guarantor Quick Balance List. 

Custom Report List  
Design capabilities in the program let you generate a variety of custom reports to meet 
the needs of your practice.  To access the customized reports, go to the Reports menu 
and select Custom Report List.  When you create a customized report, it is included in 
the Custom Report List. 

There are numerous reports already formatted that are included in the program and can 
be accessed.  These include: Address List, Billing Code List, Birthday Card, Birthday 
Labels, Claim List, Diagnosis Code List, EDI Receiver List, HCFA-1500 Forms, 
Insurance Carrier List, Insurance Payment Tracer (Claim Mgmt), Laser HCFA-1500 
forms, Patient Birthday List, Patient Face Sheet, Patient List, Patient Recall Labels, 
Patient Recall List, Patient Statements, Pre-Printed Statement, Primary Claim Detail, 
Primary Claim Labels, Primary Claim Summary, Procedure Code List, Provider/Staff 
List, Referring Provider List, Remainder Statements, Remainder Statement 
Troubleshooter Report, Sample Statement with Image, Sample Statement with Logo, 
Secondary Claim Labels, Security Permissions Grid, Superbill, Tertiary Claim Labels, 
Transaction List, Unbilled Transactions, and Walkout Receipts.   

 

In NDCMedisoft Advanced and NDCMedisoft Network Professional, there 
are two statement types: Statement and Statement Management.  If you are 
modifying a statement, make sure you are modifying one with the correct 
type.  You can only print Statement report formats from the Reports menu 
and Statement Management report formats from Statement Management 

! Look up Modifying Existing Reports. 

Load Saved Reports  
This option allows you to reopen reports that were prepared earlier and have been saved. 

! Look up Load Saved Reports. 
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Add/Copy User Reports  
This option allows you to share reports by adding reports to your database that may 
have been prepared by another practice or copying reports to disk for use by another 
practice or for disk storage.   

! Look up Add/Copy User Reports. 

Receive/Send Reports Through NDCMedisoft Terminal 
Within NDCMedisoft, the NDCMedisoft Terminal option can be used to send or 
receive reports by connecting to various bulletin boards using a modem.  The BBS 
(Bulletin Board Service) is set up through NDCMedisoft Terminal.  See Appendix E, 
NDCMedisoft Terminal, page 167. 

! Look up NDCMedisoft Terminal. 

Troubleshooting Report Printing 
Patient Remainder Statements  (Advanced and above) 
If you are having trouble printing patient remainder statements, check to be sure the 
following items have been performed: 

1. The patient has insurance coverage other than Medicare.  This is indicated in the 
patient Case window, Policy 1 tab, Insurance 1 field (also Policy 2 and Policy 3 tabs 
if there is secondary and/or tertiary coverage). 

2. A charge has been posted in the patient case. 

3. A claim has been created. 

4. An insurance payment or adjustment has been posted, applied, and marked as 
Complete to the account for each applicable carrier. 
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NDCMedisoft Report Designer 
Report Designer 
One of the most exciting features of NDCMedisoft is the Report Designer, adding 
flexibility in the creation of reports to best serve your practice or business needs.  Using 
the Report Designer and the existing set of reports, you can generate custom reports 
tailored to meet specific needs. 

Report forms in this section are categorized into several “styles.”  Each style defines basic 
report characteristics, i.e., List, Label, Ledger, Walkout Receipt, Insurance Form, 
Statement, and Statement Management.   

To create custom reports, go to the Reports menu and select Design Custom Reports 
and Bills.   

! Look up NDCMedisoft Report Designer and Format/Design Reports. 

Report Designer Menu Bar 
The Menu bar for the Report Designer is very similar to the Menu bar of 
NDCMedisoft.  See Figure 13.1.   

 

Figure 13.1 
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It lists File, Edit, Insert, Window, and Help menus.   

The File menu is where most of the functions begin.  The Edit menu features the usual 
Cut, Copy, Paste, and Delete options, plus Find Field and Find Again. 

The Insert menu contains a variety of the field types that can be used to create your 
report.  The field types are Text Field, Data Field, Calculated Field, System Data, 
Shapes, and Images).  The field types are also conveniently placed as speed buttons on 
the right side of the toolbar, giving quick and easy access. 

Toolbar  
Besides the New, Open, Save, Preview, Print, and Exit speed buttons, there are Find 
and Find Again buttons, as well as a Hints button that lets you toggle on or off the Help 
that appears throughout the program.  On the right side of the toolbar are the field type 
speed buttons. 

The Format Grid  
For illustration purposes, go to the File menu and select New Report.  Click [Next].  
Choose Patient and click [Next].  Click [Create].  The format grid, which is the basis 
for the layout of the report (excluding insurance and statement forms), generally 
contains three “bands” to help in its organization.  See Figure 13.2. 

 

Figure 13.2 
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The Page Header band is where basic identifying information should be placed, such as 
the report title, page number and date.  Header information appears at the top of every 
page printed. 

The Transaction Detail band, or the body of a report, contains the main information of 
the report and differs from page to page. 

The Patient Footer band contains those fields that typically appear at the bottom of the 
every report.  For example, in a patient list, you might expect to see a page number, a 
date, or maybe the total number of records.   

! Look up Bands under Report Properties. 

Report Properties  
One of the creative features of the Report Designer is the ability to break up the report 
into sections or bands.  Go to the File menu and select Report Properties.  You can 
adjust band height, set data filters and determine the overall general size and margin 
settings.  You can also enter the title, paper size, orientation, and position.  One 
important feature is Form Offset.  This permits the form to be adjusted even fractions of 
an inch so it fits exactly the prescribed form.  You can also affect the order in which the 
documents are printed by using the Sort By feature.   

! Look up Report Properties. 

Field Properties  
Standard Properties 
Each field type has the following options: 

Alignment: Options are Left, Center, or Right, which align the box to report margins.  
There is also an option to Align to Band.  Used in conjunction with one of the other 
alignment designations, it applies the alignment to the height of the band. 

Size: You can specify in the Properties window an exact height and/or width in 
increments of pixels (which are the smallest graphic unit that can be displayed on your 
screen). 

Matching Alignment and Size: You can match the size or alignment of any field or 
group of fields to another. 

Position: Specify an exact position on the page in relation to the top and left edges of 
the report, again in increments of pixels. 

Transparent Background: This option eliminates the white area around data in the 
various fields when the report is printed, showing the data directly over any background 
color.    
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Font: One of the variations you can introduce is changing the font.  As you go through 
the font list in the Font window, a sample of how a highlighted type face looks is shown 
in the sample box. 

Background Color: You can change the background color for each field.  These colors 
are printed with the report if you have a color printer. 

Handles: When a field is selected, it displays black handles.  The handles  
allow the field to be resized, shaped and moved by dragging the handles  
with the mouse.   

Multiple Fields: If you hold down the s key and click on any field speed button, 
you can drop multiple fields by placing your pointer on the format grid and clicking.  
Use the arrow key on the toolbar to release the multiple lock or click on another speed 
button.  You can also use the s key to select multiple fields to size or align all at 
once. 

Other: You have the choice to show the ruler, snap to the grid or designate the grid size.  
“Snap to the grid” means the field adheres to the grid lines and does not float when you 
click it.   

! Look up Format/Design Reports. 

Text Field Properties   

  A Text field is used to enter static text, or text that you want to print the same 
way every time, such as the word “Signature” next to a blank line.  A Text field does not 
retrieve stored information from program database files.   It prints on the form in the 
position you specify, and what you type is what prints.  This is contrasted with the Data 
field, which pulls data from your program data files.  See Figure 13.3. 

 

Figure 13.3
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Insert a Text field by clicking the [Text] speed button on the toolbar, then clicking the 
report grid.  A field labeled “Text1” is displayed and each time you add a text field, the 
number advances — Text2, Text3, etc.   

! Look up Text Field Properties. 

Data Field Properties   

  A Data field allows complete control in retrieving data from your program data 
files (Case, Insured, Claim, etc.) through the use of expressions.   

Click the Data Field button on the toolbar and then click on the grid to place a Data 
field on the form.  To set the properties of the field, double-click on the field (or right-
click and select Properties).  The Data Field Properties window appears.  See Figure 
13.4. 

 

The Data Field Properties window lists any expressions that have already  
been created.   

To create an expression, click [New Data Field], select a field from the list and click 
[Save] or press #.  See Figure 13.5. 

Figure 13.4
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If you do not see the field you want, either scroll through the Fields list box or click 
[Find Field].  The Find Field window is displayed.  See Figure 13.6. 

 

In the Find Fields that Match area, type a word or two of description and you usually get 
a list in Search Results to select the field you want. 

! Look up Data Field Properties and Find Field. 

Figure 13.5

Figure 13.6
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Calculated Field Properties   

  A Calculated field works with the same files and data selections as a Data field, 
but also lets you specify financial operations, how the numbers are formatted, and 
whether the layout bands are reset at the time of printing.   

 This field type has no effect on statements, which present a special situation. 

Data entered in a Calculated field can generate the transaction and calculates costs and 
charges.  The Calculated Field Properties window has three fields for financial 
accounting.  See Figure 13.7.   

 

The Calculated field permits averaging, count, maximum, minimum, and sum 
functions.  There are numerous options for the Format field.  The Reset After Print field 
can be used to reset the calculations after printing.  This resets the field to zero.   

! Look up Calculated Field Properties. 

System Data Field Properties   

  A System Data field lets you insert data into your report that is tracked by your 
computer system, such as the date or current page number.  Data possibilities, such as 
Total number of Records to be Printed on Report, Current date in the format set by 
Windows, Current Page Number, and Report Title, among others, make System fields an 
invaluable asset to creating that “finishing touch” to a report.  See Figure 13.8. 

Figure 13.7 
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! Look up System Data Field Properties. 

Shape Field Properties   

  The Shapes feature lets you add color, shapes, different background styles, and 
borders with inserted text.  Shapes and colors can add greatly to the appearance of 
reports and creative possibilities are almost limitless.  In the Shapes category, you can 
choose from rectangle, circle, horizontal line, vertical line, right and left lines, and top 
and bottom lines.  Backgrounds can be solid, cross, diagonal cross, backward diagonal 
lines, horizontal lines, forward diagonal lines, vertical lines, and clear.  See Figure 13.9. 

 

Figure 13.8
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Choices for border style are clear, solid, dash, dot, dash-dot, dash-dot-dot, and inside 
frame.  Colors can be basic or custom, and within custom you can designate hue, sat, 
lum (which is set for brightness), plus basic color mixes. 

! Look up Shape Field Properties. 

Images Field Properties   

  The Images feature permits you to add bitmaps, sound, and videos to patient 
records in the program.   

Add images to your reports, such as a company logo or picture of the office building.  
See Figure 13.10.   

Figure 13.9
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! Look up Image Properties. 

Data Fields and Expressions 
Of the field types available in the Report Designer, the Data field is the only type that 
allows for expressions to be defined.   

An expression is a formula or equation that lets you introduce variables to determine the 
end result.  A conditional expression is a formula or equation that contains at least one 
“if” clause which must be met to get the desired result.  In effect, expressions give you an 
easy formatting method to get the exact data desired to display in the field.   

Click [New Expression] and the Select Data Field window is displayed.  Select a file on 
the left-hand side of the window and an abundant list of fields available is displayed in 
the Fields list on the right.  The files from which you may choose are Case, Insured, 
Claim, Custom Data, Patient, Practice, and Transaction.   

! Look up Data Field Expressions and Conditional Expressions. 

Tutorial Practice 
To review the procedures outlined in this chapter, you can perform the following steps 
using the tutorial database provided. 

Repositioning the CMS- or HCFA-1500 form 
Let’s say your paper claims are printing with text shifted too far to the right and below 
the spaces provided in the pre-printed CMS- or HCFA-1500 forms. 

Figure 13.10 
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Go to the Reports menu and select Design Custom Reports and Bills.  Click the Open 
speed button (the book with the arrow pointing to it) and select HCFA - 1500 
(Primary).  Click [OK]. 

Go to the File menu and select Report Properties.  See Figure 13.11.  

 

It’s probably better to make one adjustment at a time, so in the Form Offset section, 
change Left to .05.  Click [OK].  You need to print the form to see if it is adjusted 
enough.  Click the Print speed button.  The Save Report As.... window is displayed.  
Since you are revising a standard form, give this form a different name, until you know 
it is correct.  In the Report Title box, enter CMS - 1500 1. 

 

You need to use a name that you can  remember, but you can’t replace the 
original form.  If you use the same name as the original form, the list shows 
two forms with the same name and it may be difficult to remember which is 
the form you’ve revised.   

The program informs you that claims and statements printed through the Report 
Designer are not marked as billed.  This is generally a good thing.  Click [OK]. 

In the Data Selection Questions window, select a single claim number in the Claim 
Number Range so only one page prints.  Click [OK].   

Figure 13.11
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Use the Claim Number Range and not the Chart Number range because there 
must be an available claim before the form prints from the Report Designer. 

Click [OK] in the Print window.  We made a great adjustment and the right/left 
adjustment is perfect.   

Now repeat the process, opening the Report Properties window.  This time, enter .6 in 
the Top field.  Click [OK]. 

Again print the form and check to see if the alignment is OK.   

Unfortunately, aligning the CMS- or HCFA-1500 form is a trial-and-error process.  
You may have to make a number of adjustments to get the printing just right.  When 
you do get the adjustments right, save the form and close the Report Designer.  Use this 
revised form each time you print paper claims. 

If you are short on CSM- or HCFA forms, you can print the report on plain paper.  
Place the test paper on top of a pre-printed form and hold them up to the light to see if 
the text is lined up properly. 

How To Revise an Existing Report  
You decide that you want the Zip Code included on your patient lists.  In the Report 
Designer, click the Open speed button.  Locate Patient List and click [OK].   

First you need to add the column heading and you have to make a little space for it.  
Move the [Phone] heading a little to the right by clicking and dragging the field.  (This 
is the heading in the blue band, not the one in the green band.) 

Click the Text Field speed button in the toolbar and then click the cursor in the space 
between [CityLine] and [Phone].  Double-click this new text field to open the Text 
Properties window.  In the Text field, enter Zip Code.  Click [Font] and, in Font style, 
click Bold.  Click [OK].  Click [OK] again.  To be sure the heading is aligned properly, 
hold down the [Shift] key and click [CityLine], [Zip Code], and [Phone].  Right-click 
over one of the selected fields select Align Fields in the Speed menu.   

In the Alignment window, choose Bottoms and click [OK].  You’re halfway there! 

In order to align the [Phone] heading and the [Phone 1] field (in the green band), right-
click [Phone] and select Properties.  In the Text Properties window, locate and make 
note of the value in the Position Left field.  Click [OK].  Now, right-click over the 
[Phone 1] field and enter the same value in the Position Left field of this window.  Click 
[OK].  The [Phone] heading and [Phone 1] field are now aligned.   

Next you need to enter the Zip Code field in the document–you need to insert a Data 
Field in the green band.  click the Data Field speed button, then click the green band 
below the [Zip Code] heading.   
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Double-click this new field to open the Data Field Properties window.  Click [New 
Data Field].  In the Select Data Field window, the Patient file should automatically be 
selected.  Be sure it is.  In the Fields section, scroll down until you see Zip Code.  Select 
Zip Code and click [OK].  Click [OK] again.  

To make sure the two Zip Code fields are aligned, right-click over the heading and 
make note of the value in the Left position field.  Then right-click over the Zip Code 
field (green band) and enter the same number in the corresponding field of this window. 

To save, you must rename the form.  Go to the File menu and select Save As.  In the 
Report Title box, enter Patient List w/Zip and click [OK].  Close the Report Designer.   

To test your new report form, go to the Reports menu and select Patient List w/Zip.   

How To Create a New Report  
hold down the [Shift] key and click [Phone] and then [Phone 1] (in the green band).  
Right-click over one of the selected fields and select Align Fields in the Speed menu.   

Choose a report style on which to base a completely new form. 

Format the report by going to the File menu and selecting Report Properties.  Establish 
the report name, margins, size of bands and filter the source data needed to provide the 
information for the report.   

With the report formatted, you can begin placing fields on the grid.  Make the necessary 
additions and/or changes to complete your form, then save and exit Report Designer.  
The new report appears in the Custom Report List. 

As you become familiar with the workings of Report Designer, formatting and 
designing become easier. 
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Chapter 14 
 

Office Hours Patient Appointment Scheduler 
Introduction 
Office Hours is an appointment scheduling program that helps keep track of 
appointments for your practice.  It is automatically installed with NDCMedisoft (unless 
you chose not to have it included when you performed the installation). 

If you purchased Office Hours Professional, the features of this program are clearly 
marked throughout this chapter. 

Starting Office Hours 
If you are working in NDCMedisoft, click the Appointment Book speed button or go 
to the Activities menu and select Appointment Book.   

Accessing Office Hours from Other Programs 
You can access Office Hours at the same time as you are working in other Windows-
based programs.  Open Office Hours at the beginning of each day and then minimize it.  
Press a + t at the same time to activate Office Hours, perform the desired 
scheduling tasks, and then minimize it to return to your previous task. 

Office Hours Setup 
There are several portions of the program that need to be set up before you can start 
scheduling.   



 
134     NDCMedisoft 

First, set up provider records.  If you are booking appointments for lab work or therapy, 
each of those technicians should have a provider number and schedule and so should 
each office member whose schedule is included in the Office Hours program. 

Second, create your resource records.  You can include all treatment apparatuses in this 
list, as well as consultation and treatment rooms, so that you do not double book a 
room or equipment. 

Third, establish the number of booking columns you want. 

Fourth, clarify program options, such as establishing appointment length, creating 
whatever views you need for viewing multiple columns at once, and deciding how much 
information you want displayed in your appointment blocks in the appointment grid.   

Fifth, set up breaks and recurring breaks, to show lunch hour, set coffee-type breaks, 
seminars, etc. 

Setting up Provider Records 
Office Hours must have at least one provider record set up in order to run.  If no 
provider record is set up, Office Hours automatically prompts you to do so.  If you 
want, you can let the program assign the Code for the provider or you can enter a five-
character code yourself.   

Enter the provider’s name and pertinent information.  PIN and ID numbers assigned by 
governmental carriers and other commercial carriers are recorded in the Default Pins tab 
of the Provider: (new) setup window, as well as the Group Number and UPIN, when 
needed. 

! Look up Provider Entry. 

Setting up Patient Records 
This can be done in either NDCMedisoft or Office Hours.  Click the Patient List speed 
button and click [New Patient] or press * to display the Patient/Guarantor: (new) 
window.  You can create a chart number yourself (eight alphanumeric characters) or let 
the program create one.  Enter information in as many of the fields as necessary in both 
tabs.  When finished, click [Save].  Repeat this process for each patient who visits your 
practice. 

! Look up Patient Entry. 

Setting up Case Records 
This can be done in either NDCMedisoft or Office Hours.  Click the Patient List speed 
button and then choose the Case radio button in the top-right corner of the window.  
Then click [New Case] or press * to display the Case: Patient Name (new) window.  
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Enter information in as many of the fields as necessary.  When finished, click [Save].  
Repeat this process for each case you want to enter. 

 

In the Case window, you cannot press * or ( to access records available 
from lookup fields, such as Facility or Attorney.  The * and ( keys are only 
available in the Case window from within NDCMedisoft itself. 

! Look up Case Entry. 

Setting up Resource Records 
The Resource List is a tool to help you manage the scheduling of rooms and equipment 
in the office.  To create the list, click the Resource List speed button or go to the Lists 
menu and select Resource List.  In the Resource List window, click [New] or press *.   

Create a code for the resource or let the program create one based on the description.  
Enter a description (e.g., Room 1, Treadmill, etc.) and click [Save].  Repeat this process 
until all rooms and/or equipment are contained in the list. 

! Look up Resource Entry. 

Setting an Appointment 
To set an appointment in Office Hours, first select the provider for whom you are 
scheduling.  The provider box at the top right of the toolbar has a drop-down box 
arrow.  Select the provider you need, or press * to set up a new provider record.  In 
any Multi View (Office Hours Professional), select the provider by clicking in the 
appropriate provider’s column. 

Select the date on which the appointment is to be set.  You can use the Day, Week, 
Month, and Year selection arrows below the calendar to locate the correct date, or use 
the Go to Date feature.  

Next, in the appointment grid, double-click a time slot, which is highlighted with a 
heavy line border.  You can also click the New Appointment speed button; right-click in 
the time slot and select New Appointments press *; or go to the Lists menu and select 
Appointment List, then click [New] to open the New Appointment Entry window.  See 
Figures 14.1 and 14.2 (Office Hours Professional).   



 
136     NDCMedisoft 

 

 

Enter or select the chart number of the person for whom the appointment is being set.  
If the person’s information has been entered in the program, the name and phone 
number are automatically entered and the patient’s last case is reflected in the Case field.   

Figure 14.1 

Figure 14.2 
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Assign a resource.  If the resource or room you need is not in the list, press * to create 
a new resource record.  The Notes field lets you include a reminder message regarding 
the patient’s need or condition.  Enter an appointment reason in the Reason field.  If 
necessary, change the Length, Date, and Time fields here.  You can also change the 
appointment color.  If there is a need for repeat visits, click [Change] in the Repeat 
section.  See the following Repeating Appointments section. 

! Look up New Appointment Entry. 

Repeating Appointments 
When a patient needs to make regular return visits, set up repeat appointments through 
the New Appointment Entry or Edit Appointment window.  Click [Change] in the 
Repeat section at the bottom of the window.  The Repeat Change window that opens is 
the same window that appears when creating repeating breaks.  See the Setting Up 
Repeating Breaks section for instructions, page 138. 

! Look up Repeat Change. 

Entering Breaks 
You can enter breaks into the appointment schedule as reminders that the time slots are 
committed.  Some breaks are a one-time occurrence, like a vacation or a seminar.  
Others are regularly scheduled times for each month or week.         

There are several ways to access the New Break Entry window.   The quickest way is to 
click the Break Entry speed button.  You can also click [New] or press * in the Break 
List window.  See Figure 14.3. 

 

Figure 14.3
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To create a break, give it a name, a date, and enter the time that the break starts.  Using 
the up and down arrows, enter the length of time in minutes.  The display color of the 
break should be contrasting to the regular daily appointment schedule (the default is 
gray).  

Indicate whether the break should display in all columns on the appointment grid.  If 
not, click the All Columns box to uncheck it, then mark those columns to be affected.  
Three radio buttons at the bottom of the window let you apply the break to the Current 
provider (the one whose schedule is on the window), Some, or All providers.  

! Look up New Break Entry. 

Setting Up Repeating Breaks 
In the New Break Entry window is a field marked Repeat, with a [Change] button.  
Clicking [Change] opens the Repeat Change window where you can establish the 
Frequency of the break. See Figure 14.4. 

 

Choosing any of the radio buttons (except None) displays different data entry boxes in 
the middle of the window that give you the repeat options for each frequency.  Also, a 
written summary of the selected frequency appears in the bottom middle area of the 
box. 

It is important to note that when you set up a break using the Monthly frequency, the 
date highlighted on the main calendar affects the day or date that is entered in the break 
note.     

Moving/Deleting Appointments 
Changing Appointment Status (Office Hours Professional) 
There are multiple options for marking the status of an appointment.  See Figure 14.5.  

Figure 14.4
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 The default is Unconfirmed.  When any change in status occurs, edit the appointment 
or right-click on the appointment and choose the appropriate radio button.  If you 
choose Cancelled, the appointment is removed from the grid display.  Any other status is 
reflected by a small icon in the upper right corner of the appointment in the grid.   

Moving an Appointment 
If you want to move the appointment to another day or time, click the appointment 
and press c + X (or go to the Edit menu and select Cut).  Move the cursor to the 
new day and/or time slot, and either press c + V or select Paste in the Edit menu.  
If you want to move the appointment to another time slot showing on the appointment 
grid (whether the same provider or not), click the appointment, hold the left mouse 
button down and drag the cursor to the desired time slot.  Release the mouse button. 

Deleting an Appointment 
There are multiple ways to delete or remove an appointment: click the appointment slot 
on the appointment grid and press d, highlight the appointment in the 
Appointment List and click [Delete], or right-click on the appointment (either in the 
Appointment List window or on the appointment grid) and select Delete or Delete 
item, respectively.  You can also edit the appointment and change the status to 
Cancelled.   

! Look up Moving/Deleting an Appointment. 

Patient Recall (Office Hours Professional Integrated) 
The program includes a complete patient recall system with a recall appointment list to 
assist in contacting patients to schedule appointment dates and times or to make 
reminder phone calls.  This feature is available through both the NDCMedisoft and 
Office Hours programs. 

! Look up Patient Recall. 

Figure 14.5 
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Eligibility Check (Office Hours Integrated) 
Selecting the EDI Receiver, chart number, and case number in the Eligibility 
Verification window enters necessary data for checking the eligibility of the patient for 
insurance coverage.   

Multiple Booking Columns 
If you want to multi-book appointments (that is, schedule more than one patient in the 
same time slot), simply right-click on the column heading in the appointment grid and 
the Speed menu gives you a choice of Add Column or Delete Column.  If you add a 
column, the Add Column window has a horizontal scroll bar that lets you indicate the 
provider for whom you are adding a column.  The number of columns determines how 
many appointments can be booked in one time slot for one provider.  There is really no 
limit as to how many columns can be set up on the appointment grid.  You can also edit 
the column display by selecting Edit Column in the Speed menu.  Changes are made in 
the Change Column window. 

Program Options 
Appointment Length 
Set the starting and ending appointment times for the practice.  Enter the Starting Time 
and Ending Time, breaking it down by hour and minutes.  Standard appointment 
Intervals can be established by scrolling with the up and down arrows.  See Figures 14.6 
and 14.7 (Office Hours Professional).     
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Figure 14.6

Figure 14.7
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You can also set colors to distinguish appointments, breaks, and conflicts (Office Hours 
Professional).  Make decisions concerning all the other default settings in this tab. 

Designate one of the reports in the Speed Report box (Office Hours Professional) and it 
automatically prints when you click the Print speed button. 

Views (Office Hours Professional) 
One of the most important features of the Office Hours Professional program is the 
variety of ways you can display appointments/breaks in the appointment grid.   

At the bottom of the main Office Hours window, in the Status bar, there are four View 
boxes, with different configurations of dot patterns.  These give quick access to the same 
functions available through the View menu on the Menu bar.  These correspond to 
Single Provider View, Week View, Month View, or any combination Multi View.  See 
Figure 14.8.  

 

 Day View 
The Day View shows a single provider’s appointments for a selected day.  If 
multiple columns are set up, all columns are displayed.  To display another 
provider’s schedule, make a new selection in the provider box in the toolbar.  This 
view does not show columns for resources, but columns can be added or removed 
as necessary in this view.   

 Week View 
The Week View also shows only one provider’s schedule, but with one column for 
each day of the week.  If you have multiple appointments scheduled, the time slot 
shows the color for scheduling conflicts.  You can size the columns to see all the 
appointments/breaks scheduled by placing the cursor on the right column heading 
boundary line until it takes the shape of a double-sided arrow, and then drag the 
boundary line right or left to increase or decrease the size of the column.  Columns 
can be added or removed as necessary in this view. 

 Month View 
The Month View shows up to 31 days, with the boxes colored where appointments 
have been scheduled.  This is a single-provider view.  The value of this view is that 
you can get a good overall view of which days are free for appointments or other 
scheduled items.  Columns cannot be added or removed in the Month View. 

Figure 14.8
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 Multi View/Multiple Provider/Resource View 
The Multi View, or Multiple Provider/Resource View, is the most flexible.  The 
program provides one Multi View setup, which automatically includes all providers 
and all resources, each with its own column.  You can create as many Multi Views 
as you need in the Multi Views tab of Program Options.     

The open data entry field lists all Multi Views that have been set up.  This is where 
you can group providers and/or resources (rooms or facilities scheduled for 
appointments) in any combination desired, or modify or delete existing multiple 
view setups.  Click [New] to set up a new Multi View (select a view and click [Edit] 
to make changes).   

In the New View window, assign a name for the new view.  For the first column, 
indicate the type (Provider or Resource), the Code (provider number or resource 
code), then the width of the column (in pixels).  Set up each column you want in 
the view and click [Close] when finished.   

If you want to add a column between columns that have already been created, place 
your cursor where you want the new column and click [Insert].  

These views can be also edited or reverted to default views through the View menu. 

Appointment Display (Office Hours Professional) 
In the Appointment Display tab of Program Options, you can specify up to five rows of 
information to display in the grid for an appointment.  Be aware that the length of the 
appointment determines how much data is actually displayed on the grid.  An 
appointment must be at least 75 minutes long to display five rows of information. 

! Look up Program Options. 

Security Setup  
If you are using Office Hours in connection with NDCMedisoft, the security settings 
established in NDCMedisoft are applied to Office Hours as well.  However, you can 
make changes from within Office Hours if needed.  

! Look up Security Setup. 

Reports in Office Hours 
If you select one of the following reports in the Speed Report box in Program Options 
(Options tab), that report prints automatically when you click the Print speed button 
(Office Hours Professional). 
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Appointment List 
Probably the most important report printed in Office Hours is the Appointment 
Schedule, a listing of all the day’s scheduled events.  Generally, printing this report is the 
first order of business.  Print the list and be sure you are ready to meet the day.   

! Look up Printing the Appointment List. 

Appointment Status (Advanced and above) 
The Appointment Status report displays a list of appointments showing their statuses.   

! Look up Appointment Status Report. 

Printing Superbills 
If you use Office Hours integrated with any version of NDCMedisoft, you can print 
superbills for the day through Office Hours.  Go to the Reports menu and select Print 
Superbills.   

! Look up Printing the Superbill. 

Tutorial Practice 
To review the procedures outlined in this chapter, you can perform the following steps 
using the tutorial database provided with this program. 

Entering Resources 
Go to the Lists menu and select Resource List.  Click [New].  See Figure 14.9. 

 

Leave the Code field blank.  In the Description field enter Treadmill.  Click [Save].  
Click [Close]. 

Figure 14.9
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Entering Appointments 
I.B. Gone (remember him?) calls and needs to see Dr. Urdoc today.  Amazingly enough, 
Dr. Urdoc actually has an opening at 11:30 am.  In all views except Monthly (Advanced 
and above) and Multi View (Advanced and above), select Dr. Urdoc in the provider box 
to the right of the Exit speed button in the toolbar.  In any Multi View, be sure to locate 
Dr. Urdoc’s appointment column.  You see that the 11:30 time slot is open for Dr. 
Urdoc so double-click it to open the New Appointment Entry window.  See Figure 
14.10. 

 

In the Chart field, enter GON to locate I.B. Gone’s chart number.  Press e.  In 
Resource, enter T to help locate the treadmill resource. Highlight the correct resource 
and press e.   

In the Note field, enter the following information:  Emergency physical for work.  

The Case defaults to Mr. Gone’s most recently opened case.  In the Reason field, 
although we have not yet created reasons of our own, we can select one from the 
database.  Click the down arrow and select Routine Checkup.     

The date and time have already been selected, so click [Save].   See that Mr. Gone’s 
name appears in the 11:30 am slot.  Also notice that it is fuchsia in color (which is the 

Figure 14.10 
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color assigned to the Routine Checkup reason).  A recap of the appointment and Mr. 
Gone’s information is also displayed to the left of the Appointment Grid.  

Repeating Appointments 
Dr. Urdoc wants to follow up on Mr. Gone’s treadmill results and asks you to make two 
more appointments, a month apart.  Since 11:30 am is a good time for Mr. Gone, 
double-click the existing appointment.   

In the bottom left corner of the Edit Appointment window, click [Change] to open the 
Repeat Change window.  Choose Monthly.  In the End on: field, click the down arrow to 
show the calendar.  Click the right arrow twice (for two months).  Then click [OK].  
Click [Save]. 

Setting Breaks 
Click the Break Entry speed button.  In the Name field, enter Dr. Urdoc Seminar.    

The meeting is scheduled for two hours on June 21, starting at 1:00 pm.  In the Date 
field, enter 6/20/2003.  For Time, type in 1:00 p.  In Length type 120.  In Resource 
enter L for the Lunch room.  Give it an aqua color, using the down arrow to display the 
color choices.  Click the All Columns box to be sure everyone participates.  Under 
Provider, choose All.  Click [Save].  To double-check, click the appropriate Month and 
Day buttons to locate June 21, 2003.  If necessary, use the scroll bar to show the 
seminar. 

To return to today’s calendar, click the Go to Today speed button. 

Creating Reason Codes 
Go to the Lists menu and select Reasons List.  Click [New] to open the Appointment 
Reason Entry window.   

Leave the Code field blank.  In the Description field, enter Sports Accident.     

The default appointment length is 15 minutes.  Change this number to 30.  In the 
Default Appointment Color field, the drop-down arrow lets you select a color that fills the 
appointment space on the schedule grid.  Choose red for this emergency accident 
response.  In Default Template Color (Advanced and above), select Light Red.  Click 
[Save]. 

Creating Templates (Office Hours Professional) 
Go to the Lists menu and select Templates List.  Click [New].   
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In one of the six Template Reasons fields, use the drop-down arrow to enter the Code and 
Description.  In the Description field describe the template’s use as See New Patients.  
Using the drop-down arrows, select Dr. Urdoc as the Provider, and the Resource is Exam 
Room 2.   

Click the arrow on the Date field to display the calendar and highlight the designated 
date.  Use the arrows on either side of the month name to change to an earlier or later 
month, if necessary.  Type 10:00 a in the Time field.  Set the Length to 120.  The search 
arrow on the Color field lets you select light yellow as the color for the template on the 
appointment grid. 

You want to use this template every day, so click [Change] to display the Repeat Change 
window.  Choose the Weekly frequency, enter the number 1, and click the boxes for 
Tuesday and Thursday.  Leave the End on field blank at this time.  Your entry is 
confirmed with the message, “Every week on Tue and Thu.”   

Creating Multi Views (Office Hours Professional) 
Dr. Urdoc works only with therapy patients and uses Exam Room 2 for consultations.  
Let’s create a view where you can see all of these schedules at the same time.  

To create a multi view, go to the File menu and select Program Options.  Open the 
Multi Views tab.  Click [New].   

Name the new view Dr. Urdoc and press e.  In the Type field, click the box and 
select Provider.  In the Code field, locate and highlight Dr. Urdoc’s name.  Leave the 
Width at its default setting.  Press t.   

In the next line, select the Resource type.  Press t.  Locate Exam Room 2 and 
highlight it.  Press t.  Change the Width column to 50.  Press t to create a new 
line.  Again select Resource.  This time locate and select Therapy.   Click [Close].   

Using the Wait List (Office Hours Professional) 
Mr. Gone has seen the doctor for his injury but he needs a return visit in a week.  With 
the full appointment schedule, the surest way to work him in is to put him on the Wait 
List.  Go to the View menu and click Wait List.   Click [New].   

Type in GONI to select the Chart number.   

To begin the search for his next appointment, click [Find] to open the Find Open Time 
window.     

Mr. Gone is out of school at 2 p.m. but has choir practice on Tuesday and Thursday.  
He needs a 15 minute appointment so enter a Start Time of 2:30 p and an End Time of 
5:00 p.  Click  Monday, Wednesday, and Friday.  Click [Search] and let it go.  In a few 
moments, if the program finds a match, a Confirm window pops up:  “Open time slot 
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found.  Do you want to set the appointment?” If the first time slot it presents is not 
satisfactory, click [Retry] and let it search further.  Or click [Yes] and schedule the 
appointment. 
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Appendix A 
 

Where to Find Help with NDCMedisoft 
The Manual 
Documentation Conventions 
As steps required to use the program are explained, certain consistent instructions are 
given in the manual.  Knowing these instructions helps you have a clearer understanding 
when they are used. 

 Buttons and Keys 
Square brackets [ ] indicate a button on a window, such as [Close] or [Edit].  Keys 
on the keyboard are indicated by pictures of the keys, such as e or ! or t. 

 Entering Information 
When you are instructed to enter information, type the data, then press e.  For 
example, the instruction to “enter your name” means to type your name and press 
e.   

When instructions say an entry can be alphanumeric, it can be letters, numbers, or 
a combination of both.  In most cases, a chart number is alphanumeric, a 
combination of letters and numbers. 

When instructed to enter a date or phone number, use no punctuation.  The 
program supplies the punctuation automatically.  For dates, use the format of either 
MMDDYY or MMDDCCYY (for Medicare claims only). 
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 Title Designations 
For identification purposes, all menu selection options mentioned in the manual 
are in bold print (File menu, Program Options), titles of actual windows are in 
bold and italicized print (Patient List), and field names within a window are in 
italicized type (Description). 

Support Options 
Technical help for learning and working with NDCMedisoft is available in the 
following options:  (1) ! key or [Help] buttons access online information while within 
the program; (2) accessing the NDCHealth web site; (3) training options; (4) local 
Value-Added Resellers; and (5) NDCHealth telephone technical support.  NDCHealth 
support is unable to provide training on the telephone.   

Using Online Help 
No matter where you are in your NDCMedisoft program, help is close at hand.  If you 
don’t understand what is wanted, or how data should be entered, press !, click [Help] 
(if available), or click the Help speed button, and data files are opened.  Specific 
information and examples of how data should be entered is displayed in the Help 
window. 

In addition, you can go to the Help menu and select Table of Contents.  Highlighting 
any option in the Contents list opens the related help data fields.   

Regardless of which of these entry points you utilize, you open the same Help files.  
Access the files in the manner most convenient to you.   

NDCMedisoft Web Site 
The Knowledge Base is a searchable online database containing technical information 
relevant to the use of all NDCMedisoft and related products.  If you are working in an 
NDCMedisoft program, access is made easy by going to the Help menu and selecting 
NDCMedisoft on the Web or at the following web site:  

  http://www.medisoft.com/kb.   

When accessed, you can search for information concerning all NDCHealth products or 
any particular product.  We try to maintain the most current technical information in 
the Knowledge Base.  For instructions on how to use the Knowledge Base, click Help on 
the left side of the Knowledge Base page.   

Training Options 
There are various training options available.  Contact your sales representative at (800) 
333-4747 or a local Value-Added Reseller for information concerning these options. 
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Local Value-Added Resellers 
There are local Value-Added Resellers of NDCMedisoft in your market area who are 
knowledgeable and efficient in selling, installing, troubleshooting, and supporting your 
NDCMedisoft program.  You can contact an NDCHealth sales representative for the 
name of a qualified Value-Added Reseller in your area to give you hands-on help. 

NDCHealth Technical Support  
Call Toll-Free (800) 334-4006.  Get help directly from NDCHealth technical support 
services!  NDCHealth support is available to answer questions and assist in 
troubleshooting problems. 

NDCHealth support answers questions related to the operation of NDCMedisoft 
software in a physician’s office or a billing service.  NDCHealth support technicians are 
unable to assist with network configuration, computer hardware problems, training on 
how to do medical billing, or aligning your CMS or HCFA forms.  NDCHealth 
support does provide software assistance to any customer, no matter where the program 
was purchased. 

 
NDCHealth support is unable to provide training or file repair over the 
telephone. 

 When You Call Support 
You’ll get faster service if you have these items ready when you call NDCHealth 
support:  

• Your NDCMedisoft customer number.  This is found on the upper right 
corner of the invoice or packing slip that came with your NDCMedisoft 
program.   

• The Serial Number and registration information for your NDCMedisoft 
software.   

• A complete description of your problem or question, including the complete 
text of any error messages.   

• Have a current support contract already in place or be ready with credit card 
information to set one up.   

• It is usually necessary for you to be able to work on your computer while you 
are talking to the technical support staff, so be sure your phone is close to the 
computer. 
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 Service Hours 
Remember, Arizona doesn’t change to daylight saving time.  Year around support is 
available from 6:00 AM until 5:00 PM, Monday through Friday, Mountain 
Standard Time.   

Updates and Changes 
Go to the Help menu and select Online Updates.  Any free update available is 
downloaded to your system. 

! Look up Online Updates. 

Tips and Shortcuts on the Internet 
There’s a wealth of information on the NDCMedisoft web page on the Internet.  The 
web site address is www.medisoft.com.   
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Program Installation—Troubleshooting 
Handling Errors and Problems 
When you have trouble with your computer, it is not always easy to determine the 
problem.  You may occasionally experience hardware difficulties, program errors, data 
problems, or operator errors.  This section covers the basics of troubleshooting, 
including how to define problems, how to recover from them, and how to avoid 
trouble. 

Error Messages 
Written Error Description 
This is the most important part of the error message.  Because it is a written description, 
it can give easy-to-understand information and help to solve a problem quickly. 

Recovering from Errors 
When you get an error in NDCMedisoft, your ability to recover from it is based on 
what you do next.  Always stop immediately to make note of the ENTIRE error message 
and retrace the steps that led up to the error.  Write down every word and/or number 
EXACTLY as it appears in the error message, the operation you are using, the last few 
entries you made and any other facts, such as power failure or changing data disks, etc. 

If you recognize the error and have an idea as to what to do, correct the problem.  Then 
try to repeat the operation you were working on when the error occurred.   
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If you are not sure how to handle the error, the Knowledge Base is very useful to check 
first.  Look for articles concerning the error you received.  The web site address is:  
www.medisoft.com/kb. 

Sometimes the error repeats itself in an identical pattern.  This type of error should be 
reported to your local Value-Added Reseller, who can give you further suggestions; or 
call NDCMedisoft technical support at (800) 334-4006 to get the help you need.   

Note:  Please note that you are required to have a valid or current support contract 
in place or be prepared to set one up when you call NDCMedisoft technical 
support. 

In some cases, it may be necessary to restore a data backup.  This means that you would 
restore a backup copy of your NDCMedisoft data back onto your hard disk so that you 
are using a set of data that was not corrupted by the error. 

It is very important that you make regular backups of your NDCMedisoft data.  
Although the software is painstakingly designed and tested, and while you may exercise 
the utmost care in using the program, there still exists the danger of an error causing a 
loss of your billing data.  Protect yourself by making frequent backups of your data. 

Avoiding Errors 
Most users can work with their computers and rarely experience an error.  The best way 
to avoid errors is to thoroughly understand both the hardware and software you use.  Be 
sure to study the NDCMedisoft manual and the user manuals provided with your 
computer until you are comfortable with their operation. 

Avoiding little errors may be impossible, but they become insignificant if you can 
quickly diagnose the problem and fix it.  Avoiding catastrophic errors requires common 
sense and foresight—particularly in making backup copies of your data. 

Network Problems 
Network Initialization Failure Error  
Indicates that either the network drive is inaccessible or the user does not have full 
access to the shared network drive.   

Invalid Directory Alias  
Indicates that NDCMedisoft is being started from an incorrectly configured desktop 
icon.  Run the program from the Start menu or correct the properties of the icon.   
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Getting Help From NDCHealth 
If you have a question about the way the NDCMedisoft program works, the best way to 
get a fast, accurate answer is to try one of these self-help approaches first: 

1. Review an onscreen Help topic by pressing ! when the cursor is positioned 
on a field you’re wondering about.  The Help feature in the NDCMedisoft 
program has information on every field in the program. 

2. Look for a listing in the Table of Contents, Index, or in the section of the 
manual that discusses the operation in NDCMedisoft that you are using. 

3. Look up the Knowledge Base on the Internet.  The web site address is 
www.medisoft.com/kb. 

If you take the steps listed above and still can’t find the answer to your question, check 
the Knowledge Base (www.medisoft.com/kb), call your local Value-Added Reseller, or 
call NDCHealth at (800) 334-4006 for technical support.  

Before you place the call, make note of the following information: 

1.  Your Customer Number. 

2.  Your Serial Number. 

3.  Your practice name and location. 

4.  The name and version of the program you are using. 

5.  The exact error message or problem. 

6.  The sequence of steps taken before the error. 

7.  Your exact actions since the error occurred. 

With this information, it is easier to understand the problem and quickly find a 
solution. 

Near a Phone 
It is usually necessary for you to be able to work on your computer while you are talking 
to the support staff at NDCHealth, so be sure your phone is close to the computer. 
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Converting Data  
What Doesn’t Convert  
Before you undertake the conversion of NDCMedisoft MS-DOS data to the 
NDCMedisoft Windows program, you need to know that there are several types of data 
or formats that do not convert, no matter which option you choose.   

Any custom formatting you have done, including lists, statements, CMS or HCFA 
forms, receipts, and the custom data windows, does not convert.  In addition, notes, 
superbills, billing notes, and custom printer setups do not convert.   

Prior to conversion, you must complete all EDI batches in your MS-DOS program.  In 
addition, the conversion does not apply payments to charges.  There is no way for the 
conversion program to know how much of each check is applied to respective changes, 
so it is up to you to apply payments to charges.  It is highly recommended that all 
payments be applied before performing a conversion of the data. 

Converting MS-DOS to Windows 
NDCMedisoft data file conversion from MS-DOS to Windows is automated with a 
simple click of a button. 

To start your conversion, go to the File menu (or press a + F) and select Convert 
Data.   

The Convert NDCMedisoft Data window, by clicking [Search for Data], finds all MS-
DOS NDCMedisoft data files.  This search may take a few minutes. 
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Each MS-DOS database found appears in a list and automatically marked for 
conversion.  If you do not want to convert all data at one time, deselect those files you 
do not want to convert by clicking on the check box next to the data you don’t want 
converted.  Buttons marked [All] and [None] below the data field can aid in marking 
the files.  When you click [Start Data Conversion], you have three options:  Convert All 
Transactions, Convert Patient Balances, and Convert No Transactions.    

The Convert No Transactions option (which is recommended) converts all MS-DOS 
data except transaction detail and transaction histories.  If selecting this option, you 
need to maintain two accounting systems until all patient balances in the earlier system 
are zeroed out.  All new charges (and payments and adjustments for the new charges) 
should be recorded in the new NDCMedisoft program for Windows program, and all 
payments and adjustments for existing transactions should be recorded in the MS-DOS 
program until all accounts are balanced. 

The Convert Patient Balances option (not recommended) converts all MS-DOS data 
but treats transactions in a special manner.  All transactions for each patient are 
compiled and converted into a single balance forward sum with no transaction detail.  A 
BALFORWARD or CREDFORWAR transaction is created showing the amount owing 
or credited to the patient.  Because no detail is converted, we do not recommend this 
type of conversion.  It becomes very difficult to apply payments to old transactions.   

The Convert All Transactions option (not recommended) converts all MS-DOS data 
and creates new cases as necessary. 

Select the type of conversion you want and click [OK].  The Conversion Progress 
window is displayed.   

The Convert No Transactions option converts only these files: 

Address Insurance 
Appointment Patient 
Billing Code Provider 
EDI Receiver Procedure/Diagnosis/MultiLink  

The Convert Patient Balances option converts these files: 

Address Patient 
Appointment Provider 
Billing Code Transaction (lump sum only) 
EDI Receiver Procedure/Diagnosis/MultiLink 
Insurance  

The Convert All Data process converts the following data files: 

Address Patient 
Appointment Provider 
Billing Code Transaction 
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EDI Receiver Transaction History 
Insurance Procedure/Diagnosis/MultiLink  
 
During the conversion process, the program checks billing dates on all transactions and 
places them in the Claim Management list format, as discussed in Chapter 8, page 79. 

The conversion finishes on its own.  If the data conversion encounters problems, a file 
named CONVERT.LOG is created in the data file directory which explains any 
problems. 

Any problems or questions should be reported to or clarified through NDCHealth t 
support at (800) 334-4006. 

Bringing Over Account Detail from Another System  
If you are converting data from an accounting system other than NDCMedisoft, the 
data is not affected by the built-in automatic conversion.  Because NDCMedisoft is an 
Open Item Accounting system, to best take advantage of this capability, it is 
recommended that you recreate each transaction, with all of its detail, for every charge 
that is still outstanding. 

The recommended course of action is as follows: 

1.  Be sure each patient with an outstanding balance is set up in the  Patient/ 
Guarantor: (new) window.  That puts all the patient information into the system 
for filling out the insurance claim forms. 

2.  After your patient accounts are set up, enter a transaction for each outstanding 
charge in Transaction Entry.  The date on each transaction should be the date that 
service was rendered. 

You can work from the ledger of each patient and enter data, item by item, until 
everything is current.   

Again, it is noted that the manual reentry applies to data originating from a different 
accounting program.  It could also apply if you do not want to put your MS-DOS data 
through the automatic conversion built into  the Windows versions of NDCMedisoft.   

Converting from Windows to Windows 
Converting from Version 5.5x or 5.6x to Version 9 
If you have been using NDCMedisoft Version 5.5x or 5.6x and have just installed 
Version 9, an automatic conversion is performed the first time a practice data set is 
opened in the new program. 
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Converting from Version 5.4x or Lower to Version 9 
If you are converting from NDCMedisoft Windows Version 5.4x or lower to Version 9, 
data must be converted before it can be accessed in the new program.  Go to the File 
menu and select Convert Data.  Choose Convert Windows 5.x data.  Follow the 
prompts. 
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Understanding and Working with Cases 
“Case — a set of circumstances or conditions; …an instance of disease or injury.”    
   Merriam Webster Collegiate Dictionary, 10th Edition, 1996 

One of the most important concepts to understand in setting up patient records and 
entering transactions in the program is the case.  Transactions within the NDCMedisoft 
program are generally case-based, meaning they are applied to a specific case and specific 
diagnoses.    

A case is a grouping of transactions for visits to the doctor’s office, generally associated 
with a specific diagnosis or procedure.  A new case should be set up each time there is a 
new condition or a change in data contained, e.g., the provider, location of the 
procedure, or insurance carrier, etc.  See Figure D.1. 

 

Figure D.1
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The program groups transactions on one insurance form by case.  All transactions from 
one case are included on one insurance form.  Separate cases for the same patient get 
separate forms.     

The program automatically assigns a case number when a new case is created (and there 
are no duplications of case numbers within a database).   

Each time you access a patient’s record, there is a list of cases for which the patient has 
been treated.  If a previous treatment is similar to a new visit diagnosis, retrieve the 
earlier case and continue to enter data within it.   

Remember, if you are working in one case file and there is any change in carrier, open a 
new case.  Keep the old data intact with old claims information. 

To help you better understand . . .  

Working with Cases 
Accounting in the NDCMedisoft program focuses on the case.  Transactions within 
NDCMedisoft are generally case-based.  A case is an accounting function for keeping 
track of visit procedures of a common nature, for building a treatment history of the 
patient.  You can set up one case per patient or set up any number of cases.   

Open the Patient List window.  Select the chart number, click the Case side of the 
window, click [Edit Case] or [New Case] to open the case fields. 

There are multiple tabs in the patient Case window for gathering more specific data 
than is contained in the patient record.    

A case is created to gather data on a specific treatment or situation.  Patient visits 
regarding a single ailment are grouped in a specific case.  While patient information 
seldom changes, case information deals with diagnoses, procedures, providers, insurance 
companies, and other variable data.  In other words, case files are totally flexible and can 
change with every illness, insurance change, or transaction. 

As transaction entries are made for a visit and billing is prepared, the data in the case file 
is essential to identifying the problem and to whom the billing is to be sent.  In effect, 
visualize the claim as a large truck that can be loaded with any number of boxes (cases) 
of product.  By the same token, a case can have as many transactions as are needed.  (See 
Trucking analogy that follows.)  

The program automatically assigns a case number when a new case is created, with no 
duplication of case numbers within a database. 

Each time you access a patient’s record through the Patient List window, there is a list 
of cases for which the patient has been treated.  If a previous treatment is similar to the 
new visit diagnosis, reopen that case and continue to enter data within it.  Through the 
cases, you can build a history of that patient’s treatments regarding the particular illness.  
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For instance, all records regarding that patient’s treatment for diabetes is in one case.  
The high blood pressure treatment is accessible through another case. 

Just visualize 

A Truckload of Boxes—or Cases 
To accomplish the billing tasks in the NDCMedisoft program, there must be a vehicle 
of transportation.  Visualize the insurance carrier as a large truck.  See Figure D.2.   

 

It can carry just one box (or patient case), or it can be full.  The load depends on the 
accounting procedures and the frequency of patient visits.  When you are ready to 
transmit or ship the truckload of cases, turn them over to the driver, who in this analogy 
is Claim Management. 

If a patient is a frequent client, and is treated for several illnesses, it is sensible to label 
each case box with a different procedure and sort the similar diagnosis visits by the case.  
One patient can have a heart treatment box (case), and a cancer box, and a diabetes box, 
and a high blood pressure box.  Each box contains a patient case.  Each case can have 
any number of transactions.   

When you access the Patient List, the left side of the window displays a list of patients, 
sorted by either chart number or case.  (You determine that in the Field box at the top 
of the window.)  Select a patient record by highlighting the name.  All of the cases that 
have been set up for that patient are listed in the right side of the window.  Click [New 
Case] or press * to create a new case. 

The first truck at the dock is headed for Blue Cross and all cases loaded in this truck are 
shipped there for payment.  But then the patient is involved in an accident at work.  
The new set of claims are submitted to Workers’ Compensation for payment, not to 
Blue Cross.  You can still make entries in the first set of cases, but don’t intermingle 
them with the new Workers’ Compensation claims. 

Figure D.2 
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During this treatment session, the patient changes jobs and has a new healthcare plan 
with a new insurance carrier.  There’s a new truck backing up to the loading dock.  Be 
careful the proper cases are put into the correct truck, or carrier.  Since claims must now 
be carefully divided, all procedures going to the new carrier from this point must have 
new cases, to be placed into the new truck. 

Next you have a super healthy patient who visits the office for occasional treatments.  
His once-a-year visits can all be placed in a single case.  Hence, only one case appears on 
his case list.  If, in the future, he develops a problem you want to track more closely, 
then set up a new additional case for him.   

Summary of the Use of Cases 
Situation: Recommendation and/or Example 
Case Description: A grouping of procedures or transactions generally 

sharing a common treatment or insurance carrier. 

Purpose of a case: A case brings together in an accounting function claims 
and transactions that share a common thread.  Also, 
cases let you print reports of the progress of a patient’s 
health, especially relating to similar diagnoses or claims 
to carriers. 

What “case-based” means: All claims within NDCMedisoft are tied to a case 
number.  That number can reflect the procedure for 
which the patient is being treated.  It can also group all 
claims to a certain insurance carrier.  It is an accounting 
function for keeping track of visit procedures of a 
common nature, for building a treatment history of the 
patient.  As you are ready to file a claim, the 
combination of chart number and case number help 
verify that the proper claim is being sent to the carrier 
that needs to pay it. 

When to set up a case: A case is set up to group treatment transactions.  Open 
a new case if the visit is for treatment of a condition not 
in the patient’s medical history or associated with a 
different insurance carrier.  Visits treating similar 
diagnoses can be kept in the same case. 

However, after 650 transactions have been created in 
Transaction Entry for a single case, we recommend that 
you create a new case. 
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How a case is set up: Go to the Lists menu and select Patient List.  
Highlight the desired patient number.  Click the Case 
radio button to open case function; then, at the bottom 
of the window, click [New Case] (or [Edit Case] if the 
case has already been entered). 

Entering case information: There are nine tabs containing information for setting 
up a new case.   This is data needed to complete 
insurance claim forms and should be filled in for every 
case. 

Information shortcut: A quick way to enter repeat data on a patient when 
setting up a new case is to click [Copy Case].   

Open existing case file: Through the Patient/Guarantors and Cases option in Lists 
menu or while in the Transaction Entry window, click 
the arrow to the right of the Case field, then highlight 
desired case and press (. 

Why open new cases: A new case should be opened if the patient switches to a new 
insurance carrier.  If the patient develops new 
symptoms that require a change in diagnosis codes and 
extended care, create a new case.  However, if the patient 
comes in once for, say, three stitches in a finger, you can 
create a transaction to cover the visit without creating a 
new case.  Simply change the diagnosis codes in 
Transaction Entry and a new claim is created. 

Cases sharing same number: The only time the same number appears is when that 
number has intentionally been recalled to add 
transactions to an existing visits list.  The program 
automatically assigns case numbers to new cases. 

Patient changes carriers: Always set up new cases for all transactions when a 
patient changes insurance carriers.  Introducing new 
case numbers helps avoid intermingling of claims aimed 
at different carriers. 

Patient on Workers’ Comp: If treatment is covered by Workers’ Compensation, set 
up a new case to keep transaction charges separate from 
claims filed with the regular primary carrier.  When 
accident treatment is finished, close this case and return 
to regular carriers.  It is possible to enter a Workers’ 
Comp case and still make regular entries in existing 
primary carrier cases. 

One case only: It is possible, but not recommended, to enter all 
transactions under the same case.  Cases are set up to 
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enhance flexibility in accounting practices.  Be aware, 
however, that only 650 transactions in a case will show 
up at one time.  After a case has 650 transactions, we 
recommend that you create a new case for the patient. 

New case for every   It is possible, but not recommended, to  
diagnosis code: create a new case for every new diagnosis code entered 

for a patient.  This defeats the purpose of using the case 
to build a continuing history of that patient’s treatment 
for each distinct malady.  

  
Assign to previous case: It is possible to call up previously-assigned cases if the 

treatment is a continuation of treatment for the same or 
similar diagnosis or grouping.    

Delete a case: To conserve disk space, you can delete cases that have 
been completed when the patient has current cases 
continuing the information.  A case that has no 
outstanding balance can be removed by highlighting it 
in the Case list box and clicking [Delete].  A case 
cannot be deleted if it has open charges remaining. 

Billing Service cases: New sequences of case numbers, each starting with the 
number one (1) can be used by billing services that set 
up separate databases for each practice represented. 
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NDCMedisoft Terminal 
Receiving Reports from a BBS 
Within the NDCMedisoft program, the  NDCMedisoft Terminal feature can be used 
to send or receive reports by connecting to bulletin boards using a modem. 

Go to the Tools menu and select NDCMedisoft Terminal.  The NDCMedisoft 
Terminal window appears.  See Figure E.1.   

   

Figure E.1 
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The window displays speed buttons or icons allowing you to dial, hang up, answer, and 
send or receive files.  The Menu bar at the top of the window has corresponding 
functions to the speed buttons. 

Dial:  c + D Hangup: c + H 

Answer: c + A Send File: c + S 

Receive File: c + R 

The speed buttons are defined as follows: 

  Dial 

  Answer 

  Hang up 

  Send a file 

  Receive a file 

  Exit the program 

The blank part of the window displays all modem activity (such as dialing). 

Before using NDCMedisoft Terminal, parameters are defined in the Dial menu or the 
Program Options window of NDCMedisoft Terminal.  Go to the File menu and select 
Program Options.  Otherwise, if you are wanting to access the BBS through an already 
set up EDI receiver within NDCMedisoft. 

Check the Knowledge Base (www.medisoft.com/kb), call your local Value-Added 
Reseller, or call NDCHealth at (800) 334-4006 for technical support., go to the Call 
menu and select Dial. 

! Look up NDCMedisoft Terminal. 

Program Options  
Go to the File menu and select Program Options.  The Program Options window 
appears.  See Figure E.2. 
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The window is divided into three groups.  If you are using an in-house phone system, 
you may need to enter 9 or some other number in the Dialing Prefix field.  You are 
always required to enter a 1 for dialing a long distance phone number.  The Dialing 
Suffix is used to dial any extra numbers after the telephone number, such as an 
extension. 

In the next group are a series of scroll boxes for defining technical information about 
your modem.  The Serial Port field has four selections: COM1, COM2, COM3, and 
COM4.  In order to determine which Communications port your modem uses, click 
[Find Modem] and the Modem Search/Test window opens.   

! Look up Modem Search/Check in the NDCMedisoft Terminal help files. 

The lower third of the window has two fields.  Modem Initialization is normally left 
blank.  If you have problems connecting with your EDI receiver or BBS and your 
modem manufacturer suggests a Modem Initialization String, enter the string here. 

In Modem Termination, enter a character string to terminate the phone connection after 
the transmission has ended if your modem requires this.  This field is usually left blank.   

! Look up Program Options in the NDCMedisoft Terminal Help file. 

Dial Options 
Go to the Call menu and select Dial to open the Dial window.  See Figure E.3. 

Figure E.2
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Select the EDI receiver to dial from the scroll box.  After the EDI receiver is selected, 
the [Options] button becomes activated.  Click it to open the Dial Options window.   
See Figure E.4. 

 

Modem Tab 
The Modem tab is divided into three groups.  In the top group, enter the Data Phone 
Number.  This is the number that the Terminal program dials when you are 
transmitting your claims.   

Enter the data phone number assigned for your transmission.  The program 
automatically enters the punctuation for you.    

Figure E.3

Figure E.4
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In the Dialing Prefix field, enter the prefix number, if any.  If you are using an in-house 
phone system, you may need to enter a 9 or some other number to get an outside line, 
followed by one or two commas to create a pause during dialing.  For dialing a long 
distance phone number, you always need to enter the number 1.  The Dialing Suffix is 
used to dial any extra numbers after the telephone number, such as an extension. 

In the next group are a series of scroll boxes for defining technical information about 
your modem.  The Serial Port field has four selections: COM1, COM2, COM3, and 
COM4.     

The Baud Rate is the speed at which your modem transmits data.  The Parity, Data 
Bits, and Stop Bits fields are defaulted to None, 8, and 1, respectively, and usually do not 
need to be changed.   

The lower third of the window has two fields.  Modem Initialization is normally left 
blank.  If you have problems connecting with your EDI receiver or BBS and your 
modem manufacturer suggests a Modem Initialization String, enter the string here. 

In Modem Termination, enter a character string to terminate the phone connection after 
the transmission has ended, if your modem requires this.  This field is usually left blank.   

ID and Extra Tab 
This tab displays information only.  Any entries in these fields are already set up in the 
EDI Receiver window. 

! Look up Dial Options in the NDCMedisoft Terminal Help file. 

Dialing a BBS 
To dial a BBS, press c + D to bring up the Dial window.  See Dial Options, page 
169, on the features and setup.  Once the parameters have been specified, select your 
EDI receiver and click [OK] to initiate the dialing process.  After clicking [OK], the 
phone number, ATDT, and any prefix entered displays in the NDCMedisoft Terminal 
window.   

Since all BBS’s are different, you need to follow the screen commands as they appear. 

! Look up Dial in the NDCMedisoft Terminal Help file. 

Sending and Receiving Files 
While you are logged on to the BBS, you may want to send or receive files.  To do this 
while logged on, go to the Transfer menu and select Send File.  The Protocol Properties 
window appears.  See Figure E.5. 
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The window has two field selections: Send file and Use the following transfer protocol.  If 
you know the name of the file and its location, enter it here.  If you need to locate the 
file, click [Browse].  This opens the File to Send window.  See Figure E.6. 

 

The window is divided into two parts.  On the left side, select the drive and/or 
subdirectory where the file(s) are located.  On the right, select the actual file to send.   

Click [OK] when done and the file is immediately downloaded. 

In the Send A File window, select the protocol at which you want to send the file.   

The selections are, in suggested order of use: 

 ZModem offers the best overall combination of speed, features and error tolerance.  
ZModem protocol has many options and should generally be used as the most 
versatile protocol of choice. 

Figure E.5

Figure E.6
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 XModem is the simplest and possibly the slowest protocol.  XModem uses blocks 
of 128 bytes and requires an acknowledgment (ACK) of each block.  It uses only 
simple checksum for data integrity. 

 XModem-1K transfers larger blocks (1024- bytes) and uses a 16-bit cycle 
redundancy check.  A larger block size can considerably increase the protocol speed 
because it cuts down on the amount of times the transmitter waits for an 
acknowledgment. 

 YModem is essentially the same as XModem with batch facilities added.  This 
means that a single protocol session can transfer as many files as you can care to 
transmit.  Another added feature allows the sender to provide the receiver with the 
name, size, time stamp with the incoming file. 

 YModem-G has a “streaming” feature and operates in a similar manner to 
XModem-1K.  But like YModem itself, YModem-G offers the advantages of batch 
transfers and file information. 

 
This protocol shouldn’t be used unless you are using an error-correcting 
modem with error control turned on. 

 Kermit allows file transfers in environments that other protocols can’t handle.  
Examples of different environments would include those that transfer only seven 
data bits; links that can’t handle control characters, computer systems that can’t 
handle large blocks of data. 

 ASCII is a convenient way of transmitting a text file.  Because ASCII follows no 
real protocol, it is difficult for the receiver to know when an ASCII transfer has 
completed.  The ASCII protocol terminates on any of three conditions: when it 
receives or saves the file, a c + Z character, when it times out waiting for more 
data, or when the user aborts.   

 BPlus protocol is a proprietary protocol designed and used exclusively by 
CompuServe.   

! Look up Send A File and/or File Transfer Protocol in the NDCMedisoft Terminal 
Help file. 

Receive File 
To receive files while logged on to the BBS, go to the Transfer menu and select Receive 
File.  See Figure E.7.   
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As with sending a file, enter the location and the protocol of where and how the file is to 
be received. 

If you want to search on a location to download a file, click [Browse] and the Choose 
Directory window opens.  See Figure E.8. 

 

Select the proper transfer protocol by clicking on the Transfer Protocol field.  For 
descriptions on what each protocol does, refer to the previous two pages. 

! Look up Receive File in the NDCMedisoft Terminal Help file. 

Figure E.7

Figure E.8 
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Answering 
When an outside source wants to connect with your computer (generally an individual), 
he or she would typically let you know that a connection will be attempted at such a 
time.   

At the given time, when the phone rings and with NDCMedisoft Terminal open, click 
the Answer speed button, or go to the Call menu and select Answer to make the 
connection through your modem.   

Once the two computers are communicating, you can send or receive files.  You can also 
communicate by typing on your keyboard.  What you type shows up on the other user’s 
screen, and vice versa. 
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CMS- or HCFA-1500 Data Sources 
Complete and accurate insurance claims depend on careful entry of patient data, both 
on the original setup and entry of each transaction.  If the data that fills out the CMS- 
or HCFA-1500 insurance claim form is entered correctly, filing and processing of the 
claim moves efficiently and insurance payments are made in a timely manner.  Your 
cash flow depends on your data entry. 

NDCMedisoft is programmed to fill out the CMS- or HCFA-1500 claim forms with 
data that has been entered in the program.  If there is a problem in data placement, this 
chart can help provide the data source files, the information and operation field name 
that apply to each designated box on the insurance form.   

Box Claim Form Box Name Data Source  Window/Field Name 

Top 1 Insurance Name/Address Insurance Insurance Carrier, Address, Name, etc. 

Top 2 Primary, Secondary, Tertiary Insurance Determined by claim form selected 

1 Insurance Type Insurance Insurance Carrier, Options, Type 

1a Insured’s ID No. (SSN/Policy) Case Case, Policy 1,2,3, Policy No. 

2 Patient’s Name Patient Patient/Guarantor, Name, Address, Last Name, 
   Middle Name, Middle Initial 

3 Patient Birthday, Sex Patient Patient/Guarantor, Name   
  Address, Birth Date, Sex 

4 Insured’s Name Case Case, Policy 1,2,3, Insured 1,2,3 

5 Patient’s Address Patient Patient/Guarantor, Name, Address, Street, City, 
  State, Zip 

6 Patient Relation to Insured Case Case, Policy 1,2,3, Relationship to Insured 
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Box Claim Form Box Name Data Source  Window/Field Name 

7 Insured’s Address Patient Patient/Guarantor, Name, Address, Street, City, 
   State, Zip 

8 Patient Status Case Case, Personal, Marital Status, Student Status,  
   Employment Status 

9 Other Insured’s Name Case Case, Policy, Insured 2,3 

9a Policy/Group No. Case Case, Policy 2,3, Policy Number, Group Number 

9b Date of Birth Patient Patient/Guarantor, Name, Address, Birth Date, Sex 

9c Employer/School Patient Patient/Guarantor, Other Information, Employer 

9d Insurance Plan Name, Program Insurance Insurance Carrier, Options, Plan Name.  If empty,
   prints carrier name 

10a Condition Related to      
 Employment Case Case, Condition, Employment Related check box 
 
10b Condition Related to       
 Auto Accident Case Case, Condition, Accident, Related To 

10c Condition Related to      
 Other Accident Case Case, Condition, Accident, Related To 

10d Local Use A Case Case, Miscellaneous, Local Use A 

11 Insured’s Policy Group/FECA Case Case, Policy 1, Policy Number, Group Number 

11a Date of Birth Patient Patient/Guarantor, Name, Address, Birth Date 

11b Employer/School Patient Patient/Guarantor, Other Information, Employer 

11c Insurance Plan Name/Program Insurance Insurance Carrier, Options, Plan Name.  If empty,
   prints carrier name 

11d Another Health Benefit Plan? Case Case, Policy 2, 3 

12 Patient Signature Patient Patient/Guarantor, Other Information, Signature 
  on File; Insurance Carrier, Options, Patient  
  Signature on File 

13  Insured’s Signature Patient Patient/Guarantor, Other Information, Signature 
   on File; Insurance Carrier, Options, Insured  
   Signature on File 
 
14 Date Current Ill/Inj/LMP Case Case, Condition, Injury/Illness/LMP Date 

15 Same/Similar Date Case Case, Condition, Date Similar Symptoms 
  
16 Dates Unable to Work Case Case, Condition, Dates—Unable to Work 

17 Referring Physician Case Case, Account, Referring Provider 

17a ID Number of  Referring Referring Provider, Default PINs, UPIN
 Referring Physician Provider 

18 Hospitalization Dates Case Case, Condition, Dates—Hospitalization  
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Box Claim Form Box Name Data Source  Window/Field Name 

19 Local Use B Case Case, Miscellaneous, Local Use B 

20 Outside Lab? Case Case, Miscellaneous, Outside Lab Work 

21 Diagnosis codes Case Case, Diagnosis, Default Diagnosis 1, 2, 3, 4 

22 Medicaid Resubmission Case Case, Medicaid and Tricare, Resubmission No., 
   Original Reference 

23 Prior Authorization Case Case, Miscellaneous, Prior Authorization Number 

24A Dates of Service Transaction Transaction Entry, Date From, Date To 

24B Place of Service Transaction Transaction Entry, Place of Service 

24C Time of Service Transaction Transaction Entry, TOS 

24D Procedure codes/Modifiers Transaction Transaction Entry, Procedure, M1, M2, M3, M4  

24E Diagnosis codes Transaction Transaction Entry, Diag 1, Diag 2, Diag 3, Diag 4 

24F $ Charges Transaction Transaction Entry, Amount 

24G Days or Units Transaction Transaction Entry, Units  

24H ESPDT Case Case, Medicaid and Tricare, ESPDT 

24I EMG Case Case, Condition, Emergency check box 

24J COB Not used 

24K Local Use Provider Provider, Default PINs, PIN.   This field is 
determined by the carrier to which the claim is 
being sent (Insurance Carrier, Options, Print PINs 
on Forms).  

25 Federal Tax ID Practice Provider, Default Pins, SSN/Federal Tax ID 
  
26 Patient’s Account No. Patient Patient/Guarantor, Name, Address, Chart No. 

27 Accept Assignment? Case Case, Policy 1, 2, 3, Assignment of Benefits/Accept
    Assignment  

28 Total Charge Transaction Calculated field 

29  Amount Paid Transaction Transaction Entry, Payment  

30 Balance Due Transaction Calculated field       

31 Physician’s Signature Provider Provider, Address, Signature on File; Insurance 
   Carrier, Options, Physician Signature on File 

32 Facility Address Practice Case, Account, Facility 

33 Physician Billing Name  Provider Provider, Address, First Name, Middle Initial, Last 
   Name, Street, City, State, Zip 

PIN# and/or GRP# Provider Provider, Default PINs and/or Default Group IDs, 
   PIN, Group Numbers 
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Appendix G 
 

Understanding the Terminology 
 

Many of the words in this list may be familiar, but a common understanding of their 
meanings is helpful. 

Abort — To discontinue or stop the current function or process. 

Accelerator key (hot key) — A shortcut key on the keyboard that can be pressed to 
perform a specific action.  Usually the a key in combination with another key, 
but can also be a combination of the c or s keys with another key.  The 
underlined letter on menu items and field labels indicates an accelerator key that is 
available.  Function keys are also considered accelerator keys.  See Function keys. 

Activate — To bring an application or document window to the foreground.  If you are 
working in more than one application or more than one document with the active 
program, the active window is the window in which you are working. 

Alphanumeric — Consisting of both letters and numbers and often other characters 
(such as a question mark). 

Application menu — The main menu of the program; it is displayed in a horizontal 
format.  Sometimes called operations menu or the Menu bar. 

Backup — Act of saving some or all of the data on a backup disk.  Backups are 
extremely important in the event of data loss, data damage or computer failure.  
Making regular and complete data backup copies can save countless hours of data 
reentry. 
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Bit map — Graphic image that fills appointment spaces illustrating and indicating 
breaks in scheduling.  See also Pixel. 

Boolean — A switching function that has two options, such as True/False or Yes/No. 

Capitation — The payment made to doctors from managed healthcare services for 
those patients who select this primary care provider, regardless of whether they visit 
that provider or not.   

Case — A grouping of claims usually with at least one thing in common, i.e., the same 
carrier, the same diagnosis, etc.   

Case-based — A method of accounting that helps keep track of transactions of a 
common nature; transactions tied to a case. 

Chart number — An eight-character control number to a patient’s information. 

Check box — A square box with associated text that represents a choice.  When a user 
selects a choice, a check mark appears in the box to indicate that the choice is in 
effect. 

Choose — To execute and complete a command.  Some commands are executed when 
you select the menu command; others execute when you choose [OK] in a window 
or dialog box. 

Clearinghouse — A company set up to process NDCMedisoft insurance claims 
transmitted electronically, distributing those claims to various carriers.   

Click — To place the mouse pointer at the desired location and then quickly press and 
release the left mouse button once.  r 

Close button — The  button in the top right-hand corner of an active window which, 
when clicked, ends an activity and removes that window from the display.  Closing 
a program window clears the immediate screen in which you are working.  See also 
Exit. 

[Close] — The button in many windows that closes the active window but not the 
program. 

CMS  — Centers for Medicare and Medicaid Services (formerly known as the Health 
Care Financing Administration – HCFA). 

Combo Box control — A combination edit control and list box control with a down 
arrow button control.  The button control displays a drop-down list box so a 
selection can be made. 

Conditional expression — An expression applied to Data fields in Report Designer that 
contains at least one “if” clause. 
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Control — A component of the user interface that allows the user to select choices or 
types of information, i.e., check box, entry field, radio button, etc.    

Cursor — A movable object (such as the flashing underline or block) on your screen 
that indicates the position where keyboard input appears.   

Cyclical billing — A method of equalizing cash flow by spreading billing processes 
through the month. 

Date format (MMDDYY or MMDDCCYY [for Medicare forms]) — The format used 
to enter dates in NDCMedisoft programs.  The date is entered without 
punctuation, using two digits each for month, day and year. 

Default — A preset value in a field. 

Diagnosis code — One of the ICD-9 codes used to identify a patient’s condition. 

Dialog box — A moveable window containing controls that a user uses to provide 
information required to process a user request. 

Double-click — To place the mouse pointer at the desired location and then quickly 
press and release the left mouse button twice.  r 

Drag — To place the mouse pointer on an item and, holding down the left mouse 
button, move the pointer to the desired location and release the mouse button to 
set the item in the new place. 

Drop-down menu — A menu that emerges in a downward direction from a point or 
line at or near the top of the window.  The series of menu levels displayed under-
neath the main menu are drop-down menus. 

Edit control — The most common type of control for entering text. 

EOB Report — “Explanation of Benefits” report provided by the insurance carrier at 
the time a check is sent for payment of submitted claims. 

Exit — An action that ends the active application and removes all windows associated 
with it.  Usually press  on the program Title bar.  Many data screens also have 
[Exit] or [Cancel] buttons, as well as a Close button (see Close button). 

Expression — A formula or equation that lets you introduce variables into Data fields 
in Report Designer. 

Field — The space allowed in the window for entering data, usually labeled by a field 
name, e.g., Code Name. 

Filter — A procedure that reads data from the keyboard, modifies the data, and displays 
it on the window, i.e., you set parameters through the keyboard, the program 
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searches the database for data that fits your parameters and displays the result on 
the window. 

Focus — The control or area of a window where user interaction is possible, where the 
data entry or action can occur or is occurring at a set point in time.  A button that 
has the focus usually has a broken line box on the button.  An edit control indicates 
that it has the focus by the blink caret (vertical cursor).   

Folder — A container in which documents, program files, and other files are stored in 
the computer or on disk.  Formerly referred to as a directory. 

Format code — A character assigned to a data entry field that can be used in designing a 
report. 

Function keys — Keys usually identified by the letter “F” followed by a number from 1 
to 12 which provide shortcuts to accessing various parts of the program.  Each key 
can have assigned functions in different software.   

Graying — A visual cue that a choice is not available at that time; a menu item or 
control is displayed in a gray color instead of black.   

Guarantor — A person who accepts responsibility for the payment of the patient’s debt. 

HCFA — See CMS. 

Highlight — Contrasting color or reverse video (light letters on dark background) 
indicating selection of a menu option or field in a window. 

Hint — Brief summary of function displayed in a small yellow balloon when the mouse 
cursor is placed on an icon in the toolbar or on a field in a window.  Hints are also 
displayed in text form in the Status bar at the bottom of the application window.  
Also known as a ToolTip. 

Hotspot — A point of reference in a window that provides additional information 
concerning the picture, word, or group of words on which the cursor is resting.  To 
signify that a hotspot is present, the cursor becomes a hand.  Click anywhere you 
see a hand.  Text that is linked to a hotspot is displayed in green and underlined in 
one of two specific ways: Solid double underlining moves you to another topic or 
activates a particular macro; dotted underlining displays a brief definition. 

Icon — See Speed button. 

List box — A control that presents its data in a list format from which a user can make a 
choice.  Normally a vertical roll bar appears on the right side of the list.  Also 
known as a scroll box. 
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List window — A window unique to NDCMedisoft programs which presents each 
record of the given data file in a list format.  This window is also called the browser 
window, indicating that the data can easily be viewed and browsed through. 

Managed care — Healthcare organizations that offer patients treatment to contracting 
providers and facilities for payment of a set co-pay amount.  Services and co-pay 
amounts vary with the plan under which the patient registers. 

Maximize — To expand the active window to fill the entire screen.  The Maximize 
button is the middle of three buttons in the upper right corner of the Title bar. 

Minimize — To reduce the program to a button on the Task bar.  The Minimize 
button is the first of three buttons in the upper right corner of the Title bar. 

Operation — A function in the program which may be selected from a menu. 

Operations menu — The main list of options in a program.  Also referred to as the 
application menu or Menu bar. 

Pixel — Short for “picture element.” The smallest graphic unit that can be displayed on 
your screen.  All the images displayed on a computer screen are composed of pixels.  
See also Bit map. 

Procedure code — A CPT code established by the American Medical Association 
consisting of up to ten characters which identify a service provided to a patient.  A 
charge is assigned to each procedure and is included with the code data.  Procedure 
codes are also used to record payments or adjustments to patient accounts. 

Provider — Usually a doctor, but may also be an assistant or nurse who renders services. 

Radio button — A circle with text beside it.  Radio buttons are combined to show a 
user a fixed set of choices from which only one choice can be selected.  The circle is 
partially filled when a choice is made.   

Record pointer — The pointer on the left side of list windows that indicates the record 
selected. 

Right-click — To position the mouse pointer in the desired location and then click the 
right mouse button.  This action displays the Speed menu.  o 

Select — To highlight or mark a section of text, menu name, command, dialog box 
option or graphical object with the keyboard or with mouse actions. 

Shortcut — A quicker, more direct method of doing something than the ordinary 
procedure; usually keystrokes as opposed to using the mouse.   

Speed button — An image or picture displayed on a window on which the user can 
click to select a particular function or software application.  Also known as an icon. 
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Speed menu — The menu that displays when the right mouse button is pressed.  This 
menu normally duplicates functions that can be initiated in other ways.   

Statement — A summary of a financial account showing the balance due. 

Status bar — The gray bar across the bottom of an applications window which displays 
data and information pertaining to the field in which a user is working. 

Submenu — A menu related to and reached from a main menu. 

Suboption — An option on a submenu. 

Superbill — Checklist of procedures and diagnoses used to indicate the procedures that 
are performed during an office visit.  Once completed by the doctor, it becomes the 
basis for transaction entry.  Also known as a Routing slip. 

System menu — A drop-down list that displays when the System menu icon is selected 
(the upper left square in a window).  Usually contains items such as Restore, Move, 
Minimize, Maximize, Close, Switch To. 

Task bar — The bar at the bottom of the screen that contains the Start button, as well 
as minimized buttons of any active program.  In the NDCMedisoft program, it also 
contains written hints concerning buttons and windows. 

Tertiary — Of third rank, value or importance.  In the NDCMedisoft program, the 
patient’s tertiary (third) insurance carrier can be an attorney, employer, or anyone 
else that needs a copy of insurance claims. 

Title bar — The area at the top of each window that contains the window title and 
System menu icon.  When appropriate, it also contains the Minimize, Maximize, 
and Close buttons. 

Toggle — To switch between two options, such as showing hints or not showing hints. 

Toolbar — The bar just below the Menu bar that usually contains speed buttons to 
perform specific functions in the program. 

Transaction — Recording of both charge procedures and accounting procedures to 
depict accounting activities. 

Validation — A process used to detect input data in order to determine whether they 
are inaccurate, incomplete or reasonable.  The object (or set of functions) that 
actually performs the validation of the data is called the validator. 

Walkout Receipt — A receipt issued to the patient at the time of payment specifying 
the procedures and related accounting codes for which he/she was treated. 

Window — An area on your computer monitor screen surrounded by a box which 
contains information for temporary use.  Windows may be used to display 
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information or to enter data.  They may include search information, help text, 
notes, etc. 

Windows Operating System — A graphical user interface developed by Microsoft 
Corporation wherein action is controlled by movement with a mouse or by clicking 
on icons. 
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